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A System Equipment and Software
A.1 Survey Vessels
A.1.1 NOAA Ship THOMAS JEFFERSON (WTEA)
Vessel Name

NOAA Ship THOMAS JEFFERSON (WTEA)

Hull Number

S222

Description

S222 is a steel hulled hydrographic survey ship built by Halter Marine, Inc., Moss
Point, MS.

Dimensions

Most Recent Full
Static Survey

LOA

208 ft

Beam

45 ft

Max Draft

17 ft

Date

2016-08-31

Performed By

The IMTEC Group, Ltd.

A.1.2 Hydrographic Survey Launch 2903 (HSL 2903)
Vessel Name

Hydrographic Survey Launch 2903 (HSL 2903)

Hull Number

2903

Description

HSL 2903 is an aluminum hulled hydrographic survey launch built in 2017 by
Willard Marine, Inc. HSL 2903 is equipped to collect bathymetric data, side scan
imagery, and water column profiles.

Dimensions

LOA

28 ft

Beam

10 ft

Max Draft

4 ft
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Most Recent Full
Static Survey

NOAA Ship Thomas Jefferson

Date

2017-04-30

Performed By

National Ocean Service - National Geodetic Survey (NGS) Field Operations Branch

A.1.3 Hydrographic Survey Launch 2904 (HSL 2904)
Vessel Name

Hydrographic Survey Launch 2904 (HSL 2904)

Hull Number

2904

Description

HSL 2904 is an aluminum hulled hydrographic survey launch built in 2017 by
Willard Marine, Inc. HSL 2904 is equipped to collect bathymetric data, side scan
imagery, and water column profiles.

Dimensions

Most Recent Full
Static Survey

LOA

28 ft

Beam

10 ft

Max Draft

4 ft

Date

2017-04-30

Performed By

National Ocean Service - National Geodetic Survey (NGS) Field Operations Branch

A.2 Echo Sounding Equipment
A.2.1 Multibeam Echosounders
A.2.1.1 Kongsberg EM710
Manufacturer

Kongsberg

Model

EM710

Description

Kongsberg EM710; The Kongsberg EM710 is a high resolution mid-water MBES. It is
capable of operating at frequencies ranging from 40-100kHz. Across-track swath width is
up to 5.5 times water depth. The EM710 is operated with a 120-140 degree swath width in
dynamic swath mode.
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Inventory

S222

NOAA Ship Thomas Jefferson

Component

Processer

Receiver

Projector

Model Number

N/A

N/A

N/A

Serial Number

CZC3407HFV

172

235

Frequency

N/A

N/A

70kHz

Calibration

2017-06-30

2017-06-30

2018-05-23

Accuracy Check 2017-06-30

2017-06-30

2018-05-23

A.2.1.2 Teledyne Reson (formerly RESON A/S) SeaBat 7125-SV2
Manufacturer

Teledyne Reson (formerly RESON A/S)

Model

SeaBat 7125-SV2
The Reson SeaBat 7125-SV2 is a dual frequency (200/400kHz), high-resolution multibeam
echo sounder system for shallow-water depths. The recommended maximum range at
200kHz is 450m resulting in a 225 m depth limit for full swath coverage on a flat bottom.
The 400kHz setting maximum range is 175m resulting in a 87m depth limit for full
swath coverage on a flat bottom. The transducer assembly consists of single flat-faced
receiver array and one curved projector, which can transmit at either 200kHz or 400kHz.
Bathymetric data from the 7125 SV2 is used to provide object detection and complete
coverage in shallow water.

Description

SeaBat 7125-SV2 systems are installed on HSLs 2903 and 2904. The integrated system
includes a dual 200kHz & 400 kHz projector unit, a receiver unit, and a topside 7-P Sonar
Processor Unit (TPU). The projector and receiver are set up in a Mills Cross configuration.
The 7125-SV2 produces a across track swath of 140° in equidistant mode and 165° in
equi-angle mode. At 200kHz the across track transmit swath is resolved into 256 discrete
beams by the receive array. Each beam is has a resolution of 2° across track and 1° along
track. At 400kHz the across track swath is resolved into 512 discrete beams by the receive
array. Each beam has a resolution of 1° across track and 0.5° along track. The Reson 7125SV2 can be configured for roll stabilization. In roll-stabilized mode, the sonar can operate
in environments with up to +/- 10 degrees of roll without degrading system performance.
Sound velocity at the face of the transducer is provided by an integrated Reson SVP-71
sound velocimeter. The TPU has the following software versions installed: 7K Center: 7K
Center Version # 6.1.0.3, 7K UI Version 6.1.0.3, 7K IO Version 4.2.0.5.
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2903

NOAA Ship Thomas Jefferson

Component

Processor

Receiver

Projector

Model Number

7125 SV2

EM 7216

TC 2181

Serial Number

18341313046

1513550

0513045

Frequency

N/A

N/A

N/A

Calibration

2017-06-30

2017-06-30

2017-06-30

Accuracy Check 2017-06-30

2017-06-30

2017-06-30

Inventory

2904

Component

Processor

Receiver

Projector

Model Number

7125 SV2

EM 7216

TC 2181

Serial Number

18340713036

1409071

1214104

Frequency

N/A

N/A

N/A

Calibration

2017-06-30

2017-06-30

2017-06-30

Accuracy Check 2017-06-30

2017-06-30

2017-06-30

A.2.2 Single Beam Echosounders
No single beam echosounders were utilized for data acquisition.
A.2.3 Side Scan Sonars
A.2.3.1 Klein Marine Systems, Inc. 5000 v2
Manufacturer

Klein Marine Systems, Inc.

Model

5000 v2

4
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Description

NOAA Ship Thomas Jefferson

The Klein High Speed, High Resolution Multi-Beam Side Scan Sonar (SSS) system
is a beam-forming acoustic imagery device. The integrated system includes a Klein
5000 towfish, a Transceiver/Processing Unit (TPU), and a computer for user interface.
Stern-towed units also include a tow cable telemetry assembly. The towfish operates
at a frequency of 455kHz and a vertical beam angle of 40°, and can resolve up to 5
discrete received beams per transducer stave. The system is capable of ranges up to 250
meters. In addition, the Klein 5000 V2 model can collect bathymetric information using
phase differencing. Each side scan transducer stave contains 3 bathymetry staves. The
bathymetry staves operate at 455kHz, with an along track resolution of 0.4°, and can
resolve one discrete beam per side. The Klein 5000 is deployed as a stern-towed unit.
Positioning of the towfish is calculated using Caris HIPS and is derived from the amount of
cable out, the towfish depth (from the towfish pressure gauge), the vessel's Course Made
Good (CMG), and the vessel's heading. Towfish altitude is maintained between 8% and
20% of the range scale unless specifically noted in the Descriptive Report. Vessel speed is
adjusted during SSS acquisition to ensure that object detection density is met. Confidence
checks are performed by noting changes in linear bottom features extending to the outer
edges of the digital side scan image, and by verifying aids to navigation or other known
features on the side scan record.

Inventory

S222

Component

TPU

Towfish

Model Number

N/A

N/A

Serial Number

778

385

Frequency

N/A

N/A

Calibration

2017-06-30

2017-06-30

Accuracy Check 2017-06-30

2017-06-30

A.2.3.2 Klein Marine Systems, Inc. 5000
Manufacturer

Klein Marine Systems, Inc.

Model

5000

Description

The Klein 5000 system used on THOMAS JEFFERSON is an older version of the 5000
v2 system. The specifications of the 5000 system are identical to the 5000 v2 system in all
substantial aspects relating to system performance. The 5000 systems are smaller than the
5000 v2 system and are deployed on the HSLs in a hull-mounted configuration.

Inventory

2903

Component

TPU

Towfish

Model Number

N/A

N/A

Serial Number

009

319

Frequency

N/A

N/A

Calibration

2017-06-30

2017-06-30

Accuracy Check 2017-06-30

2017-06-30
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NOAA Ship Thomas Jefferson

A.2.3.3 EdgeTech 4200
Manufacturer

EdgeTech

Model

4200
The EdgeTech 4200 system is comprised of a topside system and a stainless steel towfish.
The towfish is a dual frequency 300/600 kHz capable of simultaneous acquisition in both
frequencies. The towfish is fitted to the HSL in a hull-mounted configuration.

Description

The EdgeTech 4200 uses Multi-Pulse (MP) technology to enable survey speeds up to
10 knots while maintaining 100% bottom coverage. When operated in simultaneous
dual frequency acquisition mode, speed must be reduced since the frequencies alternate
between 300 and 600 kHz.

Inventory

2904

Component

TPU

Towfish

Model Number

N/A

N/A

Serial Number

50423

50508

Frequency

N/A

N/A

Calibration

2017-08-18

2017-08-18

Accuracy Check 2017-08-18

2017-08-18

A.2.4 Phase Measuring Bathymetric Sonars
No phase measuring bathymetric sonars were utilized for data acquisition.

A.2.5 Other Echosounders
No additional echosounders were utilized for data acquisition.

A.3 Manual Sounding Equipment
A.3.1 Diver Depth Gauges
No diver depth gauges were utilized for data acquisition.

A.3.2 Lead Lines
No lead lines were utilized for data acquisition.

6
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NOAA Ship Thomas Jefferson

A.3.3 Sounding Poles
No sounding poles were utilized for data acquisition.

A.3.4 Other Manual Sounding Equipment
No additional manual sounding equipment was utilized for data acquisition.

A.4 Horizontal and Vertical Control Equipment
A.4.1 Base Station Equipment
No base station equipment was utilized for data acquisition.
A.4.2 Rover Equipment
No rover equipment was utilized for data acquisition.
A.4.3 Water Level Gauges
No water level gauges were utilized for data acquisition.
A.4.4 Levels
No levels were utilized for data acquisition.

A.4.5 Other Horizontal and Vertical Control Equipment
No other equipment were utilized for data acquisition.

A.5 Positioning and Attitude Equipment
A.5.1 Positioning and Attitude Systems

7
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NOAA Ship Thomas Jefferson

A.5.1.1 Applanix Corporation POS MV 320 Version 5
Manufacturer

Applanix Corporation

Model

POS MV 320 Version 5
The Applanix POS MV 320 Version 5 (Position and Orientation System for Marine
Vessels, hereafter ‘POS MV v5’) is a GNSS Inertial Navigation System that provides high
frequency and highly accurate vessel trajectory (both navigation/position and attitude/
orientation) data. The system incorporates data from an Inertial Motion Unit (IMU)
and dual multi-constellation GNSS receivers. Advanced proprietary Kalman Filtering
techniques are used to provide a blended navigation and trajectory solution in real-time
that is both highly accurate and reliable. The POS MV v5 also computes vessel heave
(both instantaneous and ‘delayed’ heave values). The POS MV v5 system is integrated
with all platform acquisition systems. Data from the POS MV v5 is applied to echosounder
data in real-time and logged for post-processing/archiving.

Description

The POS/ MV generates attitude data in three axes (roll, pitch, and heading) to an accuracy
of 0.02° or better. Real-time heave measurements supplied by the POS/MV maintain an
accuracy of 5% of the measured vertical displacement or 05 cm (whichever is greater)
for vertical motions less than 20 seconds in period. The standard practice on THOMAS
JEFFERSON is to configure the Heave Bandwidth filter with a damping coefficient of
0.707. The standard practice is to apply a high pass filter that is determined by the longest
swell period encountered on the survey grounds. The POS MV v5 is also calculates a
‘delayed heave’ (Applanix labels this ‘TrueHeave’) value. The Applanix delayed heave
algorithm uses a delayed filtering technique to eliminate many of the artifacts present in
real time heave data. Applanix delayed heave measurements maintain an accuracy of 2%
of the measured vertical displacement or 02 cm (whichever is greater) for vertical motions
less than 20 seconds in period. Delayed heave measurements are logged and applied to
MBES data in post processing.
A graphical user interface provides visual representations and summary statistics of data
quality in real-time. Performance parameters are monitored by acquisition hydrographers
in real-time and checked against HSSD requirements.
Position and trajectory data from the POS MV v5 system is applied in both real-time and
post-processed applications. Navigation and attitude data is applied to all echosounder data
in real-time. Raw data from the POS MV v5 can also be post-processed after acquisition
to achieve trajectory solutions that are more accurate than those achieved in real-time
by using forward/backward processing methods. Post-processing is conducted using
the Applanix POSPac MMS software suite. Post-processing methodology is described
elsewhere in this document.

Inventory

S222

Component

IMU

PCS

Model Number

N/A

N/A

Serial Number

1047

6497

Calibration

2017-06-30

2017-06-30
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NOAA Ship Thomas Jefferson

A.5.1.2 Applanix Corporation POS MV 320 Version 4
Manufacturer

Applanix Corporation

Model

POS MV 320 Version 4

Description

HSL 2903 and HSL 2904 are equipped with Applanix POS MV 320 Version 4 systems.
The specifications of the Version 4 system are identical to the Version 5 systems described
elsewhere in the document in all substantial aspects relating to system performance.

Inventory

2903

290

Component

I08

PCS

Model Number

N/A

N/A

Serial Number

131

3245

Calibration

2017-06-30

2017-06-30

Component

I08

PCS

Model Number

N/A

N/A

Serial Number





Calibration

2017-06-30

2017-06-30

A.5.2 DGPS
DGPS equipment was not utilized for data acquisition.

A.5.3 GPS
GPS equipment was not utilized for data acquisition.

A.5.4 Laser Rangefinders
Laser rangefinders were not utilized for data acquisition.

A.5.5 Other Positioning and Attitude Equipment
No additional positioning and attitude equipment was utilized for data acquisition.

9
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A.6 Sound Speed Equipment
A.6.1 Moving Vessel Profilers
A.6.1.1 AML Oceanographic AML Micro CTD
Manufacturer

AML Oceanographic

Model

AML Micro CTD

Description

The Micro CTD is a sensor package used to measure conductivity and temperature in
the water column. The Micro CTD is attached to the Moving Vessel Profiler towfish on
S222.

Inventory

S222

Component

Micro CTD

Model Number

N/A

Serial Number

007761

Calibration

2017-06-30

A.6.1.2 AML Oceanographic AML Smart/Micro SV&P Probe
Manufacturer

AML Oceanographic

Model

AML Smart/Micro SV&P Probe

Description

An AML Micro SV&P Probe is used with the MVP system on S222 to collect speed of
sound profiles. The speed of sound is measured directly using a 'time-of-flight' sensor.
Depth is calculated via strain gauge pressure.

Inventory

S222

Component

Micro SV&P

Model Number

N/A

Serial Number

007761

Calibration

2017-06-30

A.6.2 CTD Profilers
A.6.2.1 Sea-bird Electronics SBE 19plus
Manufacturer

Sea-bird Electronics

Model

SBE 19plus

10
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Description

NOAA Ship Thomas Jefferson

Sea-Bird Electronics SBE 19plus SeaCAT Conductivity, Temperature, and Depth (CTD)
Profilers are used on HSL 2903 and HSL 2904 to collect vertical sound speed profiles.
The speed of sound is calculated from temperature, salinity, and pressure measurements.
Temperature is measured directly. Salinity is calculated from measured electrical
conductivity. Depth is calculated via strain gauge pressure. The system is configured for a
sampling rate of 0.5 seconds. CTD equipment is deployed manually aboard TJ launches.
Component

CTD

Model Number

N/A

Serial Number

19P33589-4487

Calibration

2017-02-04

Component

CTD

Model Number

N/A

Serial Number

19P60744-6667

Calibration

2017-02-09

Inventory

A.6.3 Sound Speed Sensors
A.6.3.1 Teledyne Reson (formally RESON A/S) Reson SV-71
Manufacturer

Teledyne Reson (formally RESON A/S)

Model

Reson SV-71

Description

Reson SV-71 sensors collect the speed of sound at the face of the Reson 7125-SV2
transducers on HSL 2903 and HSL 2904. The sensors are bolted to the mounting sleds
near the face of the transducer on each launch. The speed of sound is measured directly
using a direct path echosounding sensor. The SV-71 is integrated with the Reson 7125SV2 TPU.

2903

Component

SSP

Model Number

N/A

Serial Number

0710064

Calibration

2017-02-21

Component

SSP

Model Number

N/A

Serial Number

4211065

Calibration

2017-02-23

Inventory
2904
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NOAA Ship Thomas Jefferson

A.6.3.2 Valeport MODUS SVS Thruhull
Manufacturer

Valeport

Model

MODUS SVS Thruhull

Description

The Valeport MODUS SVS Thruhull is a digital, real time sound speed sensor used to
measure the speed of sound at the transducer faces of the Kongsberg EM 710 and EM2040
MBES. The system has a manufacturer-stated accuracy of 0.02m/s. The sensor is fully
removable for maintenance and calibration; it is deployed prior to and recovered at the
completion of survey operations via a Valeport fabricated thruhull flange.

Inventory

S222

Component

SSP

Model Number

N/A

Serial Number

33747

Calibration

2016-12-15

A.6.4 TSG Sensors
No surface sound speed sensors were utilized for data acquisition.
A.6.5 Other Sound Speed Equipment
No surface sound speed sensors were utilized for data acquisition.

A.7 Computer Software
A.7.1 Caris HIPS
Manufacturer

Caris

Software Name

HIPS

Version

10.3

Installation Date

2017-06-30

Use

Processing

A.7.2 Caris BASE Editor
Manufacturer

Caris

Software Name

BASE Editor

Version

4.3
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Installation Date

2017-06-30

Use

Processing

NOAA Ship Thomas Jefferson

A.7.3 NOAA Pydro
Manufacturer

NOAA

Software Name

Pydro

Version

17

Installation Date

2017-06-30

Use

Processing

A.7.4 HYPACK - A Xylem Brand HYPACK
Manufacturer

HYPACK - A Xylem Brand

Software Name

HYPACK

Version

2017

Installation Date

2017-06-30

Use

Acquisition

A.7.5 Applanix Corporation POSPac MMS
Manufacturer

Applanix Corporation

Software Name

POSPac MMS

Version

8.2

Installation Date

2017-06-30

Use

Processing

A.7.6 Applanix Corporation POSView
Manufacturer

Applanix Corporation

Software Name

POSView

Version

8.32

Installation Date

2017-06-30

Use

Acquisition
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NOAA Ship Thomas Jefferson

A.7.7 QPS, Inc Fledermaus
Manufacturer

QPS, Inc

Software Name

Fledermaus

Version

7.4.0d

Installation Date

2017-06-30

Use

Processing

A.7.8 ESRI, Inc. ArcGIS
Manufacturer

ESRI, Inc.

Software Name

ArcGIS

Version

10.3

Installation Date

2017-06-30

Use

Processing

A.8 Bottom Sampling Equipment
A.8.1 Bottom Samplers
No bottom sampling equipment was utilized for data acquisition.

B System Alignment and Accuracy
B.1 Vessel Offsets and Layback
B.1.1 Vessel Offsets
All offsets for S222 are derived from full surveys performed by Kongsberg USA-contracted personnel and
have been verified by Hydrographic Systems and Technology Branch (HSTB) personnel. All offsets are
tracked and updated as needed. Offsets values are known in the vessel reference frame, the IMU reference
frame, and Kongsberg EM710 reference frame. Offset values for the Kongsberg MBES systems are entered
into SIS and the ship's Caris HIPS Hydrographic Vessel File (HVF), with the exception of the orthogonal
offsets between the primary Applanix GNSS sensor antenna and the Applanix IMU. The offset between
the primary GNSS antenna and the IMU is applied to the POS MV. The POS MV provides navigation and
attitude data in the IMU reference frame at the IMU reference point. All other offsets are applied to data
during the SVP or Merge processing steps in CARIS HIPS.
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Offsets are applied to side scan sonar data during the Compute Towfish Navigation step.
All offsets for HSL 2903 and HSL 2904 are derived from full vessel surveys performed by NGS personnel.
The reference point for the launches is the IMU.
All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in
the Appendices to this report. HVF Reports are output from the Caris HVF Editor in a plain text document
readable anywhere and include all of the requested values for the DAPR necessary to reproduce an HVF.
B.1.1.1 Vessel Offset Correctors
See included HVFs for information on applied correctors.

B.1.2 Layback
)RUWKHVKLSWowfish positioning is provided to CARIS HIPS using cable-out values registered by the Totco
cable counterand recorded in the SonarPro SDF files. SonarPro uses Payout and Towfish Depth to compute
towfishpositions. The towfish position is calculated from the position of the tow point using the cable-out
valuereceived by SonarPro from the cable payout meter, the towfish pressure depth (sent via a serial
interfacefrom the Klein 5000 TPU to the SonarPro software), and the Course Made Good (CMG) of the
vessel. This
15
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method assumes that the cable is in a straight line. Therefore, no catenary algorithm is applied at the time of
acquisition, but in processing, CARIS SIPS applies a 0.9 coefficient to account for the catenary.
Layback error is calculated by running a side scan certification test. This test consists of running parallel to
a known feature at varying ranges from nadir to ensonify the target in the near-field (approximately 15% of
range scale in use), mid-field (approximately 50 % of range scale in use), and far-field (approximately 85%
of the range scale in use). The test requires that each side of the sonar ensonify the feature at each of these
areas in the swath. Then the test is repeated in a direction that is orthogonal to the original set of lines such
that the feature is ensonified a total of 12 times. A successful test will detect the feature in at least 10 of the
12 passes. For hull-mounted systems, the selected contact positions must be within 5m; for towed systems,
the contact positions must be within 10m. Layback error is the amount of correction that must be applied to
minimize the distance between contact positions.

B.2 Static and Dynamic Draft
B.2.1 Static Draft
Static draft is measured on the S222 using a Sutron Bubbler system. The orifice was surveyed into the
IMU reference frame and a waterline height was calculated. A common waterline for the ship when fully
loaded with fuel and ballasted normally is approximately 35cm below the reference point of the ship, but the
waterline may change by as much as +/- 30cm over the course of a field season.
The Static Draft is not applied to soundings for ERS Surveys.
The waterline for S222 is measured at least weekly. When feasible, waterline measurements are taken before
and after fueling or ballasting of the ship. The values are kept in a static draft log and periodically updated
in the HVF. Once applied in the HVF, all affected lines have SVP re-applied and are then merged so that the
updated waterline measurements will be applied.
The waterline for HSL platforms is measured using physical measurements from the waterline of the vessel
to physical known benchmarks.
All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in
the included Appendix Folder, HVF Reports. These HVF Reports are output from the Caris HVF Editor in
a plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
reproduce an HVF.
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B.2.1.1 Static Draft Correctors
See included HVFs for information on applied correctors.

B.2.2 Dynamic Draft
Dynamic draft for all platforms was measured using the Post Processed Kinematic GPS method outlined in
section 1.4.2.1.2.1 of NOAA's FPM. To reduce the effect of any potential current, reciprocal lines were run
at each RPM step in order to get an average speed over ground for each RPM. This average speed was used
to estimate the vessel’s speed through the water. Dynamic draft and vessel offsets corrector values are stored
in the HIPS Vessel Files (HVF).
In ERS surveys (those that use recorded GPS heights corrected via a VDatum SEP model to achieve tidal
datum) the dynamic draft correction is not applied to the soundings.
All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in
the included Appendix Folder, HVF Reports. These HVF Reports are output from the Caris HVF Editor in
a plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
reproduce an HVF.
B.2.2.1 Dynamic Draft Correctors
See included HVFs for information on applied correctors.

B.3 System Alignment
B.3.1 System Alignment Methods and Procedures
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THOMAS JEFFERSON conducts MBES calibration tests during annual HSRR activities for each individual
multibeam system on the ship and her launches.
Multibeam systems with two frequencies required an individual test for each frequency. The procedure used
follows that outlined in section 1.5.5.1 of the Field Procedures Manual dated April 2014. Timing bias was
determined using the method of running the same line at different speeds. Pitch and yaw bias was determined
using a target on the seafloor. Finally, roll bias was determined using the standard flat bottom method. Offset
values for all platforms were derived using Caris’ patch testing tools during annual HSRR activities.
All calibration reports can be found in the Appendix Folder.

B.3.1.1 System Alignment Correctors

See included HVFs and calibration reports for information on applied correctors.

C Data Acquisition and Processing
C.1 Bathymetry
C.1.1 Multibeam Echosounder
Data Acquisition Methods and Procedures
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All multibeam data on THOMAS JEFFERSON is logged using Kongsberg Seafloor Information System
(SIS) in the .all file format.
During acquisition aboard THOMAS JEFFERSON, the hydrographer:
- Monitors the SIS interface for errors and data quality
- Monitors the SIS interface for indication of sound speed changes requiring a cast, and conducts casts as
necessary
- Monitors the Hysweep interface in HYPACK
- Monitors the vessel speed and requests the bridge to adjust as necessary to ensure density and coverage
specifications are met
All MBES data on the launches is logged using HYPACK in the .HSX file format.
During acquisition aboard the launches, the hydrographer:
- Monitors the Reson 7k control interface on the Reson MBES TPU for errors and data quality
- Monitors the Hysweep interface in HYPACK
- Monitors the vessel speed and requests the coxswain to adjust as necessary to ensure density and coverage
specifications are met
Data Processing Methods and Procedures
Five workflows exist depending on whether a survey uses zoned tides, TCARI tides, Marinestar service and
the Real-Time Precise Point Positioning (RT3P) method, the Post-Processed Precise Point Positioning (5P)
method, or Inertially Aided Post Processed Kinematic (IAPPK) method. A more detailed description of 5P
and IAPPK workflows is provided elsewhere.
These workflows are shown in descending order of preferred use.
RT3P:
1) Convert .all file into Caris project
2) Load Delayed Heave via Auxiliary Data Import
3) Sound Velocity Correction (note: no file is loaded in this step. This is purely to apply Delayed Heave.)
4) Compute GPS Tide using the provided VDatum SEP model.
5) Merge; use GPS Tides.
6) Compute Total Propagated Uncertainty (TPU) using fixed uncertainty values (11cm for Marinestar, and
the uncertainty value provided as part of the vDatum model)
5P:
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1) Create SBET and RMS files in POSPac MMS.
2) Convert raw .HSX data to Caris HDCS format
3) Load Delayed Heave
4) Import ancillary data: SBET and RMS
5) Apply tide correctors. While unused, if available these are useful for a QC check in Subset Editor.
6) Compute GPS Tides using the provided VDatum SEP model.
7) Apply sound speed correctors
8) Merge; use GPS Tides.
9) Compute Total Propagated Uncertainty (TPU)
IAPPK:
IAPPK requires a delay of around 48 hours to produce the SBET and RMS files, due to reliance on updates
of CORS station and ephemeris data. The need for fast QC of the data ("night processing") to allow planning
of the next day's survey operations necessitates that initial processing must happen before the IAPPK
solution is available. As a result, it initially follows the tidal scheme appropriate to that project area (Zoned
Tides or TCARI). Once sufficient time has passed, SBETs and RMS files are produced and the data is
reprocessed using the same workflow as 5P, skipping the conversion and Delayed Heave steps.
Zoned Tides:
1) Convert raw MBES data to Caris HDCS format
2) Load Delayed Heave
3) Apply tide correctors
4) Apply sound speed correctors
5) Merge
6) Compute TPU
TCARI Tides:
The TCARI Tides work flow is the same as Zoned Tides except that Step 3 applies the TCARI correctors via
Pydro, and Step 6 applies "realtime" tidal uncertainty values instead of project specific static values.
At this stage, all of the work flows merge into a common process:
1) Create CUBE surfaces. Surface resolution is dictated by the type of coverage required (Complete
Coverage vs. Object Detection), and the depth of water. Disambiguation method is NOAA CUBE
Parameters. Compliance with HSSD gridding requirements is strictly observed.
2) Review the CUBE surface for holidays.
3) Create a holiday line plan.
4) Review the uncertainty and standard deviation layers and address areas where the standards set by the
HSSD are exceeded.
5) Examine all surfaces for erroneous surface designation and evidence of systematic errors. Also identify
features and look for evidence of shoaling.
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6) Significant features are flagged 'designated', forcing the CUBE algorithm to honor the depth of the
sounding. Designated soundings are reviewed to ensure compliance with guidance in the HSSD.
7) Create finalized grids. In finalization, the standard deviation for each node in the surface is multiplied by
1.96 to provide the 95% (2-sigma) confidence level. Standard deviation is then compared to the computed
Total Vertical Uncertainty (TVU) for each node. The larger of the two values is retained as the finalized
Uncertainty for each node. Finalization is also when the surface is forced to honor designated soundings.
C.1.2 Single Beam Echosounder
Single beam echosounder bathymetry was not acquired.
C.1.3 Phase Measuring Bathymetric Sonar
Phase measuring bathymetric sonar bathymetry was not acquired.
C.1.4 Gridding and Surface Generation
C.1.4.1 Surface Generation Overview
After initial processing the bathymetric data is gridded into BASE surfaces using the CUBE algorithm. This
type of surface calculates a horizontal and vertical uncertainty for each sounding, derived from the combined
uncertainty from each of the sensors that contributes data to the sounding (e.g water levels, tide zoning,
attitude sensor error, navigation sensor horizontal position error, and sound velocity profile error). Individual
soundings are then propagated to grid nodes, which takes on a depth value as well as an uncertainty value
based on all the soundings that contribute to the node. The influence of a sounding on a grid node is limited
to 0.707 times the grid resolution.
C.1.4.2 Depth Derivation
Filters are used on a case-by-case basis as determined by the hydrographer. Refer to the Descriptive Report
for more information. Gridding parameters and surface computation algorithms comply with the HSSD and
are described above.
C.1.4.3 Surface Computation Algorithm
MBES data is gridded using the CUBE algorithm. Resolution is dictated by the Project Instructions, as well
as section 5.2.2 of the HSSD. The disambiguation method used is always Density and Local. The settings
used for Capture Distance Scale, Horizontal Error Scale, and Capture Distance Minimum are those listed
in section 4.2.1.1.1.1 of the FPM. After creation, Uncertainty and CUBE surfaces go through a quality
control process. During this process, the Depth, Uncertainty, Standard Deviation, and Density child layers
are examined for compliance with NOAA specifications. After the surfaces pass quality control, they are
finalized. Uncertainty values for finalized surface come from the greater of either Uncertainty, or Standard
Deviation.
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C.2 Imagery
C.2.1 Multibeam Backscatter Data
Data Acquisition Methods and Procedures
All backscatter data on THOMAS JEFFERSON are logged in the SIS .all format.
All backscatter data on the launches are logged in the Reson .s7k file format.
Data Processing Methods and Procedures
All acquired backscatter data are processed into a mosaic and delivered to AHB. All processing of
backscatter is done using the FMGT module of the QPS Fledermaus software package in accordance with
OCS standard data processing methods.
C.2.2 Side Scan Sonar
Data Acquisition Methods and Procedures
All side scan sonar data collected with the Klein 5000 SSS are logged using Klein SonarPro, in the .SDF
format. Data collected with the Edgetech 2400 SSS were logged in Edgetech Discover in .JSF format.
During acquisition the hydrographer:
- Monitors range, towfish height, heading, pitch, roll, latitude, longitude, speed, pressure, and temperature;
- Adjusts towfish height (for operations aboard THOMAS JEFFERSON)
Data Processing Methods and Procedures
1) Convert raw SSS data using Caris SIPS;
2) Scan Navigation and Attitude data, flagging erroneous data as rejected;
3) Re-compute towfish navigation. This is when tow point offsets and horizontal layback is applied to the
data;
4) A primary reviewer scans each line for significant contacts;
5) A secondary reviewer makes an independent check-scan of all lines, verifying contacts and checking for
missed contacts;
6) If the Project Instructions call for 200% Side Scan coverage, the scanners check correlation of contacts
between 100% and 200% coverage;
7) Correlation is also used to reveal systematic errors, particularly if a contact shows up on lines collected in
opposite or orthogonal directions;
8) Create individual mosaics for 100% and 200% coverage. Examine for coverage;
9) If necessary, create a holiday line plan.
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C.2.3 Phase Measuring Bathymetric Sonar
Phase measuring bathymetric sonar imagery was not acquired.

C.3 Horizontal and Vertical Control
C.3.1 Horizontal Control
C.3.1.1 GNSS Base Station Data
GNSS base station data was not acquired.
C.3.1.2 DGPS Data
DGPS data was not acquired.
C.3.2 Vertical Control
C.3.2.1 Water Level Data
Data Acquisition Methods and Procedures
THOMAS JEFFERSON uses the Fugro Marinestar satellite based corrector service to provide realtime
correction to the horizontal position and ellipsoid height for all data acquisition and initial processing. The
corrector signal is received on the L1 channel of the POS MV primary GPS antenna and logged directly into
the POS MV.
In the event of issues with the real-time solution, the POS files produced during acquisition can be processed
through the POSPac MMS software to produce a trajectory solution in the WGS84 reference frame and an
associated uncertainty file containing the realtime uncertainty estimates of the position and attitude data.
THOMAS JEFFERSON does not normally install GNSS reference stations or temporary tide stations for
operations on the East Coast. Data from permanently installed GNSS reference stations and/or tide stations
(typically maintained by NGS and CO-OPS, respectively) may be used in certain workflows (described
below).
Data Processing Methods and Procedures
Vertical control requirements for surveys conducted during the 2017 field season by THOMAS JEFFERSON
are satisfied through the use of one or more of the following methods.
Discrete Zoned Tides:
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This method utilizes one or more National Water Level Observation Network (NWLON) water level gauges
and a discrete zoned tidal modal to determine vertical control correctors to be applied to soundings at a
given location and time. Co-range and co-phase measurements from the NWLON stations are used to break
the project area into zones, each of which has a distinct time-of-tide and range-of-tide corrector. CO-OPS
provides the field unit with a Caris compatible file which takes observed water levels from surrounding
gauges, computes the time and range correctors for each zone, and uses the zoned data to reduce bathymetric
soundings to MLLW. THOMAS JEFFERSON does not install tertiary gauges in support of tidal modeling.
After completion of a survey area, CO-OPS verifies all zoning and water level data.
TCARI Tides:
Tidal Constituent and Residual Interpretor is an alternative to discrete zoning. A TCARI grid is a
triangulated network that uses two or more water level gauges to create a weighted network across the survey
area. Each point on the grid has a discrete tidal interpolation that is based on the horizontal nearness of a
water level gauge, the harmonic constants of the area, and the residual water levels. Bathymetric data is then
reduced to MLLW using the TCARI tool in Pydro. Like zoned tides, CO-OPS verifies TCARI grids and
observed water levels at the conclusion of each survey.
GPS Tides:
Trajectory solutions and VDatum separation models that meet OCS ERS specifications can also be used to
provide vertical control. Using this method the bathymetric data is initially referenced to the ellipsoid using
the high accuracy position data. It is later reduced to MLLW using a separation model called VDatum, which
is provided to the field unit by NOAA's Hydrographic Services Division.
Methods employed to meet Ellipsoidally Referenced Survey (ERS) specifications include the methods
described below:
Vertical control requirements for ellipsoidally referenced surveys conducted during the 2017 field season by
THOMAS JEFFERSON are satisfied through the use of one or more of the following methods.
Real-time Precise Point Positioning (RT3P):
THOMAS JEFFERSON uses the Fugro Marinestar satellite based corrector service to provide real-time
correction to the horizontal position and ellipsoid height for all data acquisition and initial processing. The
corrector signal is received on the L1 channel of the POS MV primary GPS antenna and logged directly into
the POS MV. The data are then put out in real time to the EM710, and positional and motion data are applied
to the acquired bathymetry.
In the event of issues with the real-time solution, the POS files produced during acquisition can be processed
through the POSPac MMS software to produce an SBET in the WGS84 reference frame and an RMS file
containing the realtime uncertainty estimates of the position and attitude data.
Real-time corrected ellipsoid height is recorded directly in Kongsberg MBES data logged through the
Kongsberg SIS program on THOMAS JEFFERSON and is used when processing ship MBES data in CARIS
HIPS.
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Post-processed Precise Point Positioning (5P):
Raw GNSS-INS observables and Marinestar corrector data logged through POSView can be post-processed
in POSPac MMS to provide a trajectory solution that can be applied to MBES data in CARIS HIPS. The 5P
is the standard practice for HSL 2903 and HSL 2904. The 5P method is only used on S222 data if required.
Inertially Aided Post-Processed Kinematic:
During post-processing horizontal positioning can be shifted to an Inertially Aided Post-Processed Kinematic
(IAPPK) solution. The solution is created by combining GPS/GNSS satellite ephemeris and clock data with
position information downloaded from a network of Continually Operating Reference Stations (CORS).
The resulting position data is corrected for the effects of atmospheric interference on the GPS signal. The
corrected GPS position is then combined with the vessel's inertial data using the POSPac MMS program to
create a Smoothed Best Estimate of Trajectory (SBET). The resulting position can be used to apply higher
quality navigation information to the processed data.
C.3.2.2 Optical Level Data
Optical level data was not acquired.

C.4 Vessel Positioning
Data Acquisition Methods and Procedures
As described in Section A.5 of this document.
Data Processing Methods and Procedures
As described in Section C.3 of this document.

C.5 Sound Speed
C.5.1 Sound Speed Profiles
Data Acquisition Methods and Procedures
S222 uses an AML Micro CTD Probe installed inside an MVP free-fall fish to acquire sound speed profiles.
Profiles aboard the ship are generally acquired at 30 - 90 minute intervals. Cast frequency is increased when
the comparisons show significant variability. Sampling intervals are adjusted to ensure spatial variability or
if there is suspicion of sudden changes in the water-column.
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HSL 2903 and HSL 2904 both use Sea-Bird SBE 19plus CTDs to collect sound speed profiles. Casts are
generally taken at 2-4 hour intervals. Casts are also conducted when changing survey areas or when a
change of weather, tide, or current warrant. The launch crew also monitors the real time display of the Reson
SVP-70/71 sound velocity probe for significant changes in the surface sound velocity.
Velocipy software is used to interface with SBE 19plus CTD equipment and to process CTD data.
Casts are typically taken in the deepest portions of the project area.
The following procedure is followed when conducting manual CTD casts with the SBE 19plus: The
instrument is lowered into the water and submerged just below the water's surface for about 1 minute to
allow air to escape the salinity cell. The instrument is lowered at the rate of free fall. The instrument is
lowered slowly (in some cases, much less than 1 meter/second) through the first 5-10 meters of water in
order to accurately sample the sound speed for areas with lenses of fresh water or other complex sound speed
variation near the surface.
The Moving Vessel Profiler (MVP) is an automated winch system that deploys a towfish containing a sound
speed sensor. The fish is towed behind the survey vessel in a ready position that is marked by messengers
attached to the tow cable. The towfish is typically deployed at a ready depth that is approximately the same
depth of the ship MBES transducers. Deployment depth is a function of water depth. The towfish descends
at the rate of freefall when deployed. Towfish freefall is automatically stopped once a specified depth limit
is met and the drag forces on the fish cause it to rise toward the surface due to the ship's forward motion. The
cable slack is then pulled in by the winch to the ready towing position.
Aboard all platforms, the hydrographer processes each cast immediately, then reviews it for erroneous data.
Data Processing Methods and Procedures
Sound Speed Manager (distributed with Pydro) is used to download and process all sound speed data on
S222. Sound speed cast data is provided to the Kongsberg SIS acquisition program.
Velocipy is generally used to download and process cast data on the launches.
Processed sound speed data data is applied to the MBES data in CARIS HIPS.
C.5.2 Surface Sound Speed
Data Acquisition Methods and Procedures
THOMAS JEFFERSON uses a Valeport probe to find the speed of sound at the approximate depth of the
ship transducers.
HSL 2903 and HSL 2904 use Reson SV-71 probes to acquire sound speed at their respective transducer
faces.
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Sound speed values are applied in real-time to all MBES systems to provide refraction corrections to flatfaced transducers.
The accuracy of each surface sound speed device is checked against the closest CTD data point after every
CTD cast.
Data Processing Methods and Procedures
Surface sound speed data are logged directly into both Kongsberg and Reson MBES raw data files. Surface
sound speed data is not typically processed after the time of acquisition.

C.6 Uncertainty
C.6.1 Total Propagated Uncertainty Computation Methods
TPU is calculated in Caris HIPS using the Compute TPU tool. The uncertainty values for each input into the
TPU model can come from one of three sources: Real-time, Static, or Vessel. Real-time values are provided
from the sensor or processing package (e.g. POSPac RMS values). Static values are those entered manually
into the Compute TPU dialog (e.g. tidal zoning uncertainty and sound speed measurement uncertainties).
Static values are documented in each Descriptive Report. Vessel values are taken from the HVF if no
realtime or static values are available.
Uncertainty values entered into the HVF for the multibeam and positioning systems are derived from
manufacturer specifications sheets for each sensor and from values set forth in section 4.2.3.8 and Appendix
4 - Caris HVF Uncertainty Values of the 2014 FPM.
Sound speed static values are derived from the guidance in the FPM.
Tide correction uncertainty values depend on the method of correction: real-time values are used for the
TCARI workflow; static values specified in the Project Instructions are used for Zoned Tides or ERS
workflows.
Ellipsoid height uncertainty values for ellipsoid measurements derived from the Marinstar service are
derived from both manufacturer specifications and empirical observation. Static values are used to account
for known discrepancies with the magnitude of the position uncertainty values reported by the POS MV
system when utilizing Marinestar correctors.
Ellipsoid height uncertainty values for ellipsoid measurements derived from 5P or IAPPK workflows are
applied as real-time values from Applanix RMS files.
Both the Kongsberg and Reson MBES systems provide uncertainty statistics that are recorded in raw MBES
files.
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All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in
the included Appendix Folder, HVF Reports. These HVF Reports are output from the Caris HVF Editor in
a plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
reproduce an HVF.
See included HVFs for information on vessel uncertainty values.
C.6.2 Uncertainty Components
A Priori Uncertainty

$SULRULXQFHUWDLQW\ZDVQRWDSSOLHG

Real-Time Uncertainty
Vessel

Description

S222

As discussed above.

2903

As discussed above.

2904

As discussed above.

C.7 Shoreline and Feature Data
Data Acquisition Methods and Procedures
The following workflow is used to develop and verify features:
- Potentially significant features are initially identified and inspected in Caris HIPS (both MBES and SSS
contacts).
- A development area polygon or point feature is exported from HIPS; a line plan is created using HIPS or
ArcMap if needed.
- Object Detection level MBES data is collected over all MBES and/or SSS contacts, VBES designated
soundings, and all possible shoal areas.
Quality of data is controlled through:
- Real time monitoring during acquisition to ensure that all features are covered by near nadir beams.
- Inspection of the CUBE surface's Density, Standard Deviation, and Uncertainty layers.
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- All developments are examined for significance. Objects found to be significant are flagged with a
designated sounding, and become part of the Final Feature File.
Data Processing Methods and Procedures
Feature verification begins during initial data processing. Both SSS and MBES data is processed following
the conclusion of daily acquisition operations or at regular intervals for continuous ship operations.
Significant contacts are identified and noted during initial processing. All significant contacts are then
developed using a MBES. When conducting Multibeam surveys, or when reviewing MBES developments
over side scan sonar contacts, the least depths over navigationally significant features are flagged as
'designated soundings', then imported into Caris BASE Editor or HIPS. Inside BASE Editor, each significant
contact is given an S-57 attribution, and the hydrographer recommends charting action. The final deliverable
is a Final Feature File (FFF) in .000 format.

C.8 Bottom Sample Data
Bottom sample data was not acquired.

D Data Quality Management
D.1 Bathymetric Data Integrity and Quality Management
D.1.1 Directed Editing
All statistics layers generated by the CARIS CUBE implementation are used (including uncertainty,
hypothesis count, hypothesis strength, and standard deviation) to direct data cleaning. Use of the Flier Finder
function in the HydroOffice QCTools 2 software included with Pydro was used to further reduce time spent
examining the data and provided a more robust output for directed editing.
D.1.2 Designated Sounding Selection
In accordance with HSSD 2017.
D.1.3 Holiday Identification
Holidays are identified primarily through the use of two tools: the QC Tools program included with recent
version of Pydro and via standard tools included in ArcGIS (primarily to inspect SSS mosaics). All surfaces
are also visually inspected.
D.1.4 Uncertainty Assessment
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In accordance with HSSD 2017 using methods described above.
D.1.5 Surface Difference Review
D.1.5.1 Crossline to Mainscheme
Difference surfaces are conducted in accordance with HSSD 2017 and as outlined in the DR.
D.1.5.2 Junctions
Difference surfaces are conducted in accordance with HSSD 2017 and as outlined in the DR.
D.1.5.3 Platform to Platform
Difference surfaces are conducted in accordance with HSSD 2017 and as outlined in the DR.

D.2 Imagery data Integrity and Quality Management
D.2.1 Coverage Assessment
Coverage is assessed in accordance with HSSD 2017.
Automated and visual methods are used to inspect surface coverage: ArcGIS tools are used to automatically
identify coverage deficiencies; surfaces are inspected against brightly colored backgrounds for visible gaps
in coverage.
D.2.2 Contact Selection Methodology
Contacts are selected in accordance with HSSD 2017.
Visual inspection of all SSS data is conducted in CARIS HIPS by multiple scanners (initially processor,
check scanner and/or sheet manager).
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THOMAS JEFFERSON
Multibeam Echosounder Calibration

Vessel: S-222

Date Acquired: 8/19/2017 (DN231)
Processing Log
8/20/2017
Date

231
Dn

Doroba, Stone, McMillan
Personnel

Data converted --> HDCS_Data in CARIS
TrueHeave applied
SVP applied

GPS Tide

Tide applied

Zone file
Lines merged
Data cleaned to remove gross fliers

Compute correctors in this order
1. Precise Timing

2. Pitch bias

3. Roll bias

4. Heading bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS
Latency
Lines Used

Evaluators
Doroba
Stone
McMillan
Bobby
Rosenberg

Averages
Standard Deviation
FINAL VALUES

Pitch Lines
Latency (sec) Used
0.0000
0.0000
0.0367
0.0000
0.0400

Roll Lines
Pitch (deg) Used
0.9233
0.8800

Yaw Lines
Roll (deg) Used
0.1867

1.1633
0.9467

0.2067
0.2167
0.1933

0.02
0.02
0.02

0.98
0.13
0.98

0.20
0.01
0.20

Final Values based on
Resulting HVF File Name

2903_Reson7125_SV2_200kHz_2017.hvf

MRU Align StdDev gyro
MRU Align StdDev Roll/Pitch

0.43
0.07

Value from standard deviation of Heading offset values
Value from averaged standard deviations of pitch and roll offset values

NARRATIVE
We need to figure out which beams to filter on STBD side and interference w SSS.

We need to figure out which beams to filter on STBD side and interference w SSS.

HVF Hydrographic Vessel File created or updated with current offsets
Name:

2903_7125_200kHz_2017

Date:

s

Yaw (deg)
-1.8533
-1.9900
-1.4767
-1.5067
-2.5367

-1.87
0.43
-1.87

nd roll offset values

8/20/2017

THOMAS JEFFERSON
Multibeam Echosounder Calibration

Vessel: S-222

Date Acquired: 8/19/2017 (DN231)
Processing Log
8/20/2017
Date

231
Dn

Doroba, Stone, McMillan
Personnel

Data converted --> HDCS_Data in CARIS
TrueHeave applied
SVP applied

GPS Tide

Tide applied

Zone file
Lines merged
Data cleaned to remove gross fliers

Compute correctors in this order
1. Precise Timing

2. Pitch bias

3. Roll bias

4. Heading bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS
Latency
Lines Used

Evaluators
Doroba
Stone
McMillan
Bobby
Rosenberg

Averages
Standard Deviation
FINAL VALUES

Pitch Lines
Latency (sec) Used
0.0000
0.0000
0.0533
0.0067
0.0000

Roll Lines
Pitch (deg) Used
0.6533
0.4067
0.4733
0.6733

Yaw Lines
Roll (deg) Used
0.3000
0.3267
0.3367
0.3233
0.3133

0.01
0.02
0.01

0.55
0.13
0.55

0.32
0.01
0.32

Final Values based on
Resulting HVF File Name

2903_Reson7125_SV2_400kHz_2017.hvf

MRU Align StdDev gyro
MRU Align StdDev Roll/Pitch

0.32
0.07

Value from standard deviation of Heading offset values
Value from averaged standard deviations of pitch and roll offset values

NARRATIVE
We need to figure out which beams to filter on STBD side and interference w SSS.

We need to figure out which beams to filter on STBD side and interference w SSS.

HVF Hydrographic Vessel File created or updated with current offsets
Name:

2903_7125_400kHz_2017

Date:

s

Yaw (deg)
-1.1000
-1.3733
-1.0200
-1.7367

-1.31
0.32
-1.31

nd roll offset values

8/20/2017
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Vessel Name: 2903_Reson7125_SV2_400kHz_2017.hvf
Vessel created: January 23, 2018

Depth Sensor:
Sensor Class:
Swath
Time Stamp: 2017-121 00:00
Comments: Initial measurements
Time Correction(s) 0.000
Transduer #1:
------------Pitch Offset:
0.000
Roll Offset:
0.000
Azimuth Offset: 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Manufacturer:
Reson
Model:
sb7125d
Serial Number:
_________________________________________________________
Navigation Sensor:
Time Stamp:

2017-121 00:00

Comments: (null)
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Manufacturer:
(null)
Model:
(null)
Serial Number:
(null)
_________________________________________________________
Gyro Sensor:
Time Stamp:

2017-121 00:00

Comments:
Time Correction(s) 0.000
_________________________________________________________
Heave Sensor:
Time Stamp:

2017-121 00:00

Comments: (null)
Apply Yes
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000
Manufacturer:
(null)
Model:
(null)
-1-
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Serial Number:

(null)

_________________________________________________________
Pitch Sensor:
Time Stamp:

2017-121 00:00

Comments: (null)
Apply Yes
Time Correction(s) 0.000
Pitch offset: 0.000
Manufacturer:
(null)
Model:
(null)
Serial Number:
(null)
_________________________________________________________
Roll Sensor:
Time Stamp:

2017-121 00:00

Comments: (null)
Apply Yes
Time Correction(s) 0.000
Roll offset: 0.000
Manufacturer:
(null)
Model:
(null)
Serial Number:
(null)
_________________________________________________________
Draft Sensor:
Time Stamp:

2017-121 00:00

Apply Yes
Comments: (null)
Time Correction(s) 0.000
Entry 1) Draft: 0.000
Speed: 0.000
Entry 2) Draft: 0.010
Speed: 0.972
Entry 3) Draft: 0.020
Speed: 1.944
Entry 4) Draft: 0.030
Speed: 2.916
Entry 5) Draft: 0.040
Speed: 3.888
Entry 6) Draft: 0.050
Speed: 4.860
Entry 7) Draft: 0.060
Speed: 5.832
Entry 8) Draft: 0.060
Speed: 6.803
Entry 9) Draft: 0.060
Speed: 7.775
Entry 10) Draft: 0.050 Speed: 8.747
Entry 11) Draft: 0.040 Speed: 9.719
Entry 12) Draft: 0.020 Speed: 10.691
Entry 13) Draft: -0.010 Speed: 11.663
Entry 14) Draft: -0.050 Speed: 12.635
Entry 15) Draft: -0.090 Speed: 13.607
_________________________________________________________
TPU
Time Stamp:

2017-121 00:00

Comments:
Offsets
Motion sensing unit to the transducer 1
X Head 1 0.002
-2-
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Y Head 1 0.271
Z Head 1 0.526
Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000
Navigation antenna to the transducer 1
X Head 1 0.721
Y Head 1 1.013
Z Head 1 4.207
Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000
Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000
Heave Error: 0.020 or 2.000'' of heave amplitude.
Measurement errors: 0.020
Motion sensing unit alignment errors
Gyro:0.080 Pitch:0.110 Roll:0.110
Gyro measurement error: 0.015
Roll measurement error: 0.005
Pitch measurement error: 0.005
Navigation measurement error: 0.500
Transducer timing error: 0.003
Navigation timing error: 0.003
Gyro timing error: 0.003
Heave timing error: 0.003
PitchTimingStdDev: 0.003
Roll timing error: 0.003
Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.000
Tide measurement error: 0.000
Tide zoning error: 0.000
Speed over ground measurement error: 0.100
Dynamic loading measurement error: 0.030
Static draft measurement error: 0.030
Delta draft measurement error: 0.020
StDev Comment: (null)
_________________________________________________________
Svp Sensor:
Time Stamp:

2017121:0000

Comments: (null)
Time Correction(s) 0.000
Svp #1:
------------Pitch Offset:
0.000
Roll Offset:
0.000
Azimuth Offset: 0.000
DeltaX: 0.002
DeltaY: 0.271
DeltaZ: 0.526
SVP #2:
------------Pitch Offset:
0.000
Roll Offset:
0.000
Azimuth Offset: 0.000
-3-
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DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
_________________________________________________________
WaterLine:
Time Stamp:

2017-121 00:00

Comments: (null)
Apply Yes
WaterLine -0.128
_________________________________________________________
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Vessel Name: 2903_SSS_100_2017.hvf
Vessel created: January 23, 2018

Navigation Sensor:
Time Stamp:

2017-231 00:00

Comments: (null)
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Manufacturer:
Applanix
Model:
POS M/V V4
Serial Number:
(null)
_________________________________________________________
Gyro Sensor:
Time Stamp:

2017-231 00:00

Comments: (null)
Time Correction(s) 0.000
_________________________________________________________
Tow Point:
Time Stamp:

2017-001 00:00

Comments:
Time Correction(s) 0.000
DeltaX: 0.564
DeltaY: 0.654
DeltaZ: 0.310
Manufacturer:
Model:
Serial Number:
_________________________________________________________

-1-
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Vessel Name: 2903_SSS_200_2017.hvf
Vessel created: January 23, 2018

Navigation Sensor:
Time Stamp:

2017-231 00:00

Comments: (null)
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Manufacturer:
Applanix
Model:
POS M/V V4
Serial Number:
(null)
_________________________________________________________
Gyro Sensor:
Time Stamp:

2017-231 00:00

Comments: (null)
Time Correction(s) 0.000
_________________________________________________________
Tow Point:
Time Stamp:

2017-001 00:00

Comments:
Time Correction(s) 0.000
DeltaX: 0.564
DeltaY: 0.654
DeltaZ: 0.310
Manufacturer:
Model:
Serial Number:
_________________________________________________________

-1-

THOMAS JEFFERSON
Multibeam Echosounder Calibration

Vessel: S-222

Date Acquired: 8/19/2017 (DN231)
Processing Log
8/13/2017
Date

254
Dn

Bowker, Wood, Glomb, Hiteshew
Personnel

Data converted --> HDCS_Data in CARIS
TrueHeave applied
SVP applied

VDATUM K:\Yearly Reports\2017\HSRR\VDATUM_SEP\VDatumSEP\PATCHTEST_LOCATION)XYwgs

Tide applied

Zone file
Lines merged
Data cleaned to remove gross fliers

Compute correctors in this order
1. Precise Timing

2. Pitch bias

3. Roll bias

4. Heading bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS
Latency
Lines Used

Evaluators
Glomb
Bowker
Wood
Hiteshew

Averages
Standard Deviation
FINAL VALUES

Pitch Lines
Latency (sec) Used
0.0000
0.0000
0.0000
#REF!

Roll Lines
Pitch (deg) Used
2.3400
2.3900
2.4500
#REF!

Yaw Lines
Roll (deg) Used
-0.0200
-0.0200
-0.0200
#REF!

#REF!
#REF!
#REF!

2.39
0.06
2.39

-0.02
0.00
-0.02

Final Values based on
Resulting HVF File Name

MRU Align StdDev gyro
MRU Align StdDev Roll/Pitch
NARRATIVE

0.08
0.03

Value from standard deviation of Heading offset values
Value from averaged standard deviations of pitch and roll offset values

HVF Hydrographic Vessel File created or updated with current offsets
Name:

2904_Reson7125_SV2_400kHz_2017_KAG.hvf

Date:

ST_LOCATION)XYwgs84-mllw_GEOID12A.CSAR

s

Yaw (deg)
-0.4700
-0.5000
-0.3500
#REF!

-0.44
0.08
-0.44

nd roll offset values

9/13/2017

NOAA Launch 2904 Sidescan Calibration - 75mRS
Side Scan run on Dn231. MBES run on Dn254.

MBES Position of Contact
Lat
Long
36.8651381
‐76.32110282
Line Hdg
SSS Contacts
1
2
3
4
5
6
7
8
9
10

36.8651361
36.86515519
36.86515432
36.86515003
36.86514501
36.86514279
36.86513692
36.86511936
36.86512713
36.86512224

‐76.3211092
‐76.3211189
‐76.3210875
‐76.3211197
‐76.3210844
‐76.3210914
‐76.3211014
‐76.3211135
‐76.3211069
‐76.3211084

Lat Diff (m) Long Diff (m)
‐0.22
1.90
1.80
1.33
0.77
0.52
‐0.13
‐2.08
‐1.22
‐1.76

000
090
180
180
180
270
270
090
000
090

‐0.57
‐1.43
1.36
‐1.50
1.64
1.01
0.12
‐0.95
‐0.36
‐0.50

Dist. (m)
0.61
2.38
2.26
2.00
1.81
1.14
0.18
2.29
1.27
1.83

Along Trk Across Trk (m)
(m)
‐0.57
‐0.225
‐1.90
‐1.428
‐1.36
‐1.802
1.50
‐1.326
‐1.64
‐0.767
0.52
‐1.011
‐0.13
‐0.124
2.08
‐0.952
‐0.36
‐1.219
1.76
‐0.499

Dist. (m)
0.61
2.38
2.26
2.00
1.81
1.14
0.18
2.29
1.27
1.83
Figure 1. 1m3 cube mobile target used to certify hull‐mounted
SSS on TJ HSL 2904.
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36.86512499

N
DOF: 2N‐1

‐76.3211205

10
19

90

Average:
StDev:

‐1.46

‐1.57

2.14

‐1.57

‐0.05
1.43

‐0.25
1.15

1.63
0.73

‐0.01
1.26

Criteria: 95% Confidence that any future measurement will not give a positional error
greater than 10 meters.
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Setting the distance error equal to 10 meters and using the Chi-squared
value for one degree of freedom and alpha = 0.05, solve for the maximum value
for the true value of the standard deviation of the x and y error.
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The sample estimate of the standard deviation will also be Chi-squared distributed
At a 95% confidence interval the standard deviation range is:
best est.
95% Confidence
x,y StDev
1.3
1.7
And the 95% confidence inteval of the positioning error is:
Error
2.5
3.4
PASS
Note: FPM method of 1.96*RMS standard deviation
3.6
PASS
Error:
Alternate FPM method of mean radial distance plus 1.96*radial standard deviation
Error
3.1
FAIL

‐15
easting
(m)

Figure 2: Contact position errors in a geographic refernece
frame. Most contacts were reported southwest of the actual
position.

along track (m)

So:

2

northing (m)

Assuming x and y errors are goverened by the same normal distribution, the
square of the distance error is governed by Chi-squared statistics.
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Figure 3: Contact position errors in a ship aligned reference
frame.

NOAA Launch 2904 Sidescan Calibration - 75mRS
Side Scan run on Dn231. MBES run on Dn254.

MBES Position of Contact
Lat
Long
36.8651381
-76.32110282
Line Hdg
SSS Contacts
1
2
3
4
5
6
7
8
9
10

36.8651361
36.86515519
36.86515432
36.86515003
36.86514501
36.86514279
36.86513692
36.86511936
36.86512713
36.86512224

-76.3211092
-76.3211189
-76.3210875
-76.3211197
-76.3210844
-76.3210914
-76.3211014
-76.3211135
-76.3211069
-76.3211084

000
090
180
180
180
270
270
090
000
090

Lat Diff (m) Long Diff (m)
-0.22
1.90
1.80
1.33
0.77
0.52
-0.13
-2.08
-1.22
-1.76

-0.57
-1.43
1.36
-1.50
1.64
1.01
0.12
-0.95
-0.36
-0.50

Dist. (m)

Along Trk Across Trk (m)
(m)
-0.57
-0.225
-1.90
-1.428
-1.36
-1.802
1.50
-1.326
-1.64
-0.767
0.52
-1.011
-0.13
-0.124
2.08
-0.952
-0.36
-1.219
1.76
-0.499

0.61
2.38
2.26
2.00
1.81
1.14
0.18
2.29
1.27
1.83

Dist. (m)
0.61
2.38
2.26
2.00
1.81
1.14
0.18
2.29
1.27
1.83
Figure 1. 1m3 cube mobile target used to certify hull-mounted
SSS on TJ HSL 2904.
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Criteria: 95% Confidence that any future measurement will not give a positional error
greater than 10 meters.
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Setting the distance error equal to 10 meters and using the Chi-squared
value for one degree of freedom and alpha = 0.05, solve for the maximum value
for the true value of the standard deviation of the x and y error.
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Ship Frame Error
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Assuming x and y errors are goverened by the same normal distribution, the
square of the distance error is governed by Chi-squared statistics.
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The sample estimate of the standard deviation will also be Chi-squared distributed
At a 95% confidence interval the standard deviation range is:
best est.
95% Confidence
x,y StDev
1.3
1.7
And the 95% confidence inteval of the positioning error is:
Error
2.5
3.4
PASS
Note: FPM method of 1.96*RMS standard deviation
Error:
3.6
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Alternate FPM method of mean radial distance plus 1.96*radial standard deviation
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Figure 2: Contact position errors in a geographic refernece
frame. Most contacts were reported southwest of the actual
position.
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Figure 3: Contact position errors in a ship aligned reference
frame.
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2016 October 14 to 20

Glen Rice

NOAA Office of Coast Survey

NOAA SHIP THOMAS JEFFERSON
EM710 AND EM2040
ACCEPTANCE TESTING
With Hydrographic Systems and Technology Programs
Multibeam Sonar Acceptance Procedures

Executive Summary

A Kongsberg EM2040 multibeam and an EM710 MKII multibeam were installed aboard NOAA Ship
Thomas Jefferson during an extended shipyard period at the Coast Guard yard in Curtis Bay in Baltimore,
MD during the spring and summer of 2016. After a short stay at the Atlantic Marine Operations Center
in Norfolk, VA, the ship proceeded with acceptance testing of the new survey systems in the areas
between Norfolk and Hudson Canyon during the third week of October, 2016, with the assistance of
Office of Coast Survey and Kongsberg personnel.
All portions of the Office of Coast Survey Sonar Acceptance Procedures were addressed, but the value of
some tests were limited by the physical oceanography during testing. While working to confirm proper
integration and operation of the new survey systems some important limitations to the installation were
uncovered and characterized.
Key findings:
1. Both the EM2040 and EM710 are properly integrated with the supporting sensors.
2. A significant artifact presents itself in the outer beams of both multibeams. This artifact is
transient and not motion correlated. While troubleshooting of this artifact is ongoing, at this
time it is believed to be associated with the specific installation and not a defect in the
hardware. Efforts to solve this problem include:
a. Bringing the paint covering both transducers to Kongsberg specifications.
b. Removing the fairlead forward of the transducer installation.
It is not yet known if these efforts will resolve this artifact. In the interim it is recommended
that the ship limit the survey swath to 45 degrees on either side by running in Single Sector
mode, although the problem still persists at times even within the reduced swath.
3. A backscatter artifact persists on the port side as a small section of depressed backscatter and at
45 from vertical in the 200 kHz mode of the EM2040. Efforts to solve this problem include:
a. Bringing the paint covering the EM2040 transducer to Kongsberg specifications.
b. Removing filler material added during the previous shipyard to smooth the surface
around the transducer.
c. Lowering the EM2040 transmitter to meet current Kongsberg specifications.
It is not yet known if these efforts will resolve this artifact.
4. A recommended Caris HIPS workflow had been provided to the ship. This recommended
workflow is recognized as restricted to specific steps and integrating specific data to avoid post
processing pitfalls.
While preliminary steps have been taken to remedy the problems described above, testing is still
ongoing. Coast Survey plans to stay engaged in finding and implementing a solution to the described
artifacts such that the survey systems can be used to their full potential.
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1 General Overview
The NOAA Ship Thomas Jefferson was dry docked in the U.S. Coast Guard Curtis Bay Shipyard in
Baltimore, MD, during 2016 to replace a defunct Kongsberg EM1002 with a new Kongsberg EM710 MKII
1° x 0.5° multibeam echo sounder, and replace a pair of Reson 7125s with an EM2040. Coast Survey
Hydrographic Systems and Technology Branch (HSTB) personnel were on board for the acceptance
cruise to assist OMAO Marine Engineering with integration and testing of the new systems. The cruise
departed from Norfolk, VA on Friday, 14 October 2016, and returned to Norfolk on Thursday, 20
October, with the ship traveling as far as the deep end of Hudson Canyon.
Originally the USNS Littlehales, NOAA Ship Thomas Jefferson (Figure 1) is a 63 meter long hydrographic
vessel built by Halter Marine in 1991. Propulsion includes one main engine plus a bow thruster. An
additional smaller drive on the main shaft is only used for maneuvering. Thomas Jefferson conducts
bathymetric surveys in the Caribbean and the East Coast of the United States, generally in support of
Office of Coast Survey. Other echo sounders on the ship include a bridge fathometer, Doppler speed
log, and several Simrad ES60s. A Knudsen sub-bottom profiler transducer is mounted but has not been
commissioned, and is thus not currently usable.

Figure 1- NOAA Ship Thomas Jefferson in the Coast Guard yard.

The Kongsberg EM2040 multibeam echo sounder is the second EM2040 in the NOAA fleet, but the first
with the new “slim PU” design. This version should be supported for longer with firmware updates
extending the usable life. The Kongsberg EM710 MKII multibeam echo sounder is the second of its kind
in the NOAA Fleet, with one installed the previous year aboard NOAA Ship Nancy Foster. Both the
EM710 and EM2040 were mounted on a new pod (Figure 2) on centerline and near the location of the
old EM1002. Testing of the new echo sounders followed the HSTB Sonar Acceptance Procedures,
version 1.0. Visiting personnel to support acceptance work included Glen Rice from HSTB, Neil Weston
from Coast Survey, with Paul Johnson and Dr. Anand Hiroji from the University of New Hampshire
Center for Coastal and Ocean Mapping. Anthony Dalheim from Kongsberg Underwater Technologies
Inc. (KUTI) was also aboard to support installation and acceptance work.
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Figure 2- NOAA Ship Thomas Jefferson survey transducers from below and looking aft. The Kongsberg EM710 MKII 1° x 0.5°
system includes the top two transducers in center pod, while the EM2040 system includes the bottom two. Also visible are the
ES60 transducers in the pod on the right (port). The left (starboard) pod has an intake for an inboard surface sound speed
sensor.

2 Overview of schedule and conditions
2.1 Preplanning
Planning for the acceptance cruise evolved with the personnel involved and timing of the cruise. HSTB
personnel coordinated with the ship’s command and Coast Survey to establish a plan for acceptance
testing. Eight days were allocated by Office of Marine and Aviation Operations for acceptance testing,
including transit time.
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Figure 3 - Acceptance testing planned locations as displayed on chart 13003.

2.2 Executed Schedule











Tuesday, 11 October – Rice Arrives aboard in Norfolk
Wednesday, 12 October – Underway in Chesapeake Bay for crew familiarization. Some initial
integration testing and interference testing with the EM2040.
Thursday, 13 October – Initial attempt at a patch test but conditions are unsuitable. Shallow
water noise testing, some tests with doppler speed log on.
Friday, 14 October – Johnson, Hiroji, Weston and Dalheim arrive via small boat transfer to begin
acceptance cruise.
Saturday, 15 October –Second attempt at EM2040 Patch Test at Bow Mariner wreck site.
Sunday, 16 October – Patch Test at Tom’s Canyon for EM710 and EM2040, EM2040 Extinction
Test at Hudson Canyon.
Monday, 17 October – Extinction Test for EM710 and EM2040, EM710 Medium and Deep
Accuracy Testing.
Tuesday, 18 October – Extinction Test for EM710 and EM2040, deep noise test for EM2040 and
EM710.
Wednesday, 19 October – At Bow Mariner for EM2040 Accuracy, EM710 Shallow Accuracy, and
EM710 and EM2040 Object Detection, EM710 and EM2040 Shallow Noise.
Thursday, 20 October – Multispectral backscatter testing, arrive in port.

3 Pre-Installation Testing
3.1 Test Data Processing Workflow
NOAA Ship Thomas Jefferson’s new survey system required a different configuration and slightly
different workflow than was used for past NOAA Kongsberg systems. Other Kongsberg multibeams in
the NOAA fleet have been configured with the reference point at the transmit transducer to overcome
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deficiencies in the treatment of lever arms in Caris HIPS for these systems ([1], [2]). Thomas Jefferson
has two Kongsberg multibeam systems and they cannot both be identified as the primary reference
point for the survey system. In June of 2016, HSTB conducted an analysis of the updated CARIS HIPS 9
ray tracing algorithm to confirm proper application of lever arms [3]. While this analysis showed the
lever arm issue had been resolved, there are still post-processing impacts to the location of the
reference point. This is discussed further in Section 7.1.
We also tested the application of the ellipsoid height from a raw Kongsberg *.all file using Caris 9.1 and
Qimera 1.3. Thomas Jefferson has regularly used MarineStar with their POS M/V to provide real time
ellipsoid heights that can be used directly, cutting down on post processing time. Heights are recorded
within the Kongberg data both as the original NMEA string in the position record and as a separate
height record. Testing demonstrated that when the GGA NMEA message was used the resulting depths
were referenced to mean sea level (MSL). The GGA message format accommodates both the height
relative to MSL as well as the separation to the ellipsoid used to derive MSL. However, the POS M/V
does not populate the separation value in favor of higher precision elsewhere in the record, which
means there is a lack of specification in the derivation of the datum. To avoid this ambiguity, Thomas
Jefferson was configured to use the GGK message, which only contains ellipsoid heights. This was done
with the intention that ellipsoid heights could be pulled directly into Caris through the *.all file without
the need to merge additional positioning files, thus streamlining the path to survey on the ellipsoid.
Testing in both Caris HIPS and Qimera 1.3.6 was successful in producing ellipsoid referenced results.

3.2 Determine data rates and file size
We estimated the anticipated data acquisition rate using the data collected during the extinction test
(Section 6.5). The purpose of this analysis is to aid in the planning of appropriate storage volume for an
anticipated survey. Data rates with and without water column files are described. Water column is
recorded to a separate *.wcd file, but total water column rates should be considered the combined
bathymetry and water column since both files are logged simultaneously. The bathymetry files contain
a number of records, including backscatter, attitude, vessel offsets and settings, etc. No effort was
made to quantify or predict the uncertainty associated with these estimates. The data rates strongly
depend on depth. For example, the EM710 logs water-column data approximately 100 times faster in
shallow water than in deep water. This means that continuous logging of full water column may be
practical in deep water (e.g. for methane seep detection), but may be prohibitive in shallow water.
The EM2040 data collection rates without water column are shown in Figure 4.
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Figure 4 - Data collection rates for the EM2040 without water column data.

The EM2040 data collection rates with water column are shown in Figure 5.

Figure 5 - Data collection rates for the EM2040 with water column data.

The EM710 data collection rates without water column are shown in Figure 6.
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Figure 6 - Data collection rates for the EM710 without water column data.

The EM710 data collection rates with water column are show in Figure 7.

Figure 7 - Data collection rates for the EM710 with water column data.

3.3 Operational hazards
No current environmental or safety regulations or hazards restrict use of this multibeam echo sounder.
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3.4 Determine user configurable system settings
The user configurable settings are as expected from past experience and relative to the SIS manual for
an EM710 MKII and EM2040.
The EM2040 has an additional setting that had previously not been tested. It is possible to change the
type of seafloor detection to “Min Depth”, which allows for the better capture of small targets in the
water column. The effects of this are discussed further in section 6.4.

4 Configuration
4.1 Sonar installation parameters
4.1.1

Vessel Survey and Reference Frames

Because Thomas Jefferson has two Kongsberg multibeams, the configuration successfully used on other
platforms (i.e. setting the system reference point at the transmit array) could not work for both systems
with a single POS/MV system. Because of the dual multibeam installation and only one possible primary
reference point, the reference point was placed top dead center of the IMU, and all angular offsets were
defined in the IMU frame.
Both of the EM710 transducers, RX and TX, are mounted in what Kongsberg considers a “forward”
configuration. However, both of the EM2040 transducers are in what Kongsberg considers a “reversed”
configuration. While this is not expected to cause problems with the current post processing software,
historically the reversed configuration has caused complications and is worth noting.
The values used for lever arm offsets and angular rotations were based on the information provided by
IMTEC, the survey company contracted by Kongsberg to conduct the vessel offset survey (included in
appendix). Tables were provided for the ship reference frame, the IMU reference frame, the EM710
transmitter reference frame, and the ORU reference frame. The raw survey x-y-z locations in the survey
reference frame were also provided. While the IMU reference frame table was used to describe all
offsets and angles for the vessel configuration, the output from the IMU itself is rotated by the patch
test values in SIS to bring it into alignment with the surveyed IMU frame.
While alongside in Norfolk an investigation into the vessel waterline using the draft marks, the vessel
ellipsoid height, and a hull mounted sutron gauge was undertaken. A description of this work and
results can be found in the appendix. In short, we validated that all methods of obtaining draft were
consistent within their precision and that the bubbler gauge was the most precise.
The ship’s underway settlement was also estimated while underway in Chesapeake Bay using ellipsoid
relative techniques in HSTB’s AutoQC tool. These results were comparable with past dynamic draft
tests.

4.1.2

Data Flow Configuration

The data flow for a Kongsberg multibeam is multilayered. Multibeam data moves from the TRU to the
SIS acquisition workstation. Data can be sent directly from SIS or from two other Kongsberg programs
on the SIS workstation to an external client. While this flexibility provides many different options for
configuration, it can also be confusing and easily confounded. The approach taken for this installation
was mixed. The Kongsberg program, DataDistrobution.exe, was used to forward the multibeam data
from the workstation to Hypack. This program has been designated to autostart when the SIS
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workstation is booted through the Windows Startup folder and must be allowed to run in the system
tray or in the background at all times. If this program is closed, data will not be delivered to Hypack.
Sound speed packets were sent from a lower level data distribution program to Velocipy.
The survey system was configured as described in Figure 8.

Figure 8 - The Thomas Jefferson survey system configuration as of the acceptance cruise.

Water column logging through SIS on both EM systems is licensed for the Thomas Jefferson. When
water column is logged a separate raw *.wcd file containing water column records is produced. In
addition, this file contains the attitude, position, system settings, installation parameters, and sound
speed profiles. While these records are duplicates of some of the bathymetry file contents, these
records make the independent use of the water column data easier as no pairing or merging between
the *.all and *.wcd files is necessary.
A trigger cable to force the EM2040 to trigger from the EM710 transmit was built and installed by ship
personnel as the request of the acceptance team. Triggering in this fashion causes the two systems to
ensonify the same piece of the seafloor which is valuable to multi-frequency backscatter work. Enabling
the trigger is completed within the EM2040 SIS software.
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4.2 Ancillary equipment setup
4.2.1

Position and Attitude

The POS M/V was configured to send navigation (NMEA INGGK string) and attitude (Simrad 3000 (TateBryant)) through serial cables to the TRU for each multibeam though unbuffered serial data splitters. An
Ethernet connection from the POS M/V to each TRU was included for attitude velocity. The POS M/V
lever arms and rotations were configured with the IMU as the reference point as described in 4.1.1. The
POS M/V was checked to confirm proper connection to the primary / secondary antennas, and
MarineStar support remained as previously configured. Position and attitude were compared between
SIS and the POS M/V and were found to be equivalent. The POS M/V firmware for the PCS and GNSS
cards could not be updated because the hardware was no longer under an Applanix maintenance
contract.

4.2.2

Surface Sound Speed

There are three possible sources of surface sound speed aboard Thomas Jefferson, however both
multibeams were configured to only receive data from the hull mounted Valeport sound velocity sensor
during this cruise. The Valeport surface sound speed probe was configured to send an AML message
directly to SIS and was confirmed to work as expected. A benefit of using the Valeport is that it is
mounted on a seacock such that it can be retracted and removed for easy servicing (Figure 9). In
addition to the Valeport, the ship has a TSG and a Reson sound speed sensor mounted in a flow through
tank.

Figure 9 – The Valeport in the retracted positon as mounted on a closed seacock. When the value is open the sensor is deployed
by pushing down on the black handles.
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4.2.3

Profiling the Physical Characteristics of the Water Column

An MVP with a CTD sensor was used during acceptance work. The sensor was compared with a recently
calibrated Seabird CTD, as well as being compared with values from the Valeport surface sound speed
sensor, located at hull depth, and found to be working properly.
Velocipy was configured to send new casts directly to SIS for both multibeams and to receive a message
back noting that the cast was accepted by SIS. All cast extensions were made in Velocipy using either a
deeper cast or the World Ocean Atlas.
Unfortunately, Casttime was not functioning during the cruise. While Casttime was configured and
working before leaving port, some configuration change that remained undetermined caused Casttime
not to receive cast information from the MVP. Had Casttime been running, some of the problems
experienced during this cruise may have been alleviated. It was expected that ship personnel would
resolve this problem at a later date.

4.2.4

Hypack

Hypack was configured to accept data from SIS for real time display and communication with the bridge
only. For these tests, all multibeam data were logged through SIS. We recommend that SIS be used for
all future operational data logging as well.

4.2.5

Vertical control

Generally, the vertical reference for acceptance work was either the real time water level or the
ellipsoid depending on the requirement for a consistent vertical reference for the seafloor depth. The
ITRF 2008 ellipsoid was realized through MarineStar integration with the POS M/V which was recorded
both in the POS M/V files and in the Kongsberg *.all files. Where a comparison to previous surveys was
required, VDatum was used to shift from the ellipsoid to the applicable datum.

5 Alongside Testing
5.1 User interface and system control
The user interface and system controls for the EM710 and EM2040 operated the same as for previous
versions of SIS. SIS 4.3.2 was installed on the EM2040, and SIS 4.3.0 was installed on the EM710. Minor
changes to SIS are EM model specific, and these two versions are essentially the same.

5.2 System health self-tests
SIS Built In Self Tests (BIST) of all types were performed for both systems, including the extended tests
available through the TRU. While all BIST tests passed, a single receiver channel (number 52) on the
EM2040 showed a significantly different response, indicating a possible broken channel.

5.3 Evaluate stave data
See the discussion of BIST tests in 5.2.

5.4 Backscatter quality assessment
Backscatter quality was not assessed while alongside. Please see 6.6 for a discussion of backscatter
assessment and normalization while underway.
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6 Underway Testing
6.1 Patch Test
Patch testing was attempted in two separate locations but completed for both systems over Tom’s
Canyon, approximately 100 nm SE of New York City. We attempted to complete the patch test of the
EM2040 over the wreck of the Bow Mariner. Because the wreck tests lead to inconclusive results the
ship moved to Tom’s Canyon and patch tested both systems simultaneously. This location had been
used previously for patch testing the EM710 from NOAA Ship Nancy Foster. The 60 meter drop from
120 meters to 180 meters proved to be a good target for pitch and yaw lines. Roll lines were conducted
on top of the shelf just above the canyon, and confirmation lines were run across the canyon in a deeper
section. Patch test values are described for both systems in Table 1.
Table 1 - Patch test values for both multibeams.

All values are in degrees
Roll
Pitch
Yaw

EM2040
0.07
-0.05
0.70

EM710
0.02
-0.05
0.05

Figure 10 - The patch test lines at Tom Canyon. On the left is a profile of the pitch line. On the right is an overhead view of the
relief and patch test lines. Line 2 is pitch, 1 and 3 were for yaw, and 4 was for roll. Line 5 is the confirmation line, with the
maximum depth being at 450 meters.

We calculated an attitude time delay of 10 ms using the correlation of roll rate with swath slope artifact
as described in [4] using transit data from the EM2040 acquired after the Tom’s Canyon patch test.
There were significant artifacts in the bathymetry as described in section 6.4, which reduce confidence
in this estimate. EM710 noise was such that no estimate could be made with the same set of lines.
Subsequent work to improve the estimated time delay from the EM2040 data increased the estimate to
11 ms (Figure 11) with a reported uncertainty of 2 ms at two standard deviations from the covariance
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matrix used for line fitting. Similar work to extract a time delay for the EM710 resulted in similar values
to the EM2040. This time delay is entered in to SIS for both multibeams and the SIS recorded attitude
data time stamp is shifted accordingly for post processing. This time delay is different than the 14 ms
offset found with both NOAA ships Rainier and Fairweather but is sufficient until the outer beam
artifacts are removed and a better estimate can be made. The root cause of this time delay on this and
other systems remains unknown.

Figure 11 - Roll Rate to Swath Slope Correlation for the EM2040. Green line is a linear fit.

6.2 Acquire Reference Data Set
Three reference datasets in different depths were acquired for the EM710. One of these locations was
used for the EM2040 as well. These data are used to check for bathymetric biases across the swath by
comparing survey data with a dense reference surface. The IHO uncertainty standards (and similarly the
NOAA specification) contain both a depth dependent and depth independent error component; the
depth independent part (a in Equation 1) is intended to account for error sources such as vertical
control and draft measurement, the depth dependent factor (b in Equation 1) accounts for integration,
environmental, and echo sounder performance .
Equation 1: Vertical uncertainty limit equation from both IHO and NOAA Specifications.

=

(

)+( ∗ )

Because of the nature of these tests, the depth independent error parameters were not much varied, so
it is more appropriate to evaluate the performance only against the depth dependent component (i.e.
the ‘b’ parameter). For both IHO order 1 and NOAA Specifications, this is 1.3% of water depth.
EM2040 ACCURACY TESTING
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The area to the north of the wreck of the Bow Mariner was used for the reference surface. This area is
flat and generally ~75 meters deep (Figure 12). 200 kHz, 300 kHz and 400 kHz modes were tested.
Weather was 15 to 20 knots with seas 2 to 3 feet and with swells also 2 to 3 feet. Current was from the
north causing a set of approximately 6 degrees of heading when on line. A number of artifacts were
observed during these tests. The combined effect of which obscured identification of any one problem.
One of these problems was variable sound speed (Figure 13) at depth during testing. This variability
may have been caused by the propagation of internal waves. This impacted the performance of
EM2040 during this test, causing a larger apparent uncertainty than would be experienced during more
stable oceanographic conditions. Another artifact was a periodic, but non-motion correlated, leeward
outer beam artifact that is still being investigated. This artifact is discussed in more detail in section 6.4.
The reference surface was created from the object detection lines filtered to remove outer beam noise.
This analysis was conducted by accumulating data from several lines with opposing headings.

Figure 12 - The accuracy test site at the Bow Mariner. Accuracy data were extracted along the profile (blue line in top, plot in
bottom). The wreck can be seen as red in the bottom of the surface. Depths are relative to mean lower low water.
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Figure 13 – Sound Speed Profiles at the Bow Mariner site during object detection and accuracy testing. There are significant
changes in these casts between 10 meters and 60 meters of water depth.

The comparison between these data was conducted on the ellipsoid in Qimera 1.3.6.
The 400 kHz mode had a mean bias of less than 0.3% of water depth, which equates to 0.23 meters in 75
meters of water. While the pulse length was set to adjust automatically, during the 400 kHz tests the
pulse length was 107 microseconds with a CW pulse. A sound speed artifact is evident in the outer
swath due to the dynamic oceanographic conditions. Soundings fell within 0.6% of the mean difference
at two standard deviations. Note the maximum swath angle for the 400 kHz mode is restricted 60
degrees on each side. While these results meet expectations, these statistics should improve in more
ideal oceanographic conditions.

Figure 14 – EM2040 400 kHz accuracy results as a percent of depth. The blue line is the mean difference between the reference
surface and these data. The pink region is 2 standard deviations from the mean. IHO Order 1 is 1.3% for this location.
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The 300 kHz mode had a mean bias at nadir of less than 0.1% of water depth, which equates to 0.08
meters in 75 meters of water. While the pulse length was set to adjust automatically, during the 300 kHz
tests the pulse length was 370 microseconds with an FM pulse. A sound speed artifact is evident in the
outer swath due to the dynamic oceanographic conditions. Soundings approximately within 1.0% of the
mean difference at two standard deviations inside a 130° opening angle. While these results meet
expectations, these statistics should improve in more ideal oceanographic conditions and once the
additional artifact is resolved.

Figure 15 – EM2040 300 kHz accuracy results as a percent of depth. The blue line is the mean difference between the reference
surface and this line. The pink region is 2 standard deviations from the mean. IHO Order 1 is 1.3% for this location.

The 200 kHz mode had a mean nadir bias of less than 0.1% of water depth, which equates to 0.08
meters in 75 meters of water. The pulse length was set to adjust automatically, and during the 200 kHz
tests the pulse length was between 431 and 517 microseconds with an FM pulse. A sound speed artifact
is evident in the outer swath due to the dynamic oceanographic conditions. Soundings were
approximately within 1% of the mean difference at two standard deviations and inside 130° opening
angle. While these results meet expectations, these statistics should improve in more ideal
oceanographic conditions and once the additional artifact is resolved.
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Figure 16 – EM2040 200 kHz accuracy results as a percent of depth. The blue line is the mean difference between the reference
surface and this line. The pink region is 2 standard deviations from the mean. IHO Order 1 is 1.3% for this location.

EM710 ACCURACY TESTING
Three separate areas were used for accuracy testing of the Thomas Jefferson EM710 MKII. The modes
Shallow, Very Shallow, and Medium were tested at the same Bow Mariner site used for the EM2040.
Sound speed problems as discussed in the EM2040 section for the Bow Mariner site are also present for
the EM710. The EM2040 reference surface was used for the test, and was constructed from the
EM2040 object detection data as described previously. The 70 meter mean depth for this area would
normally be collected in Very Shallow mode which is used by the EM710 MKII systems in automatic
mode for depths between 0 and 100 meters.
Flat areas in the proper depths suitable for accuracy testing of the deeper modes are rare within a
reasonable steaming distance from Norfolk, VA and also not in the Gulf Stream. Areas near the
extinction line and just sound of Hudson Canyon were used for these deeper modes. These sites had
less than a 3° slope that ran across the reference surface. Because there were fishing vessels in the area
and this work was conducted at night, the MVP was not towed. Medium and Deep modes were tested
at more than one location to help provide some continuity between the locations.
Deep and Medium mode were tested in approximately 200 meters of depth (Figure 17). A CTD to 170
meters was taken at the medium depth site upon arrival. The 200 meter mean depth at this site would
normally be collected in either Shallow mode, optimized for depths between 100 to 200 meters, or in
Medium mode, good from 200 to 300 meters water depth.
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Figure 17 – The EM710 medium depth accuracy test site. Accuracy data were extracted along the profile (blue line in top, plot in
bottom). Depths are to the ellipsoid.

Deep, Very Deep and Extra Deep were tested in approximately 550 meters of water (Figure 18). A CTD
cast to a depth of 300 meters was taken in 600 meters of water with the extended point being
interpolated linearly from the last section of the water mass. The 550 meter mean depth for this area
would normally be collected in Very Deep mode which is optimized for depths between 500 and 1000
meters.
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Figure 18 - The EM710 deep accuracy test site. Accuracy data were extracted along the profile (blue line in top, plot in bottom).
Depths are to the ellipsoid.
Table 2 - A summary of the test location for each mode.

Mode
Very Shallow – Single & Dual Swath
Shallow – Single & Dual Swath
Medium – Dual Swath
Medium – Single Swath
Deep – Dual Swath
Deep – Single Swath
Very Deep – Single Swath
Extra Deep – Single Swath

Shallow Site




Medium Site






Deep Site
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Very Shallow mode was tested in both single and dual swath with each displaying the same
characteristics. Figure 19 shows the results for dual swath mode.

Figure 19 - EM710 Very Shallow Dual Swath mode accuracy results as a percent of depth. The blue line is the mean difference
between the reference surface and this line. The pink region is 2 standard deviations from the mean.

Shallow mode was also tested in both Single and Dual Swath in the same location with similar results.
Some noise is evident in the near-nadir region for this mode (Figure 20).

Figure 20 - EM710 Shallow Dual Swath mode accuracy results as a percent of depth. The blue line is the mean difference
between the reference surface and this line. The pink region is 2 standard deviations from the mean.
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Medium mode was tested at both the Bow Mariner (shallow) site and at the medium depth site (Figure
21, Figure 22). The results from these two locations were comparable, with more noise near nadir
evident at the shallower location. To reduce the effect of the sound speed artifact at the medium site,
we filtered the crossline to within +/- 15 degrees of nadir and generated the reference surface with
these filtered lines. We then used the main scheme lines to compare to the reference surface. Because
the main scheme lines were acquired closer to the time of the cast, they had less of an artifact. By
restricting the data collected later (cross lines) to the near nadir region and using the data collected
closer in time to the cast (main scheme lines) the effects of sound speed are reduced. In some cases
there was significant nadir noise that was not displayed directly in the plot, but was reflected in the
standard deviation (pink) part of the plot.

Figure 21 - EM710 Medium Dual Swath mode accuracy results as a percent of depth at the Bow Mariner site (75 meters). The
blue line is the mean difference between the reference surface and this line. The pink region is 2 standard deviations from the
mean.
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Figure 22 - EM710 Medium Dual Swath mode accuracy results as a percent of depth from the medium depth site (200 meters).
The crosslines have been used to make a small nadir-only surface and compared to the main scheme lines. The blue line is the
mean difference between the reference surface and this line. The pink region is 2 standard deviations from the mean.

Unfortunately, the same approach to reducing the sound speed effects cannot be used for deep mode
at the medium depth site since the main scheme lines were collected in medium mode. Deep mode was
tested in both Single and Dual Swath modes. Dual Swath mode showed significant nadir noise (Figure
23), while Single Swath mode show a large increase in noise in the starboard sector (Figure 24).

Figure 23 - EM710 Deep Dual Swath mode accuracy results as a percent of depth from the medium depth site (200 meters). The
blue line is the mean difference between the reference surface and this line. The pink region is 2 standard deviations from the
mean.
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Figure 24 - EM710 Deep Single Swath mode accuracy results as a percent of depth from the medium depth site (200 meters).
The blue line is the mean difference between the reference surface and this line. The pink region is 2 standard deviations from
the mean. The rapid change at +40 degrees is the port sector boundary.

Very Deep and Extra Deep modes do not have Dual Swath capability and were thus only tested in Single
Swath mode. The data were within 1% of water depth at two standard deviations to the mean
difference, which equates to approximately 6 meters at this location.

Figure 25 - EM710 Very Deep mode accuracy results as a percent of depth from the deep site (~550 meters). The blue line is the
mean difference between the reference surface and this line. The pink region is 2 standard deviations.
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Figure 26 - EM710 Extra Deep mode accuracy results as a percent of depth from the deep site (~550 meters). The blue line is the
mean difference between the reference surface and this line. The pink region is 2 standard deviations.

6.3 Noise floor testing
The purpose of noise testing is to assess sources of acoustic interference that may impact data quality.
Also, establishing a baseline noise level provides for the opportunity to identify significant changes in
the future. Noise floor testing was completed in several locations for different conditions. Tests were
conducted using both the BIST RX Noise and RX Noise Spectrum functions in SIS as well as with water
column in passive mode. Passive water column is shown as averaged along each beam as a time series
of all pings. These data are then also averaged by each beam for each speed. Averaging by beam
assumes that noise is at a consistent angle relative to the vertical, and in the case where noise is
transducer relative the noise may be smeared across several angles as the vessel rolls. Averaging was
completed in the linear domain after data outside of 3 standard deviations was removed from the time
series. EM2040 analysis on passive water column is limited to the even pings because the odd pings did
not present usable data due to a firmware problem. This problem was reported to Kongsberg and a fix
is forthcoming. Only the main engine was used during testing.
A deep test area was chosen at the bottom of the extinction line in 2500 meters of water to minimize
the effect of vessel noise reverberating off the seafloor. Both the EM2040 and EM710 were tested at
this site. The weather was from the southwest at 15 – 20 knots with seas and swells at 2 – 3 feet. Tests
were conducted both into and out of the weather.
Shallow water noise testing was undertaken in two locations. The EM710 shallow area was southwest
of the Bow Mariner wreck in a depth of 70 meters and was only conducted going into the weather,
which was from the southwest at 15 knots and 2 – 3 feet. EM2040 testing was also conducted in this
location and under the same conditions. In addition, noise testing was also conducted for the EM2040
inside Chesapeake Bay during some of which the Doppler Speed log was also active.
These results are presented in the following echo sounder specific sections.
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EM2040 NOISE TESTING
BIST noise tests are governed by preset Kongsberg settings but passive water column is sensitive to user
settings. The frequency mode is particularly important as it changes the echo sounder’s sensitivity to
noise at particular frequencies. Also, the maximum range setting changes the record length, with
shorter record lengths opening gaps between water column records where burst noise might occur. In
this case the deep water noise testing had a frequency setting of 200 kHz and a record length of 500
meters. The shallow water testing the in Chesapeake tested all frequencies but had a record time
equivalent to a 50 meters range scale. The shallow water testing south of the Bow Mariner wreck had a
frequency setting of 300 kHz and a record length of 100 meters.
The deep water BIST noise and noise spectrum tests collected into the seas are shown in Figure 27 and
Figure 28. No significant change in background noise level with change in engine RPM was identified.
Noise levels are generally low across all frequencies. This indicates that the system is limited by internal
noise rather than flow noise. As noted in section 5.2, channel 52 appeared not to function correctly.
There appears to be low background noise for all EM2040 frequencies as shown by the noise spectrum
test.

Figure 27 - Deep water BIST Noise tests heading into the seas.
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Figure 28 - Deep water noise spectrum tests heading into the seas.

Passive water column was also used to look at the beam formed deep water noise. Figure 29 shows the
entire into seas dataset (even pings only) with little identifiable change. When dead in water (DIW) the
noise was noticeably higher. Figure 30 shows the data as averaged by beam and by speed. In both
figures there is coherent noise at boresight, and therefore transducer relative, and changes beam
number as the vessel rolls. If this analysis were conducted by averaging through transducer relative
angles rather than vertically stabilized angles (beam numbers) the coherent noise would be even more
apparent in the speed relative plot. This coherent noise is likely electronic in origin.

Figure 29 - Deep water noise from passive water column heading into the seas. The EM2040 was in 200 kHz mode.
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Figure 30 - EM2040 deep water passive water column noise averaged by beam and for each speed heading into the seas.
EM2040 frequency setting was 200 kHz.

EM2040 deep water noise out of the seas is shown for comparison to the previous plots in Figure 31.
The same data for not making way is used as for heading into the seas, thus the apparent difference
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between stopped and moving ahead in the previous plot is the same as between going into the seas and
out of the seas, with heading down wind being a few dB higher.

Figure 31 - Deep water passive water column noise averaged by beam heading out of the seas.

EM2040 shallow water BIST noise testing from 14 meters of water within Chesapeake Bay is presented
in Figure 32. During the first set of tests the speed log was on and caused significant interference. At
500 RPM there is additional burst noise for the lower frequencies. Figure 33 shows how the EM2040
operates with low background noise across all frequencies with the same burst noise at 500 RPM.
Again, the speed log was active during the first set of tests and was clearly interfering with all
frequencies, although how it interfered depended on how the speed log transmit timed with the test.
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Figure 32 – EM2040 RX Noise BIST Tests from 14 meters of water in Chesapeake Bay. High, intermittent levels are interference
from the Doppler speed log.

Figure 33 - EM2040 RX Noise Spectrum test from 14 meters of water in Chesapeake Bay. High, intermittent levels are
interference from the Doppler speed log.
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Passive water column showed consistent noise results across all frequencies for all speeds as show in
Figure 34, Figure 35, and Figure 36. The speed log was secured for these tests. The nadir noise spike is
most significant at 300 kHz, but also exists for all speeds for the other frequencies. A significant number
of poor seafloor detections at nadir may result from this change in background noise in shallow water.

Figure 34 – EM2040 passive water column noise for the 200 kHz mode as averaged by beam and for each speed in 14 meters of
water.

Figure 35 - EM2040 passive water column noise for the 300 kHz mode as averaged by beam and for each speed in 14 meters of
water.
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Figure 36 - EM2040 passive water column noise for the 400 kHz mode as averaged by beam and for each speed in 14 meters of
water.

Figure 37 through Figure 40 are included to further stress the effects of the bridge speed log on the
EM2040. The first two plots are for the 200 kHz mode, while the second two plots are for the 300 kHz
mode. The beam averaged passive water column shows the change in average backscatter levels by
ping. A single ping from each frequency setting is also shown to demonstrate the effect of the speed log
in a real time view of the water column. The speed log should be secured during multibeam acquisition.

Figure 37 - EM2040 passive water column noise for the 200 kHz mode as averaged with each beam in 14 meters of water. The
speed log was active during this test.
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Figure 38 – EM2040 passive water column from a single “ping” for 200 kHz mode. Speed log interference is evident.

Figure 39 - EM2040 passive water column noise for the 300 kHz mode as averaged with each beam in 14 meters of water. The
speed log was active during this test.
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Figure 40 - EM2040 passive water column from a single “ping” for 300 kHz mode. Speed log interference is evident.

EM2040 noise testing was also conducted in approximately 70 meters of water as described previously.
This dataset includes higher rates of speed than were collected in Chesapeake Bay and are thus
presented here for completeness. No significant speed dependent change in noise is seen in the RX BIST
Noise test as shown in Figure 41, although there does appear to be some additional burst noise at 10
knots. The RX BIST Spectrum Noise test also shows good background results across all speeds with the
same burst noise at 10 knots. Background noise levels are higher in the Chesapeake data than for the
deep water and 70 meter tests, indicating some effect from seafloor reverberation of vessel noise.

Figure 41 - EM2040 RX Noise BIST Tests from 70 meters of water and into seas.
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Figure 42 - EM2040 RX Noise Spectrum test from 70 meters of water and heading into seas.

For comparison to the Chesapeake Bay data, the passive water column data from the 70 meter areas is
in Figure 43 and Figure 44. The background noise level is more on par with the deep water noise data,
and the nadir noise spike is much lower for the slowest (DIW and 2.6 kts) and highest (5.6 kts) speeds.

Figure 43 – EM2040 300 kHz passive water column averaged by beam, heading into seas in 70 meters of water.
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Figure 44 – EM2040 passive water column in 70 meters of water averaged by beam and by speed while heading is into seas.

These results do not indicate a specific recommended noise limited survey speed for the EM2040. Flow
noise above the DIW level is not observable in either shallow or deep water. While the noise floor is
higher in shallow water, it is not particularly dependent on speed and may or may not be due to the selfnoise of the ship itself.
EM710 NOISE TESTING
Passive water column testing for the EM710 was conducted in Shallow mode and with a 500 meter
range. These tests were conducted at the same location and time as the deep water EM2040 noise
tests.
Deep water noise testing did not demonstrate any speed dependence in the BIST noise tests for levels
by channel or by frequency other than small burst noise at the highest speed (Figure 45, Figure 46).
Both into and out of seas had similar results.
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Figure 45 - EM710 RX BIST Noise by speed and heading into seas in 2500 meters of water.

Figure 46 – EM710 RX BIST Noise Spectrum by speed and heading into seas in 2500 meters of water.
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The beam formed passive water column showed more noise toward the outer swath at the highest
speed, but the coherent noise at nadir remained at the same level (Figure 51, Figure 52).

Figure 47 - EM710 passive water column averaged by beam, heading into seas in 2500 meters of water.

Figure 48 - EM710 passive water column averaged by beam and by speed, heading into the seas in 2500 meters of water.

Shallow water noise testing for the EM710 was conducted at the same location and time as the EM2040,
and with the same settings as for the deep noise testing. BIST RX Noise and Noise Spectrum tests do
show a speed dependence in this depth of water (70 meters), with higher background noise at higher
speeds. Because this increase in levels was not observed in the deep area, this noise is likely not flow
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noise, but rather propulsion related self-noise propagating to the receiver via a bottom-bounce acoustic
(e.g. downward radiated propeller noise, machinery noise through hull, etc.).

Figure 49 – EM710 RX BIST Noise by speed and heading into seas in 70 meters of water.

Figure 50 – EM710 RX BIST Noise Spectrum by speed and heading into seas in 70 meters of water.
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Passive water column confirms the speed dependent noise observed in the BIST Noise tests in this water
depth with the EM710. The change in background noise is most significant around nadir (as would be
expected with an in-band bottom bounce noise source), which could potentially lead to noisier
detections in this area of the swath at higher speeds and in shallow water. There is no clear noise floor
limiting cutoff in acceptable survey speed.

Figure 51 - EM710 passive water column averaged by beam, heading into seas in 70 meters of water.

Figure 52 – EM710 passive water column averaged by beam and by speed, heading into the seas in 70 meters of water.
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6.4 Target detection and recognition
OBSERVATIONS OF OBJECTS
The Bow Mariner wreck site contains many objects that are useful for testing a system’s ability to detect
and recognize an object. Three objects were chosen to be investigated with both the EM2040 and
EM710. A debris field 1100 meters north of the wreck has an object that appears to stand 2.5 meters
proud of the surrounding seafloor, which is 76 meters deep. This object appears to be approximately 5
meters wide. In addition, the Bow Mariner has several masts that were used as objects for
investigation. The bow mast appears to stand 14 meters above the deck, which is at 55 meters of depth,
with an unknown width. The aft mast, just forward of the bridge, appears to stand 9 meters from the
deck, which is 55 meters from the surface, and be 4 meters wide.
The object detection performance of each multibeam was evaluated by counting the number of
detections both on top and in total on the object above the seafloor. While this counting method is
somewhat subjective (i.e. identifying what sounding is on the “top” of an object, which in this case was
simply within the observed cluster within approximately 0.2 meters of the average depth on top of the
feature), the number of points that would change from one count type to another should not have a
meaningful impact on the conclusion. Figure 53 shows the object north of the wreck and illustrates how
the points were counted. The EM2040 was in 300 kHz mode and the EM710 was in Very Shallow mode.
The EM2040 was tested twice for each angle, once with the “Normal” detection mode and once with
the “Min Depth” detection mode mentioned previously. No manual cleaning of soundings was
completed for this analysis, and while points that could be considered noise were tracked, they were
few enough that they did not present any meaningful conclusion for survey operations.

Figure 53 – The seafloor object 1100 meters north of the Bow Mariner wreck used for object detection work. Depths are in
meters from the ellipsoid.

Lines were run at different offsets from the target to investigate the effect of across track angle on
detections. The sounding counts for the EM2040 from swath angles between -20 and 71 degrees from
nadir as shown in Figure 54.
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Figure 54 – The number of detections on the object by the EM2040 by angle and for the Normal detection mode and Min Depth
detection mode. “Top” is the number of detection on the top of the object, while “All” is for all points perceived to be anywhere
on the object.

The EM2040 appears to make more than half of its detections on the top of the seafloor object, making
the representation of the least depth likely. Past 40 degrees, there are still numerous detection on the
feature, thus making detection of the existence of a feature likely, but the number of detections on the
top of the feature drops off quickly. Out to 65 degrees there are still detections on the object but the
least depth is no longer reliably captured. The min-depth setting did not substantially increase the
detections on the top of this object.
Using the same lines and methods, the sounding counts for the EM2040 from swath angles between -20
and 71 degrees from nadir as shown in Figure 55.
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Figure 55 - The number of detections on the object by the EM710 and by angle. “Top” is the number of detection on the top of
the object, while “All” is for all points on the object.

The EM710 does not have as many observations on the object, potentially in part due to a slightly
smaller transmit beam width. Still, enough points are on the top of the object out to 40 degrees that the
object will likely be recognized as its least depth if observed. Outside of 40 degrees the number of
points on the top of the object drops off quickly, though the total soundings on the object are still high.
Like the EM2040, detection of an object outside of 40 degrees is likely, but reliable detection of the least
depth may not be.
The same analysis was completed for the bow mast on the Bow Mariner wreck (Figure 56). The number
of these detections was not as consistent as for the seafloor object, so the results are presented in
tabular form (Table 3).

Figure 56 – The bow mast feature as observed with the EM2040.
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Table 3 – The number of EM2040 observations on the forward mast for the top of the object and total on the object by angle.

Angle (Degrees)
Top / Total, # of points, Normal Detection Mode
Top / Total, # of points, Min Depth Mode

-30
0/3
3/25

22
0/8
2/16

71
0/0
0/18

While the EM2040 does detect the forward mast with soundings reported on the structure, out of seven
passes for each detection mode this object was only observed on three lines. Also, detections are only
provided by the EM2040 on the upper part of the mast when the system is in “Mid Depth” detection
mode. Qualitatively speaking, the object would only have been recognized if the system was in Min
Depth mode as the total number of detections and detections on the top of the structure made the
structure appear real rather than just noise.
The EM710 did not detect the bow mast on any of the survey lines.
This analysis was repeated for an aft mast near the bridge superstructure (Figure 57).

Figure 57 – The aft mast feature as observed in a single line with the EM2040.
Table 4 - The number of EM2040 observations on the aft mast for the top of the object and total on the object by angle.

Angle (Degrees)
Top / Total, # of points, Normal Detection Mode
Top / Total, # of points, Min Depth Mode

-8
0/3
9/11

35
0/0
0/5

45
0/8
0/5

58
0/4
0/0

While the EM2040 does detect the aft mast with sounding reported on the structure, out of eight passes
for each detection mode this object was only observed on three lines for each mode. Detections are
only provided by the EM2040 on the upper part of the mast when the system is in “Mid Depth”
detection mode. While this structure appears to have more volume than the forward mast, from
published pictures of the vessel it is also appears composed of a truss network rather than presenting as
a solid target. Also, this mast is observed within the side lobe reverberation of the bridge super
structure due to the heading during survey, making it difficult to have a clean detection. Qualitatively
speaking, the object would only have been recognized if the system was in Min Depth mode as the total
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number of detections and detections on the top of the structure made the structure appear real rather
than just noise.
The EM710 did detect the aft mast with 4 soundings, but these would not have made the object
recognizable as a significant structure.
Observations from the two targets on the wreck suggest that it helpful to run the EM2040 in Min Depth
mode when conducting developments over a structure with vertical structures typical of anthropogenic
features such as wrecks. The Normal detection mode appears to function just as well as Min Depth
mode over natural seabed objects. Min Depth mode did not appear to increase the amount of noise
added to the dataset over Normal mode, either over the wreck or over the flat seafloor. Even so, Min
Depth mode is likely to produce detections on water column objects, such as fish schools, which are not
desirable for hydrographic surveys. Unless further compelling evidence is found, we recommend that
Min Depth mode only be used during development work.
As noted previously, the number of noisy points around objects was also tracked. A screen grabs of the
Bow Mariner is show in Figure 58 to illustrate the point. In general, there is very little noise.

Figure 58 – EM2040 data from the wreck without cleaning.

It is worth pointing out, however, that when Kongsberg data is imported into Caris a significant number
of rejected points may be included (Figure 59). Kongsberg systems will produce interpolated or
extrapolated data but flag them as such. Caris imports this data and flags it as rejected by the echo
sounder. It is important not to reaccept these points.
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Figure 59 – EM2040 data from the wreck, showing data rejected, interpolated, or extrapolated by the MBES as grey.

SYSTEMATIC SURVEY SYSTEM ARTIFACTS
During the acceptance cruise an outer beam bathymetric artifact was observed. This artifact was
particularly noticeable over flat seafloors, and could not be correlated to motion. This artifact was also
confounded by internal waves during targeted testing, further confusing its source. An example of the
artifact can be found in Figure 60 and Figure 61.
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Figure 60 – The leeward artifact as observed in a single line of EM2040 data. The top plot is a profile view of the swath, while
the bottom is an overhead view of the line along which the profile was taken. Heading was toward the left.

Figure 61 – The leeward artifact as observed in a single ping of EM2040 data. Left is the swath cross section, right is the single
swath profile colored by depth.
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This artifact occurs over multiple pings, apparently moving toward nadir and subsequently moving
outward again. This artifact appears predominantly on the leeward side of the vessel, although can also
exist on both sides when the weather is not abeam. After extended review by Kongberg and HSTB, and
thanks to additional data collected by ship personnel post-acceptance cruise, this artifact is believed to
be due to some upstream source of micro bubbles. The most likely sources of these bubbles could be
one or more of three structures forward of the transducers, including a line cutter bar just forward of
the transducer mount, a small appendage on the bow, or the bow thruster. The bubbles are not directly
detected in the water column data or noise testing, but appear to be changing the sound speed of the
water. Conceptually, as a cloud of microbubbles passes past the echo sounder, the beams are refracted
away from nadir causing those beams affected to appear deeper. While this theory has yet to be
proven, there is currently no other explanation that accounts for the relative weather direction
dependence of this artifact.
Previous to the installation of the new survey echo sounders bubble sweep down was considered and
discussed with field experts [5]. Because it was important to the U.S. Navy to conduct quality
hydrographic surveys, previous testing of bubble sweep down of the Thomas Jefferson hull (as the USNS
LittleHales) had been completed. Of the three likely sources of bubbles forward of the transducers, two
were added since ownership of the vessel passed to NOAA, the cutter bar installed with the gondola,
and the bow thruster. The cutter bar has been removed during a subsequent yard period, but no new
testing for the artifact has been completed. If the artifact still persists, the bow thruster remains the
likely candidate for the source of the bubbles since it was added by NOAA. Because abatement of
bubbles with the bow thruster as the source will likely require significant modifications to the ship, plans
for imaging the bubble cloud with cameras or imaging sonars has been discussed should the artifact still
be present.
The standing recommendation is for the ship to collect EM2040 data in single sector mode until the
bathymetric artifact is resolved. This restricts coverage to 45° on either side, reducing the likelihood
that the artifact will be present in the collected bathymetry. While this configuration is not ideal, and a
frustrating situation for a brand new survey system, the ship regularly conducts side scan surveys where
the multibeam is primarily used to fill in at nadir and gather general bathymetry. In the short term
limiting the data to only the good part of the swath will help avoid introducing questionable data into
the survey workflow. This problem clearly needs to be resolved such that Coast Survey can use these
new tools to their full potential.

6.5 Sonar Performance Parameters
The useable swath width as a function of depth is important to survey planning, survey quality, and
survey efficiency. Both the EM2040 and EM710 were tested by running the systems up and down a
slope and plotting the usable swath as a function of depth. The usable swath width is defined by the
outermost good beam on each side of the swath as reported by the multibeam. Because seafloor type
has a strong impact on the returned signal level, the achievable swath width does depend on the
seafloor type. Ideally, we would run these tests over a steady slope of homogeneous (and known)
sediment type. It is worth noting, that the identified outermost good beam can still contain noise or an
incorrect depth as it has only been designated “good” by the system.
EM2040 EXTINCTION TEST
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The EM2040 was tested for all frequency modes but left to automatically select the pulse length. The
planned location for EM2040 extinction testing contained significant amounts of fishing gear, thus a
different testing location was selected on the fly. While the improvised location for extinction testing
had a suitable maximum depth, the minimum depth did not allow for all modes to clearly demonstrate
how the system would perform in shallow water without considerable additional transit time. Also, this
location appeared to have a significant change in the seafloor type (Figure 62) which caused an
abnormal inflection in the extinction curve at approximately 200 meters (Figure 63).

Figure 62 - A line in 300 kHz mode from the first extinction site demonstrating the change in backscatter as seen in QPS FMGT.

Figure 63 – EM2040 extinction data at the improvised location. The pulse length was selected by the system automatically.
Shown are the outermost good detections on each side of the swath.
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To supplement this test, the EM2040 was also run during the EM710 extinction test. 200 kHz data was
collected while steaming down the slope, and 300 kHz data was collected while steaming up the slope
(Figure 64). These results have a smoother transition between depths than the improvised location as
would be expected for a consistent seafloor type over the test area.

Figure 64 – EM2040 extinction testing on the EM710 extinction test line. The pulse length was selected by the system
automatically. Shown are the outermost good detections on each side of the swath.

For all three frequency modes the Thomas Jefferson EM2040 appears to meet the Kongsberg specified
swath width by depth within the uncertainty of variability due to seafloor type. In general, the
performance follows the predicted extinction curve for a cold ocean with a sandy seafloor. The
variability of the results with apparent seafloor type is expected, and worth remembering when
planning surveys using these plots. Results will vary based on the seafloor conditions encountered in a
particular area.
EM710 MKII EXTINCTION TEST
The EM710 extinction line ran from 75 meters down to 2500 meters of depth along the southern side of
Hudson Canyon. This appears to be a good location for this test as the slope has minimal interruptions
from canyons between the applicable depths that would interfere with the results. The EM710 was left
to select the mode automatically, and was only tested in the 40 – 100 kHz mode. The other modes (e.g.
40 kHz mode, 50 kHz mode, and 70-100 kHz mode) largely use sub-modes of the 40 – 100 kHz modes,
and Thomas Jefferson is expected to have no need to operate in these specific modes.
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Figure 65 – EM710 extinction test results. The mode setting was selected automatically. Shown are the outermost good
detections on each side of the swath.

The EM710 MKII follows the predicted seafloor performance predicted for a cold ocean with a rocky
seafloor. While no seafloor samples were taken during acceptance testing, it is unlikely that the seafloor
was rocky during the duration of the line. Assuming the seafloor was not rocky, the EM710 likely
exceeds the predicted Kongsberg performance swath width by depth performance.

6.6 Backscatter quality assessment
Kongsberg multibeam echo sounders adjust the recorded seafloor backscatter to account for beam
pattern effects. The real time backscatter can be improved and made more useful by updating this
adjustment with values post-installation. To accomplish this, some form of backscatter calibration
needs to be completed to update these parameters. Currently these parameters can be adjusted on the
EM710 but not on the EM2040. The BSCorr.txt file stored on the TRU contains the power level used for
each sector of each mode as well as the relative receiver sensitivity by angle. Previous methods
adjusted the sensitivity settings to account for the differences in backscatter levels between sectors and
modes. For Thomas Jefferson only the power levels were adjusted to align the sectors.
Two types of backscatter calibrations were used during this cruise for the EM710 modes mostly likely to
be used aboard Thomas Jefferson. Time was not taken to calibrate the lesser modes less likely to be
used (e.g. 40 kHz, 50 kHz , 70 – 100 kHz) since the available time for calibration was not clear when in
the proper locations. The same method for collecting calibration data as was used in the past, consisting
of a single line in each direction for each mode over a flat seafloor, was used in this case as well.
Because of limited time for analysis, implementation, and testing, only the power offset was used to
normalize between sectors. This approach improved the real time backscatter considerably (Figure 66)
while also simplifying the changes needed to the Kongsberg BSCorr file. Modifying the angle sensitivities
can be laborious if undertaken by angle as has been done previously.
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Figure 66 – Seafloor backscatter with the EM710 before the BSCorr.txt file was adjusted (left) and after adjustment (right).

The relative changes made to the port and starboard sectors to match the backscatter produced by the
center sector are listed by mode in the summary in Table 5. The center sector was left with the default
power value. The units for the sector power are not defined but are assumed to be some form of
transmit power in dB.
Table 5 – The updates made to the default EM710 BSCorr sector power.

Very Shallow – Dual Swath 1
Very Shallow – Dual Swath 2
Shallow – Dual Swath 1
Shallow – Dual Swath 2
Medium – Dual Swath 1
Medium – Dual Swath 2

Port Adjustment (KM Units)
+8.0
+8.0
+7.5
+9.5
+6.0
+7.0

Starboard Adjustment (KM Units)
+8.0
+8.0
+8.0
+9.5
+7.0
+8.0

Data were also collected for a secondary approach which was developed Dr. Anand Hiroji. These lines
were run to determine the full transmit beam pattern as described in [6]. Dr. Hiroji continuous work on
these data and will provided results to the ship when complete.
While the EM2040 backscatter was not calibrated, observation of the backscatter showed an
unexplained artifact when operating in 200 kHz mode (Figure 67). This artifact appears as an area of
depressed backscatter on the port side at 30 degrees from nadir, roughly where sector boundaries
would be expected if 200 kHz had three sectors. The 200 kHz mode only has two sectors.
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Figure 67 – The EM2040 200 kHz mode backscatter artifact.

Kongsberg identified changes to the installation that may remove or improve this artifact. Kongsberg
was primarily concerned that the EM2040 transmitter was not protruding down from the cover plate
sufficiently, and that the faring compound around the transducer may be interfering with transmission.
In addition, they also recommended changing the amount of paint coating the transducers. They
considered the amount of paint evident on the transducers from pictures excessive, and felt that it could
also be impeding performance. These recommended adjustments were accomplished during a follow
on shipyard period but testing to quantify any improvement has not yet been completed.

7 Data Workflow Integration
7.1 Test application of post processed correctors
Post processing for the Thomas Jefferson acceptance cruise was conducted in Caris HIPS versions 9.1 and
Qimera 1.3. With previous Kongsberg installations in the NOAA fleet ([1], [2] ,[7]), the reference point
was set as the transmitter of the echo sounder, and the output of the inertial navigation system was
valid at this point. This configuration was chosen in those cases to eliminate the lever arm calculations
in Caris, which had a known deficiency in applying delayed heave corrections for Kongsberg systems.
For the Thomas Jefferson, we elected to make the IMU the reference point (see section 4.1.1 for more
information). This choice was primarily motivated by the fact that with two multibeam systems and a
single positioning system we could not have the reference point uniquely at each transmitter. This
configuration is also common NOAA practice (for non-Kongsberg systems) and seems to be more
intuitive to many. As tested in [3], the former lever arm related delayed heave errors seem to have
been resolved in Caris 9.1, however survey work following the cruise in shallow water with extreme
pitch revealed a residual pitch-related error and pointed to a complication with the desired HIPS
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workflow. A discussion of the current HIPS logic for Kongsberg systems as well as how the current
version of SIS effects the workflow is provided here for clarity.
Kongsberg systems provide the end user with both a processed sounding solution and the angle-range
raw data. Because the processed solution requires the application of many adjustments to the real time
data, some of the data, such as the motion data, can be modified from its raw state. Most notable to
this discussion, the motion data is modified according to the lever arms and angles provided in the
Installation and Test Parameters Sensor Setup tab (Figure 68). Roll, pitch and heading have the values
applied from the Attitude fields (commonly the patch test values), and heave is modified to account for
the induced heave due the lever arms from the motion sensor to the transducers when the vessel is
pitching (Figure 69). Thus the logged real-time attitude data in the .all file is valid at the transmitter and
in the transmitter frame. Because the real time solution is provided as vessel (reference point) relative
x, y, and z sounding locations, the navigation data is not translated.

Figure 68 - The Installation and Test Parameters, Sensor Setup, Angular Offsets for the NOAA Ship Thomas Jefferson EM2040.
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Figure 69 - Pitched induced heave (red arrow) is a result of the along track lever arm between the reference point (RP) and
transducers (TX).

In summary: the SIS logged real-time attitude (including heave) is valid at the transmitter and in the
transmitter frame; real-time navigation, including GNSS height information (e.g. GGK and EM Height
records), are valid at the ship reference point.
This difference in reference frames only becomes an issue in Caris HIPS when applying post-processed
navigation and attitude data. The primary reason for post applying any post-processed data is the
quality of the vertical information. Delayed heave or a post processed ellipsoid height can both
significantly improve on the real time solution, so it is desirable to have the option to apply these
adjustments in post processing. While a vertical offset can be straightforward to apply, the valid
location of the available vertical positioning data is important for proper accounting for the effects of
the motion induced heave.
Caris HIPS is designed around the integration of sensor data described in a single reference frame with
one sensor for each type of data. The Hydrographic Vessel File (HVF) describes the offsets between the
different sensors being integrated and accounts for those offsets where required. Processing Kongsberg
multibeam data within this framework is complicated by the existence of two possible reference frame
existing within the provided data. While in general Kongsberg data is meant to provide all data in the
vessel reference frame (patch test values are applied to motion information, ray traced soundings, etc),
real time heave and all raw transducer data (ranges and angles) are also provided in the transducer
reference frame. The Caris HVF accounts for this dual state by not applying any motion (everything is
apply = no) or offsets (Swath offsets are zero) when the real time ray-traced solution is imported, but
does account for these offsets or motion when reprocessing during ray tracing (SVC). This is the reason
for the transducer lever arms provided in the SVP portion of the HVF. In theory reintegrating the motion
information is straightforward because all lever arms and angular offsets have already been applied to
the Kongsberg data. Problems do arise when the data provided in post processing are not in the same
reference frame as the Kongsberg frames. In our case, delayed heave or GPS height information. HIPS
55

can handle different configurations, but a different HVF may be required depending on the sensor and
workflow (e.g., SVC or no SVC, true heave or real time heave). Most significant to this discussion of the
HVF configuration is the description of the heave sensor location- as configured, the real-time heave is
reported in a different place than the delayed heave, but there is only one ‘heave’ field in the HVF.
It would seem the logic of the HVF would require a lever arm for the heave sensor when using
Kongsberg real time heave (Kongsberg reported heave has the induced heave included and is therefore
valid at the transducer as mentioned previously), but the HVF requires no offset for the heave sensor
when reintegrating the real time heave during SVC. All other data is either valid at the reference point
or has offsets as described by the Caris technote on converting Kongsberg data [8]. This inherently calls
into question the reference frame of the HVF for Kongberg data – is the HVF in the vessel reference
frame or the transducer reference frame? When conducting SVC in HIPS the reference frame appears to
be in the transducer reference frame (with the exception of the SVP fields). When no SVC is conducted
the reference frame appears to be in the vessel reference frame.
When no SVC is conducted, the description of the heave sensor lever arm is only important for
computing GPS Tides. For the proper removal of heave from the GPS tide height, the HVF heave sensor
field must have a lever arm equivalent to the distance from the reference point to the transmit
transducer. When computing GPS Tides the “MRU remote heave” box must be checked such that the
heave is moved back to the reference point and properly applied to the GPS height. While this is
essentially the desired workflow, i.e. all data is to the ellipsoid using all real time data, this method was
deemed too inflexible since it precluded a water level referenced workflow free from heave artifacts.
Because the position of the heave sensor is ambiguous (real time heave is at the transducers but
delayed heave is at the reference point), there is not a way to apply delayed heave during merge only in
HIPS. While the difference between real time and delayed heave is the same everywhere on the vessel,
this difference needs to be computed at the same location such that the induced heave is canceled out.
It is possible to compute this difference directly from the Applanix True Heave record where both the
real and delayed heave are reported, but HIPS differences the delayed heave with the real time heave
from the Kongsberg file which adds back the induced heave artifact.
When SVC is conducted in HIPS the HVF appears to describe the sensors in the transducer reference
frame. SVC may be conducted with zero offsets for all sensors besides the transducers, and results
comparable to the real time reported values are produced. The computation of GPS Tides is
complicated by the fact that the valid location of GPS tides is at the reference point and not at the
transducer, and there is no entry in the HVF for the location of GPS Tides. To circumvent this problem
delayed heave must be applied to the data. By including an entry in the HVF that describes the location
of the reference point, and thereby delayed heave, for the heave sensor relative to the transmit
transducer, heave is correctly applied to the bathymetry. This means a lever arm opposite to the SVP1
field is entered for the heave sensor and provides for an SVC inclusive workflow that references the
survey to the waterline. To compute GPS tides the “MRU remote heave” box is not check because
delayed heave and the GNSS height are both already at the reference point. While this workflow
requires delayed heave and the SVC step in post processing, it provides for the most flexible workflow
and is recommended for Thomas Jefferson with their current configuration.
The application of “Waterline” during the computation of GPS tides also deserves discussion here. If
data are converted with the GPS Height as GGK then the waterline needs to be applied during GPS Tide.
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Because SIS applies the waterline value from the Installation Parameters to the EM Height, if the data
are converted with GPS Height as EM Height the water line does not need to be applied when
computing GPS tides. For this reason the recommended workflow for Thomas Jefferson is to convert
with EM Height but not apply waterline during the GPS Tide computation.
While much of this confusion could be alleviated if Caris accommodated multiple potential heave sensor
(e.g. real-time, post-processed) within the HVF (i.e. the real time Kongsberg reported heave required a
lever arm entry), Caris stated in the helpdesk ticket while exploring this problem that their HVF
configuration will not be revisited until Caris HIPS 11. For a discussion of this solution please see the
NOAA - Caris helpdesk ticket request ID 01602680.
To accommodate the current processing restrictions, maximize potential workflow flexibility, and limit
the number of unique HVF files, we implemented the following workflows:
1) ERS

a. Convert MBES data  Load Delayed Heave  Sound Velocity Correct  Compute GPS
Tides  Merge with GPS Tides  TPU

2) Traditional Water Levels
a. Convert MBES data  Load Delayed Heave  Load Tides  Sound Velocity Correct 
Merge  TPU
Thomas Jefferson’s HVF has also been modified to account for Total Propagated Uncertainty (TPU) with
MarineStar (which does not have real time uncertainty reported correctly), but again to maximize
flexibility while limiting unique HVFs. Entries associated with the real time water level reference
uncertainty, such as heave, static and dynamic draft, which together have a root sum square value of
0.09 m, have been removed from the HVF. When surveying to the ellipsoid, a value of 0.11 m for the
MarineStar uncertainty is entered into the Tide/Measured dialog. This value was derived as an average
of all 2015 Thomas Jefferson ship (no launches) POSPac PPP projects compiled by Physical Scientist
Faulkes. The VDatum uncertainty from the project instructions is entered into the Tide/Zoning dialog.
When surveying to the waterline, the Tide/Measured dialog will include the values that were removed
from the HVF as a single value of 0.09 m, and the projects instructions will inform the value for the
Tide/Zoning dialog.
For details, please see the Standard Operating Procedure for Thomas Jefferson’s Caris HIPS configuration
and conversion in the appendix.

7.2 Test data resolution and density
As with past Kongsberg multibeam echo sounders, Thomas Jefferson’s survey system meets Coast
Survey sounding density specifications. The density estimates, as calculated from the extinction lines,
for the EM2040 can be found in Figure 70, and the EM710 in Figure 72. Ping rates as measured from
these same data can be found in Figure 71 and Figure 73 for the EM2040 and EM710 respectively.
Unfortunately, the EM2040 extinction was not tested specifically in shallow water where the density
estimate would be most applicable. Past testing with the EM2040 [10] demonstrates that the EM2040
will meet NOAA density specifications in shallow water.
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Figure 70 – Sounding density for the EM2040 estimated from the extinction lines.

Figure 71 – Ping periods for the EM2040 during the extinction lines.
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Figure 72 – Sounding density for the EM710 estimated from the extinction lines.

Figure 73 – Ping period for the EM710 during the extinction lines.
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7.3 Test total propagated uncertainty
Kongsberg produces real time uncertainty for the echo sounder component of the uncertainty model
according to the method recommended by Ifremer [9]. These records can be ingested by Caris to
contribute toward the sonar portion of the Total Propagated Uncertainty (TPU). Data were evaluated
using data collected during the object detection portion of this cruise and using the HIPS configuration
described in 7.1. For reference, IHO Order 1a for 75 meters of depth is 1.1 meters. At nadir the
uncertainty was 0.406 meters, and for the outer beams it was 0.737 meters.

Figure 74 - Nadir Total Vertical Uncertainty breakdown by contribution source for the EM2040. The real time uncertainty from
the echo sounder is small and included in the “Other” portion of the plot.

Figure 75 – Outer beam Total Vertical Uncertainty breakdown by contribution source for the EM2040. The contribution from the
echo sounder real time uncertainty is small relative to other factors.
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Both Figure 74 and Figure 75 demonstrates that the EM2040 real time echo sounder uncertainty is not a
major contributor to the total uncertainty and that the Caris HIPS configuration can be expected to meet
IHO Order 1a specifications for uncertainty.

7.4 Difference Surface
The object detection lines from the vicinity of the wreck of the Bow Mariner were used to compare the
fully integrated EM710 and EM2040 survey depths against previous data collected by NOAA Ship
Thomas Jefferson during survey F00585. All Thomas Jefferson acceptance survey data was collected to
the ellipsoid, so an offset between ITRF 2008 and mean lower low water of -38.6 meters at the Bow
Mariner location was computed using VDatum. This offset was used to shift data to the same datum as
the previous Thomas Jefferson survey. The difference surface statistics between the previous Reson
7125 and the new EM710 and EM2040 are described in Table 6. Also included in this table are
difference surface statistics between Thomas Jefferson’s EM2040 and survey H11504 by David Evans
and Associates, which happened to cover some preliminary data collected with the new EM2040 before
the acceptance cruise. Patch test values were applied in post processing for these data, and the sound
speed cast was adjusted to account for the faulty sensor present during preliminary testing (see 4.2.3).
Table 6 - Difference surface statistics as computed within Caris HIPS.

Location and System
Bow Mariner – EM710
Bow Mariner – EM2040
Chesapeake Bay – EM2040

Mean Offset (m)
-0.3
-0.2
0.2

Standard Deviation (m)
0.2
0.1
0.1

While there appears to be a consistent bias at the Bow Mariner site compared to the previous Reson
7125 survey data, there is good agreement between the Thomas Jefferson EM710 and the EM2040.
When considering this agreement with the opposing offset in the difference between previous survey
coverage and Thomas Jefferson’s EM2040 at the two different locations, the bias may not be due to an
offset internal to the survey system but in realizing the vertical datum. The uncertainty in realizing the
vertical datum (VDatum and the MarineStar Service) is approximately 0.14 meters at two standard
deviations. Since the mean uncertainty for the F00585 and H11504 surveys were 0.55 meters and 0.41
meters respectively (both vertically referenced through tide zoning), Thomas Jefferson appears to be
configured to produce properly vertically referenced soundings with the new survey system.

8 Concluding Summary
Two new Kongsberg multibeam echo sounders have been added to the NOAA Hydrographic fleet aboard
NOAA Ship Thomas Jefferson. While the EM710 and EM2040 appear to be functioning as specified and
are integrated with the supporting sensors correctly, two residual problems remain.
The primary problem is a leeward bathymetric artifact effecting both the EM2040 and EM710. While an
initial step to remedy this problem has been taken by removing the line guard in front of the transducer
mount, further testing is required to evaluate if the problem is resolved. If the problem is not resolved
further steps will need to be taken to better characterize the source of the problem and engineer a fix.
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The second problem is an artifact with the EM2040 200 kHz mode. Kongsberg recommendations to
resolve this problem have already been implemented and testing is required to understand if the issue
persists.
Thomas Jefferson has a workflow that will provide both ellipsoid and water level derived results in Caris
HIPS. While this workflow unfortunately does not take advantage of the real time GPS height and ray
traced bathymetry, it does meet the requirements of the ship despite being more cumbersome.
The EM2040 Min Depth detection mode was compared to the Normal detection mode and found to
improve the recognition of features that reflect man made construction. While this mode is useful for
developments, it should not be used for general bathymetry to avoid collecting data on fish schools.
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TJ Static Draft
G. Rice, E. Younkin
Hydrographic Systems and Technology Branch
2016-10-12

Introduction
With her very large fuel capacity, Thomas Jefferson’s operational draft varies considerably over the
course of a survey season. The draft of the reference point has historically been measured with a
flexible water level sight tube. However, procedures for measuring and recording this value have not
been well defined. To improve this process, a Sutron bubbler water level gauge was installed in 2014 to
replace manual sight tube readings. In this report, we discuss the Sutron water level gauge and analyze
data taken through gauge readings, draft mark readings and ellipsoidally referenced tide station data.
We find all three systems of measurement to be acceptable, but the Sutron gauge provides the easiest
and most precise measurement of static draft.
Manual Sutron and draft mark observations were made at 1140 and 1300 UTC and POS M/V data was
recorded between these times. Through the use of the Autopoll software, one-minute interval Sutron
data was also logged to a local computer. The Marinestar corrected POS MV data was processed in
POSPac in forwards/backwards processing mode without the inclusion of base station data in order to
generate an SBET. This SBET was used in the ellipsoidally referenced static draft script.
In this report, draft is defined as the distance from the reference point to the water surface with the
positive direction down; when the reference point is above the water surface, as it typically is with
Jefferson in all but her most heavily laden conditions, the draft will be a positive number. This is
consistent with the sign conventions in both Caris and Kongsberg.

Vessel Sensitivity to Loading
By examining the ship stability tables, the weight of the survey launches, and typical fuel burns, we can
calculate the vessel’s sensitivity to loading. At her design draft, the stability book indicates 190.6 long
tons per foot submergence, or 14,000 lbs/cm submergence. This means that an additional 14,000 lbs of
deck loading will cause the ship to sink into the water by 1 cm. Conservatively estimating the full, laden
weight of a launch at 18,000 lbs, the draft change from either deploying or recovering both launches is
approximately 0.025 m. The typical daily fuel burn at survey speed (approximately 1600 gallons per
day), will result in a draft change of less than 0.01 m per day or less than 0.06 m per week. Accordingly,
we recommend updating the draft value in the HVF no more than once a week during survey
operations.

Sutron Installation and Configuration
The Sutron bubbler water level gauge, similar to the NOAA field unit installed water level gauges, uses
compressed gas to carry the static pressure at a submerged orifice to the pressure gauge in the
instrument. This configuration allows the pressure sensor to be both dry and also be balanced against
the atmospheric pressure such that variations in atmospheric pressure can be neglected in the
determination of the water level head pressure. A photo of the sea-valve and orifice configuration is
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shown in Figure 1. With the vent valve open, the measured pressure is at the level of the orifice indicted
by the arrow. This offset was measured by IMTEC in 2016 as 3.908 meters with respect to the IMU
reference point [1]. With the vent valve closed, the effective orifice is the penetration in the shell
plating. The offset to the shell plating was not accurately measured during the installation. In normal
operations, the vent valve should be left open.

Figure 1: Bubbler gauge orifice and vent line. Vent valve has yellow handle and should be OPEN. Arrow indicated surveyed
position of orifice and the location of the measured draft.

In general, conversion of a pressure measurement to a depth requires knowledge of the density of the
water and the local gravitational attraction. The general equation of the height of the reference point
above the water level is given below. This is the value (with correct sign) used in the ‘waterline’ section
of the Caris HVF and in Kongsberg SIS.

wl   PSI

6894.7 Pascal / psi
 orificeZ
*g

(1)

where wl is the height of the reference point above the waterline, ρ is water density in kilograms/
meter3, g is the acceleration due to gravity, and orificeZ is the surveyed distance from the reference
point to the bubbler orifice. The gravitational acceleration, 9.79819 m/s 2, was calculated from the
WGS84 Gravity Model for latitude 36. For these small depths, the effect of the variability of gravity is
negligible, accounting for an effective draft error of less than 0.01 m for latitude changes between 0 and
60 degrees. The density effect is more significant, with a variation from fresh to salt water yielding a
difference of approximately 0.08 m for this system. Using typical sea-surface water density of 1024
kg/m3, the formula for the height of the reference point above the water line is given by:

wl  0.68718(PS I)  3.908

(2)
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These figures have been entered into the custom fields of the bubbler gauge (station setup/ accubar
setup/ accubar settings/ user slope and user offset) such that the output value is the meters of the
reference point above the waterline (note that when the ship is fully laden, the reference point may be
below the water line and this number will then be negative).
On April 17, 2015 (Dn107) a series of six water level measurements were made from the IMU to the
level in a sight tube. A laser was set on the top of the IMU and a ruler used to measure the distance
from the top of the IMU to the water level in the sight tube. The reading was corrected for the height of
the laser. The water level was 0.285 ± 0.004 meters relative to the reference point. That afternoon, a
CTD cast measured a density of 1012 kg/m3 in the brackish waters of the Elizabeth River. Using this
density, the observed pressure of 5.182 psi on the bubbler gauge, and equation (2) above, the bubbler
derived waterline height is 0.305 meters, yielding an error of 0.02 m. The source of this error is
unknown, but is within tolerance for hydrographic survey work.
Unless extended survey operations are planned for fresh waters (e.g. the Great Lakes), we recommend
the standard density of 1024 kg/m3 be used for the calculation of waterline and the custom offsets
retained as entered. In brackish waters, the reported draft variation with density may be significant
enough to consider for precise calibration work, though can likely be neglected for routine survey work.
In the case were additional precision is required, we recommend calculating the waterline from the
observed pressure and observed density using equation (1) to derive the height.

Sutron Results
Readings were taken from the Sutron at the beginning and end of observations at 0.385 meters and
0.351 meters respectively. The readings were also recorded via AutoPoll every minute into CSV files and
displayed in Figure 2. Again, these readings are the water level relative to the IMU as the bubble gauge
offset from the IMU, 3.908 meters, was entered into the Sutron. The mean of this time series is 0.37
meters with 0.02 at two standard deviations.

Figure 2 - The Sutron time series.

107

There is a clear trend in the Sutron data. When an extended time series is plotted it appears that the
static draft test was conducted during an inopportune time as displayed in Figure 3. After discussing this
anomaly with the ship, we learned that ballast was taken on at approximately 1100 UTC to achieve an
additional few inches of draft astern. We can see that a change of about 3.5cm was seen in the Sutron
derived waterline value. Using the previously mentioned 14,000 lbs/cm loading estimate, we can say
that about 49,000 lbs or about 21.71 cubic meters of sea water was taken on during this period.

Figure 3 – The Sutron time series from 2016-10-12 for a period before and after the static draft test.

Draft Mark Results
The transom and bow (port side) draft marks were observed from the wharf at the times described. The
draft did not change at an observable amount over this time, with the transom reading 13.9 feet and the
bow (port side) reading 13.8 feet. This finding, along with our internal understanding of the accuracy of
draft mark readings, led to our assumed two standard deviation of 0.07 cm. A weighted average was
used to estimate the draft at the horizontal location of the IMU, which is closer to the bow. This
average, 13.83 feet, was then converted to meters and referenced to the IMU using an IMU to keel
offset derived from the raw survey values from the ship offset survey conducted in August of 2016 [1].
This offset was derived by averaging the keel vertical offset observations after the values were
referenced to the IMU, with a result of 4.56 meters. The final result, 0.34 meters, with this derivation
from the draft marks is shown in Table 1.
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Table 1 - Draft of the reference point from draft mark readings

Ellipsoid Referenced Static Draft Results
A POS MV file was recorded during the time period described and processed in POSPac using
forwards/backwards processing without the inclusion of any base station data. While some attempt
was made to understand the waterline offset from the AutoQC tool in Pydro, eventually the ERSD script,
also in Pydro, was used instead. This approach results in a poorer tide correction since the phase and
amplitude at the Atlantic Marine Operations Center from the local tide gauges is not taken into account.
The script was run twice, once for the Money Point tide gauge, 8639348, and again for the Sewell’s Point
tide gauge, 8639610.
The ERSD script references the water levels to the ellipsoid using a provided offset from the water level
data to the ellipsoid. The water levels are then subtracted from the ellipsoid height of the ship, with the
resulting value being the reference point draft over time. These values are then averaged for a final
estimate. More information on the ERSD script can be found in [2].
The Money Point gauge reference resulted in a mean draft of 0.43 meters with two standard deviations
being 0.07 meters as reported by the script in Figure 4. The offset from mean lower low water to
WGS84 provided by VDatum for the Money Point gauge was -39.0014 meters.

109

Figure 4 - SBET values relative to the ellipsoid referenced water levels from Money Point over the time period.

The Sewell’s Point gauge reference resulted in a mean draft of 0.32 meters with two standard deviations
being 0.08 meters as reported by the script in Figure 5. The offset from mean lower low water to
WGS84 provided by VDatum for the Sewell’s Point gauge was -38.7367 meters.

Figure 5 - SBET values relative to the ellipsoid referenced water levels from Sewell’s Point over the time period.
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Conclusion
The draft of the reference point from the different approaches is summarized in Table 2.
Table 2 – A summary of the static draft estimates.

Source
Draft Readings
Sutron
ERSD – Money Point
ERSD – Sewell’s Point

Result (Meters)
0.34
0.37
0.43
0.32

2 Standard Deviations (Meters)
0.07
0.02
0.07
0.08

No final value is derived as the static water level changes with loading conditions. Instead this series of
tests confirms that each method arrives at a statistically equivalent value, and any of them could be
used. That being said, only the ERSD and Sutron method are precise enough to even see the 3.5cm
change in draft during the testing period. This is to be expected, as that frequency and precision of both
POS MV and tide gauge measurements far surpasses the draft readings and that change was well within
the variability of the draft reading measurement. For its simplicity and precision, the Sutron gauge is the
recommended method for estimating the ship’s static water level. The Sutron should only be used
when the ship is dead in the water as water flowing over the hull will affect the measurement.
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NOAA Ship Thomas Jefferson CARIS HIPS 9.1 Post Processing Workflow
for the EM2040
HSTB, December 7, 2016

Purpose
NOAA Ship Thomas Jefferson’s survey system is configured differently than other Kongsberg systems in
the NOAA hydrographic fleet. Most notably, the primary reference point for the survey system is placed
at the IMU rather than the multibeam transmit transducer because Thomas Jefferson has two
multibeam systems; one POS MV configuration works for both. Also of note, Thomas Jefferson has a
MarineStar license and can thereby use the ellipsoid height stored in the Kongsberg data directly
without the need for POSPac post processing.
Because of how the reference point- transmitter lever arm is accounted for in Caris, there is no one HVF
and processing configuration that can accommodate the various possible processing paths (e.g. using
real-time Marinestar height and SIS raytracing to convert and merge in Caris without sound velocity
correction (SVC), applying delayed heave and a new sound speed profile in Caris and using a tide
corrector, etc.). Each of these processing paths can be accommodated, but many require different HVF
configurations and processing parameters. Please contact HSTB for additional details if interested.
The recommended workflow options below have been formulated and tested by HSTB. While the
required steps making up each method may be less efficient than possible for a given approach, this
affords the most flexibility for data processing under one HVF. This HVF is named
S222_EM2040_HSTB.hvf.
The methods require application of the POS M/V TrueHeave (delayed heave) data and requires
computing the SVC in CARIS HIPS; the latter is mandatory regardless of whether new sound speed
information or calculations beyond that used in Kongsberg SIS data acquisition are available or
desired. Specifically, these steps are required for both the real-time ellipsoid-referenced survey (ERS)
processing method and the traditional water levels processing method, as detailed below.

Method
The two methods are as follows:
1)

ERS
a. Convert MBES data  Load Delayed Heave  Sound Velocity Correct  Compute GPS
Tides  Merge with GPS Tides  TPU

2) Traditional Water Levels
a. Convert MBES data  Load Delayed Heave  Load Tides  Sound Velocity Correct 
Merge  TPU
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Procedure
Conversion (both methods, 1 and 2)
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Data sources are set to “Auto” in the following dialogues because CARIS conversion algorithms are
capable of reading the .all file (and other file types; ie: hsx) and determining data source.
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Import Delayed Heave (both methods, 1 and 2)
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119
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While a new sound speed profile does not need to be added in this step, the SVC step is required for
these workflows. By leaving the “Load new SVP file” box unchecked, CARIS will use the SV profiles
embedded in the raw data per the .all file. Apply Delayed Heave is selected so that lever arm
corrections are performed accurately. If Delayed Heave is not selected in this step, then a heave artifact
will be introduced in the processed data.
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GPS Tides is a method for computing the ellipsoid height of the vessel such that the bathymetry can be
referenced to the ellipsoid. SVC’d depths are compensated for motion and are relative to the static water
level. Because the converted vessel GPS Height (Kongsberg ,all EM Height) includes the water line
offset and motion, in Compute GPS Tide we answer: False to Water Line, but apply=True to both the
Dynamic Draft (to match the HVF) and the Dynamic Heave (Delayed Heave). The following list
summarizes the options accounting required in Compute GPS Tides for the Thomas Jefferson EM2040.
-Smooth GPS height is not selected because we want to use the observed GPS Height.
- Antenna offset is not selected because offsets from GPS antennas to the IMU accounted for in POS M/V
-Dynamic Heave is applied in order to remove heave from the observed GPS Height, smoothing the time
series the same way that accounting for heave smooths the bathymetry.
-SIS is not accounting for lever arm offsets to the transducer from IMU with the GPS height, so the GPS
Height is at the IMU as is Delayed Heave in the POS M/V file. Thus MRU Remote Heave is not selected
because our RP is the IMU; moment arms are identically zero.
-Dynamic Draft (DD) is selected for congruence with HVF; DD is applied to the bathymetry per the HVF,
so the GPS Height must be compensated to match.
-The dynamic GPS Height values in the .all file (EM Height, per conversion) are offset from the IMU by
the water line as defined in SIS. Waterline is not applied because the SVC’d depths account for the
waterline, per introductory paragraph in this section.
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Merge and Compute TPU - Method 1 (ERS)
Calculates the final position for soundings based on observed depths and applied corrections in postprocessing. Select GPS Tides because this is an ERS processing method, and Delayed Heave as needed to
match our application of the same in during our mandatory SVC, described above.
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TPU for the vertical datum when surveying to the ellipsoid is a variance summation of the uncertainties
associated with (1) MarineStar-aided POS MV height and (2) the datum separation (SEP) model. The
MarineStar uncertainty is placed in the Tide / Measured section of the TPU dialog as 0.11 meters. The
SEPuncertainty is placed in the Tide / Zoning section of the TPU dialog and is survey area-specific as
provided in Project Instructions (e.g., for OPR-G329-TJ-16/17, VDatum SEP StdDev=0.148m). Sonar
uncertainty is per the converted Realtime Kongsberg metrics from the .all. All other uncertainty sources
are set to zeros via the HVF; see the Method 2 – Traditional Water Levels Compute TPU section for more
information regarding this.
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Load Tide, Merge and Compute TPU - Method 2 (Traditional Water Level Corrections)

Normal practice in the traditional water level method is to enter the uncertainty values attributed to
vessel speed (0.03m), loading (0.06m), draft (0.03m), and delta draft (0.05m) in the HVF TPU StdDev, for
Compute TPU Uncertainty Source = Vessel look-up. Our workflow sets them to zero in the HVF to
account for our preference for one HVF for both non-ERS and ERS processing. For the Method 2
(Traditional Water Levels) we instead account for the aforementioned components as a single variance
summation (root sum square; RSS=0.09m) and place that in the “Tide / Measured” slot. The actual
(total) tide error component as provided in section 1.3.3 of the Project Instructions is placed in the Tide
/ Measured value (e.g., for OPR-G329-TJ-16/17, ZDF Tides StdDev = 0.10m). For TCARI-based projects,
an average uncertainty value will be provided in the PI as well (e.g., OPR-E350-TJ-16, TCARI mean StdDev
= 0.07m; OPR-D302-TJ-16, TCARI mean StdDev = 0.22m).

125

126

126

127

128

129

130

131

132

133

134

135

136

137

138

139

140

141

142

143

144

U.S. Department of Commerce
National Oceanic & Atmospheric Administration
National Ocean Service
National Geodetic Survey
Field Operations Branch

Thomas Jefferson Launch 2903
Component Spatial Relationship Survey
Field Report
Kevin Jordan
May 1, 2017

PURPOSE
The intention of this survey was to accurately position the POS/MV IMU, GPS
Antennas, Receiver and Transmitter, Side Scan Reference Marks and bench marks
on TJ launch 2903.
PROJECT DETAILS
This survey was conducted on May 1, 2017 at NOAA’s Marine Operations Center
in Norfolk, VA . The boat was on jack stands and leveled. The temperature was
around 70 degrees and winds 10-15 mph.
INSTRUMENTATION
The TOPCON GPT 3000 Series Theodolite was used to position all points on the
launch.
A SECO 25 mm Mini Prism System configured to have a zero mm offset was used
as target sighting and distance measurements.
SOFTWARE AND DATA COLLECTION
TDS Survey Pro Ver. 5.7.2
ForeSight DXM Ver. 3.2.2 was used for post processing.
PERSONNEL
Kevin Jordan

NOAA/NOS/NGS/Field Operations Branch 757-441-5467

Jim Harrington

NOAA/NOS/NGS/Field Operations Branch 757-441-5496

Ryan Hippenstiel NOAA/NOS/NGS/Field Operations Branch 757-441-6595

Temporary Control
A network of temporary control was established on the lot consisting or two marks
set on solid ground about 60 meters apart. These points were named TP 1 and TP
2. The majority of observations were performed using one setup on TP 1. TP 2
was utilized to setup the instrument and observe two additional points on the hull
of the boat.
OBSERVED POINTS
IMU

CL 1

CL 2

CL 3

CL 4

BM PORT 3

BM PORT 2

BM PORT 1

BM STAR 3

BM STAR 2

BM STAR 1

GPS PORT ARP

GPS STAR ARP

SIDE SCAN TOW POINT RM

RECEIVER

TRANSMITTER

KEEL BM FWD

KEEL BM AFT

PORT SIDE SCAN HARD POINT FWD

PORT SIDE SCAN HARD POINT AFT

STAR SIDE SCAN HARD POINT FWD

STAR SIDE SCAN HARD POINT AFT

POST PROCESSING
The collected points were surveyed in an assumed coordinate system and needed to
be translated to the point “IMU” as X=0, Y=0, Z=0. The azimuth from CL 4 to CL
1 needed to be oriented to 0° 00’ 00”. Post Processing was performed using
ForeSight DXM to produce the following Coordinate Report. The X Axis is
Positive toward the Bow. The Y Axis is positive toward the Starboard side. The Z
Axis is positive downward.
Transmitter center
The transmitter center was determined by measuring the length and width of the
face (fwd to aft, port to starboard) and splitting the difference of the measurement.
A temporary mark was placed on a piece of masking tape and measured.
Side Scan Tow Point Reference Mark
A reference mark for the Side Scan Sonar was established as part of this survey.
The point of measurement can be described as a “.” punch mark below the portfacing middle bracket on the side-scan arm.

Final Coordinate List
An excel spreadsheet labeled TJ_2903.xlsx is included with the project
submission. Below is a report of the final coordinate listing.
2903 Boat Survey 2017
X
Y
Z
NAME
(METERS) (METERS) (METERS)
IMU
0.000
0.000
0.000
CL1
3.591
0.002
-1.322
CL3
-0.212
0.012
-0.657
CL2
-0.145
0.029
-2.651
CL4
-4.020
0.002
-0.742
BM PORT 3
-1.581
-0.618
-2.671
BM PORT 2
-0.702
-0.467
-3.043
BM PORT 1
0.174
-1.424
-1.069
BM STAR 3
-1.581
0.692
-2.667
BM STAR 2
-0.698
0.509
-3.046
BM STAR 1
0.170
1.440
-1.052
GPS PORT ARP
-0.693
-0.710
-3.572
GPS STAR ARP
-0.680
0.746
-3.579
SIDE SCAN TOW POINT RM
-5.307
-0.015
-3.121
RECEIVER
0.263
0.000
0.530
TRANSMITTER
0.044
-0.005
0.532
KEEL BM FWD
0.455
0.001
0.632
KEEL BM AFT
-0.577
0.002
0.716
PORT SIDE SCAN HARD POINT FWD
1.102
-0.561
0.303
PORT SIDE SCAN HARD POINT AFT
0.188
-0.566
0.307
STAR SIDE SCAN HARD POINT FWD
1.105
0.554
0.322
STAR SIDE SCAN HARD POINT AFT
0.195
0.572
0.319
*NOTE Z VALUES ARE POSITIVE
DOWNWARD

SURVEY CLOSURE
The majority of points were established by occupying a temporary mark (TP 1)
established on solid ground about 11 meters behind the stern of the boat.
Throughout the survey, Horizontal and Vertical checks were made to the 2nd
temporary point that was established on the lot (TP 2). At the end of the
observations, a check point was collected and an inverse was computed.
TP 2
Δ X = 0.001 m
Δ Y = 0.003 m
Δ Z = 0.005 m
A second setup was required to collect two additional points. The instrument was
setup on TP 2 and backsight TP 1. The initial survey setup checked TP 1 by:
CK TP 1
Δ X = 0.001 m
Δ Y = 0.000 m
Δ Z = 0.003 m
Following the collection of the additional points, a final check to TP 1 was
performed and closure was:
CK TP 1
Δ X = 0.001 m
Δ Y = 0.001 m
Δ Z = 0.001 m
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PURPOSE
The intention of this survey was to accurately position the POS/MV IMU, GPS
Antennas, Receiver and Transmitter, Side Scan Reference Marks and bench marks
on TJ launch 2904.
PROJECT DETAILS
This survey was conducted on May 1, 2017 at NOAA’s Marine Operations Center
in Norfolk, VA . The boat was on jack stands and leveled. The temperature was
around 70 degrees and winds 10-15 mph.
INSTRUMENTATION
The TOPCON GPT 3000 Series Theodolite was used to position all points on the
launch.
A SECO 25 mm Mini Prism System configured to have a zero mm offset was used
as target sighting and distance measurements.
SOFTWARE AND DATA COLLECTION
TDS Survey Pro Ver. 5.7.2
ForeSight DXM Ver. 3.2.2 was used for post processing.
PERSONNEL
Kevin Jordan

NOAA/NOS/NGS/Field Operations Branch 757-441-5467

Jim Harrington

NOAA/NOS/NGS/Field Operations Branch 757-441-5496

Ryan Hippenstiel NOAA/NOS/NGS/Field Operations Branch 757-441-6595

Temporary Control
A network of temporary control was established on the lot consisting or two marks
set on solid ground about 60 meters apart. These points were named TP 1 and TP
2. The majority of observations were performed using one setup on TP 1. TP 2
was utilized to setup the instrument and observe two additional points on the hull
of the boat.
OBSERVED POINTS
IMU

CL 1

CL 2

CL 3

CL 4

BM PORT 3

BM PORT 2

BM PORT 1

BM STAR 3

BM STAR 2

BM STAR 1

GPS PORT ARP

GPS STAR ARP

SIDE SCAN TOW POINT RM

RECEIVER

TRANSMITTER

KEEL BM FWD

KEEL BM AFT

PORT SIDE SCAN HARD POINT FWD

PORT SIDE SCAN HARD POINT AFT

STAR SIDE SCAN HARD POINT FWD

STAR SIDE SCAN HARD POINT AFT

POST PROCESSING
The collected points were surveyed in an assumed coordinate system and needed to
be translated to the point “IMU” as X=0, Y=0, Z=0. The azimuth from CL 4 to CL
1 needed to be oriented to 0° 00’ 00”. Post Processing was performed using
ForeSight DXM to produce the following Coordinate Report. The X Axis is
Positive toward the Bow. The Y Axis is positive toward the Starboard side. The Z
Axis is positive downward.
Transmitter center
The transmitter center was determined by measuring the length and width of the
face (fwd to aft, port to starboard) and splitting the difference of the measurement.
A temporary mark was placed on a piece of masking tape and measured.

Side Scan Tow Point Reference Mark
A reference mark for the Side Scan Sonar was established as part of this survey.
The point of measurement can be described as a “.” punch mark on the left-most
middle bracket and is aft-facing on the side-scan arm.
Final Coordinate List
An excel spreadsheet labeled TJ_2904.xlsx is included with the project
submission. Below is a report of the final coordinate listing.
2904 Boat Survey 2017
X
Y
Z
NAME
(METERS) (METERS) (METERS)
IMU
0.000
0.000
0.000
CL1
3.583
-0.011
-1.358
CL3
-0.212
-0.004
-0.649
CL2
-0.171
-0.011
-2.653
CL4
-4.014
-0.012
-0.686
BM PORT 3
-1.598
-0.678
-2.648
BM PORT 2
-0.738
-0.549
-3.040
BM PORT 1
0.185
-1.453
-1.052
BM STAR 3
-1.607
0.649
-2.649
BM STAR 2
-0.743
0.533
-3.041
BM STAR 1
0.146
1.434
-1.060
GPS PORT ARP
-0.725
-0.762
-3.562
GPS STAR ARP
-0.730
0.726
-3.567
SIDE SCAN TOW POINT RM
-5.477
-0.061
-3.035
RECEIVER
0.269
-0.007
0.529
TRANSMITTER
0.050
0.000
0.535
KEEL BM FWD
0.467
0.003
0.631
KEEL BM AFT
-0.570
0.003
0.735
PORT SIDE SCAN HARD POINT FWD
1.130
-0.563
0.301
PORT SIDE SCAN HARD POINT AFT
0.209
-0.563
0.314
STAR SIDE SCAN HARD POINT FWD
1.123
0.579
0.300
STAR SIDE SCAN HARD POINT AFT
0.195
0.568
0.312
*NOTE Z VALUES ARE POSITIVE
DOWNWARD

SURVEY CLOSURE
The majority of points were established by occupying a temporary mark (TP 1)
established on solid ground about 20 meters behind the stern of the boat.
Throughout the survey, Horizontal and Vertical checks were made to the 2nd
temporary point that was established on the lot (TP 2). At the end of the
observations, a check point was collected and an inverse was computed.
TP 2
Δ X = 0.000 m
Δ Y = 0.001 m
Δ Z = 0.003 m
A second setup was required to collect two additional points. The instrument was
setup on TP 2 and backsight TP 1. The initial survey setup checked TP 1 by:
CK TP 1
Δ X = 0.001 m
Δ Y = 0.000 m
Δ Z = 0.003 m
Following the collection of the additional points, a final check to TP 1 was
performed and closure was:
CK TP 1
Δ X = 0.001 m
Δ Y = 0.001 m
Δ Z = 0.001 m

POS/MV Calibration Report
Field Unit: Thomas Jefferson
SYSTEM INFORMATION
2904

Vessel:
9/11/2017

Date:

254

Dn:
Glomb, Brozstek, Hiteshew

Personnel:

3954

PCS Serial #

129.100.1.231

IP Address:

8.32

POS controller Version (Use Menu Help > About)
MV-320 version 4

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver
BD960 SN5036K17685, v.00421 channels 76 OMNSN 141417685
Secondary Receiver BD960 SN5037K17791, v.00421 channels 76 OMNSN 141417791

CALIBRATION AREA
Location:

Lambert Bend to Pinner Point

Approximate Position:
DGPS Beacon Station:
Frequency:

Satellite Constellation

D

M

S

Lat

36

51

54.37

Lon
Marinestar float

76

19

15.1

(Use View> GPS Data)

Primary GPS (Port Antenna)
HDOP:
VDOP:

0.798
1.141
10

Sattelites in Use:

PDOP

Note:

N

2.232

(Use View> GAMS Solution)

POS/MV CONFIGURATION
Settings
(Use Settings > Installation > GAMS Intallation)

Gams Parameter Setup

User Entries, Pre-Calibration

Baseline Vector

1.457

Two Antenna Separation (m)

0.061

X Component (m)

0.50

Heading Calibration Threshold

1.456

YComponent (m)

Heading Correction

0.002

Z Component (m)

0
Configuration Notes:

POS/MV CALIBRATION
(Refer to POS MV V3 Installation and Operation Guide, 4-25)

Calibration Procedure:
Start time:

1359

End time:

1401

Heading accuracy achieved for calibration:

0.028

Calibration Results:
(Use Settings > Installation > GAMS Intallation)

Gams Parameter Setup

POS/MV Post-Calibration Values

Baseline Vector

1.457

Two Antenna Separation (m)

0.003

X Component (m)

0.500

Heading Calibration Threshold

1.49

YComponent (m)

Heading Correction

0.005

Z Component (m)

0
GAMS Status Online?

x

Save Settings?

x

Calibration Notes: heading at 0.067 when starting GAMS

Save POS Settings on PC
File Name:
Posconfig_2904_Marinestar_09112017

(Use File > Store POS Settings on PC)

GENERAL GUIDANCE
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the
right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.
The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference
into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the
z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the
once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the
twice-rotated x-axis to align one frame with the other.

SETTINGS (insert screen grabs)
Input/Output Ports (Use Settings > Input/Output Ports)

NOTE:

Heave Filter (Use Settings > Heave)

Time Sync (Use Settings > Time Sync)

NOT ON THE VERSION 4

Installation (Use Settings > Installation)

Events (Use Settings > Events)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)
Frame Control (Use Tools > Config)

NOT ON THE VERSION 4

GPS Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)
Primary GPS Receiver

Secondary GPS Receiver

X Component (m)
YComponent (m)
Z Component (m)

X Component (m)
YComponent (m)
Z Component (m)

ents)

g)

POS/MV Calibration Report
Field Unit: Thomas Jefferson
SYSTEM INFORMATION
S222

Vessel:
7/12/2017

Date:

193

Dn:
Marcus,Hiteshew,Doroba

Personnel:

6497

PCS Serial #

129.100.1.231

IP Address:

8.6

POS controller Version (Use Menu Help > About)
V5

POS Version (Use Menu View > Statistics)
GPS Receivers

BD982 S/N 5409C86558

Primary Receiver
Secondary Receiver

CALIBRATION AREA
Location:

E of Cape Henry

Approximate Position:

Lat
Lon
MarineStar

DGPS Beacon Station:
Frequency:

Satellite Constellation

PDOP

10

Note:

2.000

S
13

75

50

35

N

0.676
1.062

Sattelites in Use:

M
54

(Use View> GPS Data)

Primary GPS (Port Antenna)
HDOP:
VDOP:

D
36

(Use View> GAMS Solution)

POS/MV CONFIGURATION
Settings
(Use Settings > Installation > GAMS Intallation)

Gams Parameter Setup

User Entries, Pre-Calibration

Baseline Vector

2.21

Two Antenna Separation (m)

0.019

X Component (m)

0.50

Heading Calibration Threshold

2.208

YComponent (m)

Heading Correction

-0.009

Z Component (m)

0
Configuration Notes:

POS/MV CALIBRATION
(Refer to POS MV V3 Installation and Operation Guide, 4-25)

Calibration Procedure:
Start time:

2341 UTC

End time:

0005

Heading accuracy achieved for calibration:

0.486

Calibration Results:
(Use Settings > Installation > GAMS Intallation)

Gams Parameter Setup

POS/MV Post-Calibration Values

Baseline Vector

2.21

Two Antenna Separation (m)

0.019

X Component (m)

0.500

Heading Calibration Threshold

2.208

YComponent (m)

Heading Correction

-0.009

Z Component (m)

0
GAMS Status Online?

Yes

Save Settings?

Yes

Calibration Notes:

Save POS Settings on PC
File Name:
PosConfig_13Jul2017.nvm

(Use File > Store POS Settings on PC)

GENERAL GUIDANCE
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the
right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.
The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference
into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the
z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the
once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the
twice-rotated x-axis to align one frame with the other.

SETTINGS (insert screen grabs)
Input/Output Ports (Use Settings > Input/Output Ports)

NOTE:

Heave Filter (Use Settings > Heave)

Time Sync (Use Settings > Time Sync)

NOT ON THE VERSION 4

Installation (Use Settings > Installation)

Events (Use Settings > Events)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)
Frame Control (Use Tools > Config)

NOT ON THE VERSION 4

GPS Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)
Primary GPS Receiver

Secondary GPS Receiver

THOMAS JEFFERSON
Multibeam Echosounder Calibration

Vessel: S-222

Date Acquired: 7/13/2017 (DN194)
Processing Log
7/13/2017
Date

194
Dn

ACST Stone
Personnel

Data converted --> HDCS_Data in CARIS
TrueHeave applied

acs

SVP applied

acs

Tide applied

acs
Zone file
Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order
1. Precise Timing

2. Pitch bias

3. Roll bias

4. Heading bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS
Latency
Lines Used

Evaluators
Stone
Hiteshew
Marcus
Doroba
Rice

Averages
Standard Deviation
FINAL VALUES

Latency (sec)
0.0000
0.0000
0.0000
0.0000
0.0000

Pitch Lines
Used
12,13
12,13
12,13
12,13
12,13

0.00
0.00
0.00

Pitch (deg)
0.1700
0.1900
0.1600
0.1800
0.0000

0.14
0.08
0.14

Roll Lines
Used
14, 15, 16, 17
14, 15, 16, 17
14, 15, 16, 17
14,15,16,17
14,15,16,17

Roll (deg)
-0.0400
-0.0700
0.0100
0.0500
0.0000

Yaw Lines
Used
14, 15, 16, 17
14, 15, 16, 17
14, 15, 16, 17
14,15,16,17
14,15,16,17

-0.01
0.05
-0.01

Final Values based on
Resulting HVF File Name

MRU Align StdDev gyro
MRU Align StdDev Roll/Pitch
NARRATIVE

0.10
0.06

Value from standard deviation of Heading offset values
Value from averaged standard deviations of pitch and roll offset values

HVF Hydrographic Vessel File created or updated with current offsets
Name:

Date:

Yaw (deg)
0.1000
0.0500

-0.1000

0.02
0.10
0.02

roll offset values
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<?xml version="1.0"?>
<HIPSVesselConfig Version="2.0">
<VesselShape>
<PlanCoordinates/>
<ProfileCoordinates/>
<RP Length="0.000000" Width="0.000000" Height="0.000000"/>
</VesselShape>
<NavSensor>
<TimeStamp value="2016-278 00:00:00">
<Latency value="0.000000"/>
<Ellipse value="WG84"/>
<Offsets X="0.000000" Y="0.000000" Z="0.000000"/>
</TimeStamp>
</NavSensor>
<GyroSensor>
<TimeStamp value="2016-278 00:00:00">
<Latency value="0.000000"/>
<ApplyFlag value="No"/>
</TimeStamp>
</GyroSensor>
<HeaveSensor>
<TimeStamp value="2016-278 00:00:00">
<Latency value="0.000000"/>
<ApplyFlag value="No"/>
<Offsets X="-2.146000" Y="2.923000" Z="-5.022000" Heave="0.000000"/>
<Comment value="(null)"/>
<Manufacturer value="(null)"/>
<Model value="(null)"/>
<SerialNumber value="(null)"/>
</TimeStamp>
</HeaveSensor>
<PitchSensor>
<TimeStamp value="2016-278 00:00:00">
<Latency value="0.000000"/>
<ApplyFlag value="No"/>
<Offsets Pitch="0.000000"/>
</TimeStamp>
</PitchSensor>
<RollSensor>
<TimeStamp value="2016-278 00:00:00">
<Latency value="0.000000"/>
<ApplyFlag value="No"/>
<Offsets Roll="0.000000"/>
</TimeStamp>
</RollSensor>
<DraftSensor>
<TimeStamp value="2016-278 00:00:00">
<Latency value="0.000000"/>
<ApplyFlag value="Yes"/>
<DraftEntries>
<Entry Speed="0.000000" Draft="0.000000"/>
<Entry Speed="0.971922" Draft="-0.020000"/>
<Entry Speed="1.943844" Draft="-0.030000"/>
<Entry Speed="2.915767" Draft="-0.020000"/>
<Entry Speed="3.887689" Draft="-0.010000"/>
<Entry Speed="4.859611" Draft="0.030000"/>
<Entry Speed="5.831533" Draft="0.060000"/>
<Entry Speed="6.803456" Draft="0.100000"/>
<Entry Speed="7.775378" Draft="0.130000"/>
<Entry Speed="8.747300" Draft="0.180000"/>
<Entry Speed="9.719222" Draft="0.220000"/>
<Entry Speed="10.691145" Draft="0.260000"/>
<Entry Speed="11.663067" Draft="0.350000"/>
</DraftEntries>
-1-
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</TimeStamp>
</DraftSensor>
<WaterlineHeight>
<TimeStamp value="2017-195 00:00:00">
<Comment value="(null)"/>
<Latency value="0.000000"/>
<WaterLine value="0.510000"/>
<ApplyFlag value="Yes"/>
<StdDev Waterline="0.000000"/>
</TimeStamp>
<TimeStamp value="2017-231 00:00:00">
<Comment value=""/>
<Latency value="0.000000"/>
<WaterLine value="0.469130"/>
<ApplyFlag value="Yes"/>
<StdDev Waterline="0.000000"/>
</TimeStamp>
<TimeStamp value="2017-257 00:00:00">
<Comment value=""/>
<Latency value="0.000000"/>
<WaterLine value="0.316000"/>
<ApplyFlag value="Yes"/>
<StdDev Waterline="0.000000"/>
</TimeStamp>
<TimeStamp value="2017-298 00:00:00">
<Comment value=""/>
<Latency value="0.000000"/>
<WaterLine value="0.369000"/>
<ApplyFlag value="Yes"/>
<StdDev Waterline="0.000000"/>
</TimeStamp>
</WaterlineHeight>
<SVPSensor>
<TimeStamp value="2016-278 00:00:00">
<Comment value=""/>
<Latency value="0.000000"/>
<DualHead value="Yes"/>
<Offsets X="2.146000" Y="-2.923000" Z="5.022000" X2="2.450000" Y2="-2.818000"
Z2="5.005000"/>
<MountAngle Pitch="-0.266000" Roll="0.327000" Azimuth="179.504000" Pitch2="-0.277000"
Roll2="0.419000" Azimuth2="179.498000"/>
</TimeStamp>
</SVPSensor>
<DepthSensor>
<TimeStamp value="2016-278 00:00:00">
<Latency value="0.000000"/>
<SensorClass value="Swath"/>
<TransducerEntries>
<Transducer Number="1" StartBeam="1" Model="em2040_300N">
<Offsets X="0.000000" Y="0.000000" Z="0.000000" Latency="0.000000"/>
<MountAngle Pitch="0.010000" Roll="-0.040000" Azimuth="0.017000"/>
</Transducer>
<Transducer Number="2" StartBeam="1002" Model="em2040_300N">
<Offsets X="0.000000" Y="0.000000" Z="0.000000" Latency="0.000000"/>
<MountAngle Pitch="0.000000" Roll="0.000000" Azimuth="0.000000"/>
</Transducer>
</TransducerEntries>
</TimeStamp>
<TimeStamp value="2017-001 00:00:00">
<Latency value="0.000000"/>
<SensorClass value="Swath"/>
<TransducerEntries>
<Transducer Number="1" StartBeam="1" Model="em2040_300N">
<Manufacturer value="Kongsberg EM2040 300kHz 0.5x1_Normal Mode"/>
-2-
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<Offsets X="0.000000" Y="0.000000" Z="0.000000" Latency="0.000000"/>
<MountAngle Pitch="0.000000" Roll="0.000000" Azimuth="0.000000"/>
</Transducer>
<Transducer Number="2" StartBeam="2" Model="Unknown">
<Offsets X="0.000000" Y="0.000000" Z="0.000000" Latency="0.000000"/>
<MountAngle Pitch="0.000000" Roll="0.000000" Azimuth="0.000000"/>
</Transducer>
</TransducerEntries>
</TimeStamp>
</DepthSensor>
<TPEConfiguration>
<TimeStamp value="2015-001 00:00:00">
<Comment value=""/>
<Latency value="0.000000"/>
<Offsets>
<MRUtoTransducer X="2.146000" Y="-2.923000" Z="5.022000" X2="2.450000" Y2="-2.818000"
Z2="5.005000"/>
<NavigationToTransducer X="0.757000" Y="7.014000" Z="27.360000" X2="1.061000"
Y2="7.119000" Z2="27.343000"/>
<Transducer Roll="0.000000" Roll2="0.000000"/>
<Navigation Latency="0.000000"/>
</Offsets>
<StandardDeviation>
<Motion Gyro="0.015000" HeavePercAmplitude="0.000000" Heave="0.000000" Roll="0.003000"
Pitch="0.003000" PitchStablized="0.000000"/>
<Position Navigation="0.100000"/>
<Timing Transducer="0.001000" Navigation="0.001000" Gyro="0.001000" Heave="0.001000"
Pitch="0.001000" Roll="0.001000"/>
<SoundVelocity Measured="0.000000" Surface="0.000000"/>
<Tide Measured="0.000000" Zoning="0.000000"/>
<Offsets X="0.002000" Y="0.002000" Z="0.002000"/>
<MRUAlignment Gyro="0.030000" Pitch="0.060000" Roll="0.060000"/>
<Vessel Speed="0.000000" Loading="0.000000" Draft="0.000000" DeltaDraft="0.000000">
<StDevComment value="(null)"/>
</Vessel>
</StandardDeviation>
</TimeStamp>
</TPEConfiguration>
</HIPSVesselConfig>
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THOMAS JEFFERSON
Multibeam Echosounder Calibration

Vessel: S-222

Date Acquired: 7/13/2017 (DN194)
Processing Log
7/13/2017
Date

194
Dn

PS Marcus
Personnel

Data converted --> HDCS_Data in CARIS
TrueHeave applied

crm

SVP applied

crm

Tide applied

GPS Tide
Zone file
Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order
1. Precise Timing

2. Pitch bias

3. Roll bias

4. Heading bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS
Latency
Lines Used

Evaluators
Marcus
McMillan
Hiteshew
Rice
Doroba
Forrest

Averages
Standard Deviation
FINAL VALUES

Latency (sec)
0.0000
0.0000
0.0000
0.0000
0.0000

Pitch Lines
Used
13,14
13,14
13,14
13,14
13,14
13,14

0.00
0.00
0.00

Pitch (deg)
0.0000
0.0000
0.0500
0.0000

Roll Lines
Used
15,16,17,18
15,16,17,18,
15,16,17,18
15,16,17,18
15,16,17,18

Yaw Lines
Roll (deg) Used
15,16,17,18
-0.0900
15,16,17,18
-0.0700
15,16,17,18
0.0000
15,16,17,18
-0.0175
15,16,17,18

0.0000

0.01
0.02
0.01

-0.04
0.04
-0.04

Final Values based on
Resulting HVF File Name

MRU Align StdDev gyro
MRU Align StdDev Roll/Pitch
NARRATIVE

0.06
0.03

Value from standard deviation of Heading offset values
Value from averaged standard deviations of pitch and roll offset values

HVF Hydrographic Vessel File created or updated with current offsets
Name:

S222_EM2040_2017

Date:

s

Yaw (deg)

0.2000
0.3125
0.2000

0.24
0.06
0.24

nd roll offset values

7/116/2017

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 0285
CALIBRATION DATE: 04-Feb-17

SBE 19 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -4.07300858e+000
h =
4.85735412e-001
i =
1.25061470e-003
j = -2.43321316e-005
BATH TEMP
(° C)
22.0000
1.0000
4.5000
15.0000
18.4999
24.0000
29.0000
32.5000

CPcor = -9.5700e-008 (nominal)
CTcor = 3.2500e-006 (nominal)

BATH SAL
(PSU)
0.0000
34.6919
34.6716
34.6283
34.6191
34.6090
34.6036
34.5999

BATH COND INSTRUMENT INSTRUMENT RESIDUAL
(S/m)
OUTPUT (kHz) COND (S/m)
(S/m)
0.00000
2.88563
0.00000
0.00000
2.96634
8.26052
2.96633
-0.00002
3.27241
8.62451
3.27243
0.00001
4.25098
9.69552
4.25103
0.00005
4.59501
10.04437
4.59495
-0.00007
5.15119
10.58391
5.15120
0.00002
5.67139
11.06429
5.67139
0.00000
6.04251
11.39475
6.04287
0.00037

f = Instrument Output (kHz)
t = temperature (°C);

p = pressure (decibars);

δ = CTcor;

ε = CPcor;

Conductivity (S/m) = (g + h * f + i * f + j * f ) /10 (1 + δ * t + ε * p)
2

3

4

Residual (Siemens/meter) = instrument conductivity - bath conductivity
Date, Slope Correction

0.002

13-Jan-16 0.9998925
04-Feb-17 1.0000000

Residual (S/m)

0.001

0

-0.001

POST CRUISE
CALIBRATION
-0.002
0

1

2

3
4
Conductivity (S/m)

5

6

7

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 0285
CALIBRATION DATE: 02-Feb-17

SBE 19 PRESSURE CALIBRATION DATA
FSR: 5000 psia S/N 133807 TCV:

QUADRATIC COEFFICIENTS:
PA0 =
2.490724e+003
PA1 =
-6.503266e-001
PA2 =
-5.697540e-008

STRAIGHT LINE FIT:
M = -6.503518e-001
B = 2.490383e+003

PRESSURE
(PSIA)
14.70
1011.18
2008.45
3005.51
4002.69
4999.88
4002.67
3005.59
2008.49
1011.21
14.70

INSTRUMENT
OUTPUT (counts)
3804.2
2275.5
743.7
-792.1
-2325.0
-3859.0
-2325.8
-794.0
741.5
2274.5
3807.1

COMPUTED
PRESSURE (PSIA)
15.93
1010.61
2007.04
3005.81
4002.43
4999.49
4002.95
3007.05
2008.48
1011.26
14.04

RESIDUAL
(%FSR)
0.02
-0.01
-0.03
0.01
-0.01
-0.01
0.01
0.03
-0.00
0.00
-0.01

LINEAR
FIT (PSIA)
16.32
1010.51
2006.72
3005.53
4002.45
5000.09
4002.97
3006.76
2008.15
1011.16
14.43

LINEAR
RESIDUAL (%FSR)
0.03
-0.01
-0.03
0.00
-0.00
0.00
0.01
0.02
-0.01
-0.00
-0.01

n = instrument output (counts)
Straight Line Fit:

Pressure (PSIA) = M * n + B

Quadratic Fit:

Pressure (PSIA) = PA0 + PA1 * n + PA2 * n

2

Residual (%FSR) = (computed pressure - true pressure) * 100 / Full Scale Range

Date, Offset (%FSR)

0.50

02-Feb-17

Residual (% FSR)

0.25

0

-0.25

-0.50
0

500

1000

1500

2000

2500 3000 3500
Pressure (PSIA)

4000

4500

5000

5500

0.00

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 0285
CALIBRATION DATE: 04-Feb-17

SBE 19 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
g = 4.12462544e-003
h = 5.73988694e-004
i = -2.18662915e-006
j = -3.51142872e-006
f0 = 1000.0
BATH TEMP
(° C)
1.0000
4.5000
15.0000
18.4999
24.0000
29.0000
32.5000

INSTRUMENT
OUTPUT (Hz)
2297.642
2490.797
3139.048
3379.484
3783.134
4178.755
4472.483

INST TEMP
(° C)
0.9997
4.5006
14.9993
18.5003
24.0000
29.0003
32.4998

RESIDUAL
(° C)
-0.00029
0.00056
-0.00072
0.00036
0.00002
0.00033
-0.00025

f = Instrument Output (Hz)
2

3

Temperature ITS-90 (°C) = 1/{g + h[ln(f0 / f )] + i[ln (f0 / f)] + j[ln (f0 / f)]} - 273.15
Residual (°C) = instrument temperature - bath temperature
Date, Offset (mdeg C)

0.02

13-Jan-16 -0.05
04-Feb-17 -0.00

Residual (Degrees C)

0.01

0

-0.01

POST CRUISE
CALIBRATION
-0.02
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10
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20
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 4487
CALIBRATION DATE: 09-Feb-17

SBE 19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -1.021501e+000
h = 1.395833e-001
i = -2.272578e-004
j = 3.739346e-005
BATH TEMP
(° C)
22.0000
0.9999
4.4999
15.0000
18.4999
23.9999
29.0000
32.4999

CPcor = -9.5700e-008
CTcor = 3.2500e-006

BATH SAL
(PSU)
0.0000
34.7331
34.7132
34.6702
34.6611
34.6509
34.6450
34.6415

BATH COND
(S/m)
0.00000
2.96952
3.27595
4.25558
4.59999
5.15672
5.67741
6.04894

INSTRUMENT INSTRUMENT RESIDUAL
OUTPUT (Hz) COND (S/m)
(S/m)
2708.53
0.0000
0.00000
5349.99
2.9695
0.00001
5550.86
3.2759
-0.00001
6148.42
4.2556
-0.00000
6344.84
4.6000
-0.00001
6649.80
5.1567
0.00001
6922.50
5.6774
0.00001
7110.48
6.0489
-0.00001

f = Instrument Output (Hz) / 1000.0
t = temperature (°C);

p = pressure (decibars);

δ = CTcor;

ε = CPcor;

Conductivity (S/m) = (g + h * f + i * f + j * f ) /10 (1 + δ * t + ε * p)
2

3

4

Residual (Siemens/meter) = instrument conductivity - bath conductivity
Date, Slope Correction

0.004

23-Jan-16 0.9996523
09-Feb-17 1.0000000

Residual (S/m)

0.002

0

-0.002

POST CRUISE
CALIBRATION
-0.004
0

1

2

3
4
Conductivity (S/m)

5

6

7

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 4487
CALIBRATION DATE: 08-Feb-17

SBE 19plus PRESSURE CALIBRATION DATA
508 psia S/N 2837

COEFFICIENTS:
PA0 =
7.902702e-002
PA1 =
1.556410e-003
PA2 =
7.504087e-012
PTEMPA0 = -7.458082e+001
PTEMPA1 = 4.921759e+001
PTEMPA2 = -4.134267e-001

PTCA0
PTCA1
PTCA2
PTCB0
PTCB1
PTCB2

= 5.242735e+005
= 4.122209e+000
= -8.153683e-002
= 2.498675e+001
= -5.000000e-005
= 0.000000e+000

PRESSURE SPAN CALIBRATION
PRESSURE
(PSIA)
14.55
104.80
204.80
304.80
404.80
504.81
404.81
304.80
204.81
104.81
14.54

INSTRUMENT
OUTPUT (counts)
533615.0
591580.0
655756.0
719907.0
784022.0
848095.0
784038.0
719930.0
655777.0
591599.0
533618.0

THERMISTOR
OUTPUT (volts)
2.0
2.0
2.0
2.0
2.0
2.0
2.0
2.0
2.0
2.0
2.0

THERMAL CORRECTION

COMPUTED
RESIDUAL
PRESSURE (PSIA) (%FSR)
14.54
-0.00
104.79
-0.00
204.78
-0.00
304.79
-0.00
404.80
-0.00
504.81
-0.00
404.82
0.00
304.82
0.00
204.81
0.00
104.82
0.00
14.55
0.00

TEMP
(°C)
32.50
29.00
24.00
18.50
15.00
4.50
1.00

THERMISTOR
OUTPUT (volts)
2.22
2.14
2.04
1.92
1.85
1.63
1.56

TEMPERATURE (°C)
-5.00
35.00

INSTRUMENT
OUTPUT (counts)
533779.44
533776.33
533779.33
533778.52
533773.55
533745.35
533732.58

SPAN (mV)
24.99
24.98

y = thermistor output (counts)
2

t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y

2

x = instrument output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t )
2

pressure (PSIA) = PA0 + PA1 * n + PA2 * n

Residual (%FSR) = (computed pressure - true pressure) * 100 / Full Scale Range

Date, Offset (%FSR)

0.50

08-Feb-17

Residual (% FSR)

0.25

0

-0.25

-0.50
0

50

100

150

200

250
300
350
Pressure (PSIA)

400

450

500
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0.00

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 4487
CALIBRATION DATE: 09-Feb-17

SBE 19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 = 1.215545e-003
a1 = 2.605569e-004
a2 = 5.437772e-008
a3 = 1.423267e-007
BATH TEMP
(° C)
0.9999
4.4999
15.0000
18.4999
23.9999
29.0000
32.4999

INSTRUMENT
OUTPUT (counts)
713487.169
638173.119
447181.034
394913.932
323274.949
268226.508
234759.458

INST TEMP
(° C)
1.0000
4.4997
15.0002
18.4999
23.9999
28.9998
32.5000

RESIDUAL
(° C)
0.0001
-0.0002
0.0002
-0.0000
-0.0000
-0.0002
0.0001

n = Instrument Output (counts)
MV = (n - 524288) / 1.6e+007
R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)
2

3

Temperature ITS-90 (°C) = 1/{a0 + a1[ln(R)] + a2[ln (R)] + a3[ln (R)]} - 273.15
Residual (°C) = instrument temperature - bath temperature
Date, Offset (mdeg C)

0.02

23-Jan-16 0.79
09-Feb-17 0.00

Residual (Degrees C)

0.01

0

-0.01

POST CRUISE
CALIBRATION
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 6667
CALIBRATION DATE: 04-Feb-17

SBE 19plus V2 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -1.022646e+000
h = 1.341336e-001
i = 1.899491e-005
j = 1.690591e-005
BATH TEMP
(° C)
22.0000
0.9999
4.5000
15.0000
18.5000
23.9999
28.9999
32.4999

CPcor = -9.5700e-008
CTcor = 3.2500e-006

BATH SAL
(PSU)
0.0000
34.7252
34.7051
34.6625
34.6533
34.6433
34.6378
34.6344

BATH COND
(S/m)
0.00000
2.96891
3.27526
4.25474
4.59907
5.15572
5.67635
6.04784

INSTRUMENT INSTRUMENT RESIDUAL
OUTPUT (Hz) COND (S/m)
(S/m)
2759.31
0.0000
0.00000
5442.88
2.9689
0.00003
5646.99
3.2752
-0.00003
6254.44
4.2547
-0.00003
6454.20
4.5991
0.00002
6764.37
5.1557
0.00003
7041.82
5.6763
-0.00002
7233.11
6.0478
-0.00008

f = Instrument Output (Hz) / 1000.0
t = temperature (°C);

p = pressure (decibars);

δ = CTcor;

ε = CPcor;

Conductivity (S/m) = (g + h * f + i * f + j * f ) /10 (1 + δ * t + ε * p)
2

3

4

Residual (Siemens/meter) = instrument conductivity - bath conductivity
Date, Slope Correction

0.008

12-Jan-16 1.0010094
04-Feb-17 1.0000000

Residual (S/m)

0.004

0

-0.004

POST CRUISE
CALIBRATION
-0.008
0

1

2

3
4
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 6667
CALIBRATION DATE: 1-Feb-17

SBE 19plus V2 PRESSURE CALIBRATION DATA
870 psia S/N 3182130

COEFFICIENTS:
PA0 =
1.976211e+000
PA1 =
2.627526e-003
PA2 =
2.272074e-011
PTEMPA0 = -6.624888e+001
PTEMPA1 = 5.265826e+001
PTEMPA2 = -5.577237e-001

PTCA0
PTCA1
PTCA2
PTCB0
PTCB1
PTCB2

= 5.245898e+005
= 5.242476e+001
= -8.443841e-001
= 2.523813e+001
= -9.750000e-004
= 0.000000e+000

PRESSURE SPAN CALIBRATION
PRESSURE
(PSIA)
14.73
179.99
359.99
539.99
719.99
869.98
720.00
540.02
360.02
180.00
14.73

INSTRUMENT
OUTPUT (counts)
530184.0
592967.0
661302.0
729548.0
797721.0
854460.0
797750.0
729592.0
661343.0
593013.0
530204.0

THERMISTOR
OUTPUT (volts)
1.7
1.7
1.7
1.7
1.7
1.7
1.7
1.7
1.7
1.7
1.7

THERMAL CORRECTION

COMPUTED
RESIDUAL
PRESSURE (PSIA) (%FSR)
14.71
-0.00
179.92
-0.01
359.95
-0.00
539.95
-0.01
719.97
-0.00
869.96
-0.00
720.05
0.01
540.07
0.01
360.06
0.00
180.04
0.00
14.76
0.00

TEMP
(°C)
32.50
29.00
24.00
18.50
15.00
4.50
1.00

THERMISTOR
OUTPUT (volts)
1.91
1.85
1.75
1.64
1.57
1.36
1.29

TEMPERATURE (°C)
-5.00
35.00

INSTRUMENT
OUTPUT (counts)
530246.47
530232.78
530193.61
530111.08
530031.02
529645.46
529479.46

SPAN (mV)
25.24
25.20

y = thermistor output (counts)
2

t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y

2

x = instrument output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t )
2

pressure (PSIA) = PA0 + PA1 * n + PA2 * n

Residual (%FSR) = (computed pressure - true pressure) * 100 / Full Scale Range

Date, Offset (%FSR)

0.50

1-Feb-17

Residual (% FSR)

0.25
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 6667
CALIBRATION DATE: 04-Feb-17

SBE 19plus V2 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 = 1.251506e-003
a1 = 2.577880e-004
a2 = 5.786759e-008
a3 = 1.355261e-007
BATH TEMP
(° C)
0.9999
4.5000
15.0000
18.5000
23.9999
28.9999
32.4999

INSTRUMENT
OUTPUT (counts)
702154.983
626329.220
435066.729
383031.661
311981.153
257617.390
224680.966

INST TEMP
(° C)
1.0000
4.4998
15.0001
18.5000
23.9998
28.9998
32.5000

RESIDUAL
(° C)
0.0001
-0.0002
0.0001
0.0000
-0.0001
-0.0001
0.0001

n = Instrument Output (counts)
MV = (n - 524288) / 1.6e+007
R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)
2

3

Temperature ITS-90 (°C) = 1/{a0 + a1[ln(R)] + a2[ln (R)] + a3[ln (R)]} - 273.15
Residual (°C) = instrument temperature - bath temperature
Date, Offset (mdeg C)

0.02

12-Jan-16 0.20
04-Feb-17 0.00

Residual (Degrees C)

0.01

0

-0.01

POST CRUISE
CALIBRATION
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 0491
CALIBRATION DATE: 14-Feb-17

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -9.962091e-001
h = 1.739383e-001
i = -8.973398e-004
j = 9.105236e-005

CPcor = -9.5700e-008
CTcor = 3.2500e-006
WBOTC = 2.4322e-007

BATH TEMP
(° C)
22.0000
1.0000
4.4999
15.0000
18.5000
24.0000
29.0000
32.5000

BATH SAL
(PSU)
0.0000
34.6748
34.6554
34.6139
34.6049
34.5949
34.5892
34.5852

BATH COND
(S/m)
0.00000
2.96502
3.27103
4.24940
4.59334
5.14932
5.66929
6.04023

INSTRUMENT INSTRUMENT RESIDUAL
OUTPUT (Hz) COND (S/m)
(S/m)
2404.49
0.00000
0.00000
4802.75
2.96495
-0.00007
4984.94
3.27112
0.00009
5526.44
4.24942
0.00002
5704.33
4.59324
-0.00010
5980.64
5.14939
0.00007
6227.55
5.66928
-0.00002
6397.76
6.04030
0.00006

f = Instrument Output(Hz) * sqrt(1.0 + WBOTC * t) / 1000.0
t = temperature (°C);

p = pressure (decibars);

δ = CTcor;

ε = CPcor;

Conductivity (S/m) = (g + h * f + i * f + j * f ) /10 (1 + δ * t + ε * p)
2

3

4

Residual (Siemens/meter) = instrument conductivity - bath conductivity
Date, Slope Correction

0.008

02-May-14 1.0008253
14-Feb-17 1.0000000

Residual (S/m)

0.004

0

-0.004

POST CRUISE
CALIBRATION
-0.008
0

1

2

3
4
Conductivity (S/m)

5

6

7

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA
Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com
SENSOR SERIAL NUMBER: 0491
CALIBRATION DATE: 14-Feb-17

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 = 5.259318e-005
a1 = 2.652908e-004
a2 = -1.825040e-006
a3 = 1.335895e-007
BATH TEMP
(° C)
1.0000
4.4999
15.0000
18.5000
24.0000
29.0000
32.5000

INSTRUMENT
OUTPUT (counts)
775047.8
661016.5
418258.0
361339.7
288859.5
237117.2
207207.9

INST TEMP
(° C)
1.0000
4.4999
15.0000
18.4999
24.0001
29.0000
32.5000

RESIDUAL
(° C)
-0.0000
0.0000
0.0000
-0.0001
0.0001
-0.0000
0.0000

n = Instrument Output (counts)
2

3

Temperature ITS-90 (°C) = 1/{a0 + a1[ln(n)] + a2[ln (n)] + a3[ln (n)]} - 273.15
Residual (°C) = instrument temperature - bath temperature
Date, Offset (mdeg C)

0.02

02-May-14 0.58
14-Feb-17 -0.00

Residual (Degrees C)

0.01

0

-0.01

POST CRUISE
CALIBRATION
-0.02
-5

0

5

10
15
20
Temperature (Degrees C)

25

30

35

NOAA Ship S222 2017 75m Range Scale Sidescan Calibration
Side Scan run on DN229. MBES not run.

2017 HSRR
S222 75m Range Scale
Side Scan Re‐Certification
(TPU Upgrade) ‐ August 2017

MBES Position of Contact
Lat
Long
32.00238561
‐80.4578934
Line Hdg
SSS Contacts
1
2
3
4
5
6
7
8
9
10

32.0023870
32.00236939
32.00238333
32.00241408
32.00238033
32.00239658
32.00233831
32.00244697
32.00237083
32.00237472

N
DOF: 2N‐1

‐80.4579223
‐80.45791733
‐80.4579049
‐80.45788689
‐80.45786207
‐80.45789544
‐80.45789233
‐80.45788079
‐80.45786709
‐80.45790675

10
19

270
90
90
270
180
90
180
0
0
180

Average:
StDev:

Dist. (m)

0.16
‐1.80
‐0.25
3.16
‐0.59
1.22
‐5.26
6.82
‐1.64
‐1.21

Long Diff
(m)
‐2.73
‐2.25
‐1.08
0.61
2.95
‐0.19
0.10
1.19
2.48
‐1.26

0.06
3.22

‐0.02
1.88

3.11
1.79

Lat Diff (m)

2.73
2.89
1.11
3.22
3.01
1.23
5.26
6.92
2.97
1.75

Along Trk Across Trk
(m)
(m)
0.16
2.726
1.80
‐2.255
0.25
‐1.083
3.16
‐0.614
‐2.95
0.586
‐1.22
‐0.191
‐0.10
5.256
1.19
6.819
2.48
‐1.642
1.26
1.210

Dist. (m)
2.73
2.89
1.11
3.22
3.01
1.23
5.26
6.92
2.97
1.75

0.02
2.57

Criteria: 95% Confidence that any future measurement will not give a positional error
greater than 10 meters.

Figure 1: 2017 HSRR 75m Range Scale Side Scan Cert confidence
check siteoff False Cape, NC.
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Setting the distance error equal to 10 meters and using the Chi-squared
value for one degree of freedom and alpha = 0.05, solve for the maximum value
for the true value of the standard deviation of the x and y error.

‐15

15

10

10

5

5

0
‐10

‐5

0

5

10

15

‐5
‐10

Distance Error Limit (meters)
Max. x,y Std Deviation

10
5.1

The sample estimate of the standard deviation will also be Chi-squared distributed
At a 95% confidence interval the standard deviation range is:
best est.
95% Confidence
x,y StDev
2.6
3.5
And the 95% confidence inteval of the positioning error is:
Error
5.0
6.9
PASS
Note: FPM method of 1.96*RMS standard deviation
Error:
7.3
PASS
Alternate FPM method of mean radial distance plus 1.96*radial standard deviation
Error
6.6
FAIL

‐15
easting
(m)

Figure 2: Contact position errors in a geographic
refernece frame. Most contacts were reported east of
the actual position.

along track (m)

So:

northing (m)

Assuming x and y errors are goverened by the same normal distribution, the
square of the distance error is governed by Chi-squared statistics.

‐15

0
‐10

‐5

0

5

10

15

‐5
‐10
‐15 track (m)
across

Figure 3: Contact position errors in a ship aligned refernece
frame.

NOAA Launch 2903 Sidescan Calibration
Side Scan run on Dn231. MBES run on Dn231.
50m Range Scale
MBES Position of Contact
Lat
Long
32.00307
-80.604389
Line Hdg

Lat Diff (m)

Long Diff (m)

Dist. (m)

Along Trk (m) Across Trk (m)

1.78
0.44
0.67
0.67
-0.78
-0.67
0.44
1.33
-0.44
-0.33

1.88
1.04
0.38
2.26
0.28
-0.66
0.94
2.73
1.88
1.13

2.59
1.13
0.77
2.36
0.83
0.94
1.04
3.04
1.94
1.18

-1.85
1.04
-0.38
2.25
-0.30
0.69
0.46
-1.38
-0.38
-0.31

0.31
0.86

1.19
1.03

1.58
0.83

0.75
1.02

Dist. (m)

SSS Contacts

N
DOF: 2N-1

-80.6043720
-80.604369
-80.604378
-80.604385
-80.604365
-80.604386
-80.604396
-80.604379
-80.60436
-80.604369
-80.604377

10
19

181
000
180
001
181
092
271
091
272
271

Average:
StDev:

Criteria: 95% Confidence that any future measurement will not give a positional error
greater than 10 meters.

-1.811
0.444
-0.667
0.706
0.773
-0.636
-0.934
2.709
-1.899
-1.136

15
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Setting the distance error equal to 10 meters and using the Chi-squared
value for one degree of freedom and alpha = 0.05, solve for the maximum value
for the true value of the standard deviation of the x and y error.

northing (m)


P d


Figure 1: 45ft obstruction offshore of the Approaches to
Savannah used to certify hull-mounted SSS on TJ HSL 2903.

Geographic Frame Error

Assuming x and y errors are goverened by the same normal distribution, the
square of the distance error is governed by Chi-squared statistics.
So:

2.59
1.13
0.77
2.36
0.83
0.94
1.04
3.04
1.94
1.18

-15

5
0
-10

-5

0

5

10

15

-5

along track (m)

32.0030820
32.003086
32.003074
32.003076
32.003076
32.003063
32.003064
32.003074
32.003082
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32.003067
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5
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-5

-10

Distance Error Limit (meters)
Max. x,y Std Deviation

10
5.1

-10
-15
easting
(m)
-15 track (m)
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The sample estimate of the standard deviation will also be Chi-squared distributed
At a 95% confidence interval the standard deviation range is:
best est.
95% Confidence
x,y StDev
1.0
1.4
And the 95% confidence inteval of the positioning error is:
Error
2.0
2.8
PASS
Note: FPM method of 1.96*RMS standard deviation
Error:
2.6
PASS
Alternate FPM method of mean radial distance plus 1.96*radial standard deviation
Error
3.2
FAIL

Figure 2: Contact position errors in a geographic refernece frame.
Most contacts were reported east of the actual position.

Figure 3: Contact position errors in a ship aligned refernece
frame.

NOAA Launch 2903 Sidescan Calibration
Side Scan run on Dn231. MBES run on Dn231.

MBES Position of Contact
Lat
Long
32.00307
-80.604389
Line Hdg Lat Diff (m)

Long Diff
(m)

Dist. (m)

-2.22
-0.56
1.22
-1.89
1.67
1.56
-1.89
-2.00

-0.19
-1.32
-0.57
3.30
-0.66
-0.09
-2.45
-2.54

2.23
1.43
1.35
3.80
1.79
1.56
3.09
3.24

0.15
-1.32
0.57
3.33
0.69
-1.55
1.93
-2.09

2.225
-0.556
-1.222
-1.831
-1.655
-0.148
-2.417
2.473

2.23
1.43
1.35
3.80
1.79
1.56
3.09
3.24

0.22
-0.89
-0.48
1.55

-3.11
-3.02
-1.06
1.92

3.12
3.14
2.48
0.90

-3.11
-3.02
-0.54
1.72

0.222
-0.889

3.12
3.14

SSS Contacts
2
3
4
5
6
7
9
10

32.00305
32.003065
32.003081
32.003053
32.003085
32.003084
32.003053
32.003052

-80.6043910
-80.6044030
-80.6043950
-80.6043540
-80.6043960
-80.6043900
-80.6044150
-80.6044160

32.003072
32.003062
8
15

-80.6044220
-80.6044210

181
000
180
001
181
092
091
272

Along Trk Across Trk
(m)
(m)

Dist. (m)

Figure 1. Charted 45ft obstuction used to certify hull-mounted

Average:
StDev:

Criteria: 95% Confidence that any future measurement will not give a positional error
greater than 10 meters.
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Setting the distance error equal to 10 meters and using the Chi-squared
value for one degree of freedom and alpha = 0.05, solve for the maximum value
for the true value of the standard deviation of the x and y error.

northing (m)

So:

2

Ship Frame Error

15

Assuming x and y errors are goverened by the same normal distribution, the
square of the distance error is governed by Chi-squared statistics.
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Distance Error Limit (meters)
Max. x,y Std Deviation

10
5.1

The sample estimate of the standard deviation will also be Chi-squared distributed
At a 95% confidence interval the standard deviation range is:
best est.
95% Confidence
x,y StDev
1.7
2.5
And the 95% confidence inteval of the positioning error is:
Error
3.4
4.8
PASS
Note: FPM method of 1.96*RMS standard deviation
Error:
4.8
PASS
Alternate FPM method of mean radial distance plus 1.96*radial standard deviation
Error
4.3
FAIL

-15
easting
(m)

Figure 2: Contact position errors in a geographic
refernece frame. Most contacts were reported
southwest of the actual position.
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N
DOF: 2N-1
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Figure 3: Contact position errors in a ship aligned reference
frame.

UNITED STATES DEPARTMENT OF COMMERCE

National Oceanic and Atmospheric Administration
Office of Marine and Aviation Operations,

Marine Operation Center-Atlantic, NOAA Ship Thomas Jefferson
Norfolk, Virginia 23510

August 3, 2017

MEMORANDUM FOR:

Captain Richard T. Brennan, NOAA
Chief, Hydrographic Surveys Division

FROM:

Commander Chris Van Westendorp, NOAA
Commanding Officer, NOAA Ship Thomas Jefferson

SUBJECT:

NOAA Ship Thomas Jefferson Hydrographic Systems Status Summary

The hydrographic systems of NOAA Ship Thomas Jefferson were reviewed in accordance with the Office
of Coast Survey Field Procedures Manual (FPM) Hydrographic Systems Readiness Review procedures.
Thomas Jefferson ran system certification operations off of Capes Henry and Charles in July of 2017.
All certification tests were conducted and reviewed by a Hydrographic Systems Review Team comprised
of the following people:
LT Matthew Forrest, Operations Officer;
LT Anthony Klemm, Operations Officer in Training
Acting Chief Hydrographic Survey Technician Allison Stone
Clinton Marcus, Physical Scientist, Atlantic Hydrographic Branch
John Doroba, Physical Scientist, Hydrographic Systems and Technology Branch
Glen Rice, Physical Scientist, Hydrographic Systems and Technology Branch
Thomas Jefferson’s Survey Department
Thomas Jefferson’s Junior Officers.
The team installed and tested all systems except as noted below. The appropriate calibrations, checks, and
tests have been performed, and all tested satisfactorily except as noted below.
The Review Team’s findings are summarized in this memorandum and reflect the condition of the
Thomas Jefferson’s hydrographic systems on the review date. These findings have been divided into three
categories of deficiencies:

CATEGORY 1 – These deficiencies indicate the failure or absence of vital equipment or preparations of
systems essential to acquisition and/or processing of hydrographic data. The vessel will be required to
cease or limit hydrographic survey operations due to the following deficiencies:
There are no Category 1 deficiencies.
CATEGORY 2 – These deficiencies indicate noncompliance with established policies,
directives, instructions, or accepted hydrographic practice not addressed under Category
The following deficiencies shall be corrected in as timely a manner as funding, time,
and/or professional assistance permit:

1.

The ship’s Kongsberg EM710 and EM2040 multibeam echosounders continue to operate in a
degraded mode for normal hydrographic survey operations. HSTB has issued guidance
recommending limiting the EM710 and EM2040 to a 90° swath width to minimize the impact of
an outer beam artifact. The source is as yet unknown, but is suspected to be bubble sweepdown
or another oceanographic influence. Limiting the swath minimizes the appearance of the artifact,
but severely limits the capability of both systems to operate as intended. The most pronounced
effect of this limitation on day-to-day operations is the lack of coverage of the Side Scan Sonar
nadir gap in shallower water.
2. The ship’s Side Scan Sonar’s certification revealed a 2 second offset from the POS M/V-supplied
timestamp to its internal timestamp. This is a new issue, and the source of it eludes the entire
HSRR team. While an offset in post-processing has largely solved the issue, it is a distinct
possibility that the system is showing signs of age and need of upgrading, repairs, or replacement.

CATEGORY 3 – These deficiencies are associated with observations during the course of the review
which merit consideration for corrective actions. These observations are included for review and
dialogue related to potential problem areas and hydrographic operational efficiency. It is important to
assure that resources (funds, skills, and time) are available at the operating level in order to meet the
needs identified in this report and to sustain the ef ficient operation, upkeep, and repair of the field unit’s
hydrographic systems.
1. The ship’s Moving Vessel Profiler (MVP) is showing signs of age. At present, the MVP
functions adequately, but is no longer supported by the manufacturer and has fairly significant
external corrosion. Additionally, its cable is down to 160m, of which 120m is usable, a far cry
from its original 200m length. Its replacement as soon as funds are available is requested.
2. The ship’s Side Scan Sonar winch is well past its useful life. Parts are becoming more scarce as
time goes on, and preservation of it against the corrosion that has already set in will be a major
undertaking by deck department. Its replacement as soon as funds are available is requested.

Items not completed are below. They were skipped over owing to an extremely short HSRR period, tardy
launch delivery and warranty work-related delays, and the Command’s prioritization of ship system
readiness. They will be completed later in the season when launch work is called for.
HSL 2903:
- Patch Test
- Side Scan Certification
- CTD Comparison
- GAMS calibration
- Ellipsoidally Referenced Dynamic Draft
- Multibeam Patch Test: 200/400 khz
- Reference Surface: 200/400 khz
- Multibeam vs Vertical beam vs leadline comparison
- Side Scan Sonar Calibration: 50/75/100 meters
HSL 2904:
- Patch Test
- Side Scan Certification

-

CTD Comparison
GAMS calibration
Ellipsoidally Referenced Dynamic Draft
Multibeam Patch Test: 200/400 khz
Reference Surface: 200/400 khz
Multibeam vs Vertical beam vs leadline comparison
Side Scan Sonar Calibration: 50/75/100 meters

Z-1:
-

Static draft
Dynamic draft
Bar check
Latency check
Reference surface: compared to 200 khz on HSLs

Z-2:
-

Static draft
Dynamic draft
Bar check
Latency check
Reference surface: compared to 200 khz on HSLs
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Vessel Name: TJ_S222_Klein5000_SSS100_2017.hvf
Vessel created: January 23, 2018

Depth Sensor:
Sensor Class:
Swath
Time Stamp: 2015-001 00:00
Comments:
Time Correction(s) 0.000
Transduer #1:
------------Pitch Offset:
0.000
Roll Offset:
0.000
Azimuth Offset: 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Manufacturer:
Model:
Unknown
Serial Number:
_________________________________________________________
Navigation Sensor:
Time Stamp:

2015-001 00:00

Comments: (null)
Time Correction(s) -3.200
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Manufacturer:
Model:
v4
Serial Number:

Applanix
(null)

_________________________________________________________
Heave Sensor:
Time Stamp:

2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000
Manufacturer:
(null)
Model:
(null)
Serial Number:
(null)
_________________________________________________________
Pitch Sensor:
Time Stamp:

2015-001 00:00

Comments: (null)
-1-
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Apply No
Time Correction(s) 0.000
Pitch offset: 0.000
Manufacturer:
(null)
Model:
(null)
Serial Number:
(null)
_________________________________________________________
Roll Sensor:
Time Stamp:

2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
Roll offset: 0.000
Manufacturer:
(null)
Model:
(null)
Serial Number:
(null)
_________________________________________________________
Tow Point:
Time Stamp:

2015-001 00:00

Comments: HSRR 2015
Time Correction(s) 0.000
DeltaX: 6.370
DeltaY: -42.550
DeltaZ: -4.800
Manufacturer:
Klein
Model:
5000 V2
Serial Number:

Time Stamp:

2015-117 00:00

Comments: HSRR 2015 SSS Cert Results
Time Correction(s) 0.000
DeltaX: 6.370
DeltaY: -42.550
DeltaZ: -4.800
Manufacturer:
Klein
Model:
5000 V2
Serial Number:
_________________________________________________________
WaterLine:
Time Stamp:

2015-001 00:00

Comments: HSRR 2015
Apply Yes
WaterLine 0.380
Time Stamp:

2015-166 00:00

Comments: With HSL's, after ballasting during Charleston port call.
Apply Yes
WaterLine 0.441
-2-
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Vessel Name: TJ_S222_Klein5000_SSS200_2017.hvf
Vessel created: January 23, 2018

Depth Sensor:
Sensor Class:
Swath
Time Stamp: 2015-001 00:00
Comments:
Time Correction(s) 0.000
Transduer #1:
------------Pitch Offset:
0.000
Roll Offset:
0.000
Azimuth Offset: 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Manufacturer:
Model:
Unknown
Serial Number:
_________________________________________________________
Navigation Sensor:
Time Stamp:

2015-001 00:00

Comments: (null)
Time Correction(s) -3.200
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Manufacturer:
Model:
v4
Serial Number:

Applanix
(null)

_________________________________________________________
Heave Sensor:
Time Stamp:

2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000
Manufacturer:
(null)
Model:
(null)
Serial Number:
(null)
_________________________________________________________
Pitch Sensor:
Time Stamp:

2015-001 00:00

Comments: (null)
-1-
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Apply No
Time Correction(s) 0.000
Pitch offset: 0.000
Manufacturer:
(null)
Model:
(null)
Serial Number:
(null)
_________________________________________________________
Roll Sensor:
Time Stamp:

2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
Roll offset: 0.000
Manufacturer:
(null)
Model:
(null)
Serial Number:
(null)
_________________________________________________________
Tow Point:
Time Stamp:

2015-001 00:00

Comments: HSRR 2015
Time Correction(s) 0.000
DeltaX: 6.370
DeltaY: -42.550
DeltaZ: -4.800
Manufacturer:
Klein
Model:
5000 V2
Serial Number:

Time Stamp:

2015-117 00:00

Comments: HSRR 2015 SSS Cert Results
Time Correction(s) 0.000
DeltaX: 6.370
DeltaY: -42.550
DeltaZ: -4.800
Manufacturer:
Klein
Model:
5000 V2
Serial Number:
_________________________________________________________
WaterLine:
Time Stamp:

2015-001 00:00

Comments: HSRR 2015
Apply Yes
WaterLine 0.380
Time Stamp:

2015-166 00:00

Comments: With HSL's, after ballasting during Charleston port call.
Apply Yes
WaterLine 0.441
-2-
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2903Wiring Diagram
Switch #1

SV2 030916
P 129.100.1.231 to R 129.100.0.232
Set In Reson as this

P 129.100.1.231

Ant 2

com1

com4

GNSS1

com2

com5

POS M/V

K 192.168.0.81

Ant 1

GNSS2

LAN

IMU

Trig
IN

Com2

RESON

H 192.168.0.82

Com1

zda (9600,8,N,1) 25hz

1
PPS

c10
rec

c4

200
400

sv

H 192.168.10.81 to R 192.168.10.83

HYPACK
SVP70AML
Com3 9600/8/n/1

Hysweep Interface
192.168.10.82 Virtual IP
Dongle
10 9
7 8

Hyperterminal
Com8 9600/8/n/1
No hardware

Com 11 4800 N,8,1
Serial to USB adapter

CTD Com 7 9600/8/n/1

zda, rmc, gga,vtg (4800,8,n,1) 2hz

Simrad AP70
AutoPilot

T
F

Com1

Com2

Klein TPU
Trig 1 out

T 10.48.16.253 H 10.48.16.250 Admin M1Br@inM3lted

TSS 100HZ
(115200,8,N,1)

P 129.100.1.231 to
H129.100.0 230

PPS
out

com3

Switch #2

Secondary
Ant

Primary
Ant

2904 Wiring Diagram

Switch #1

SV2 030916
P 129.100.1.231 to R 129.100.0.232
Set In Reson as this

P 129.100.1.231

com4

GNSS1

com2

com5

POS M/V

GNSS2

PPS
out

com3

LAN

IMU

Trig
IN

Com2

RESON

H 192.168.0.82

Com1

zda (9600,8,N,1) 25hz

1
PPS
c10

rec

c4

200
400

sv

H 192.168.10.81 to R 192.168.10.83

HYPACK
SVP70AML
Com3 9600/8/n/1

Hysweep Interface
192.168.10.82 Virtual IP
10 9
7 8

Dongle

Hyperterminal
Com8 9600/8/n/1
No hardware

Com 11 4800 N,8,1
Serial to USB adapter

CTD Com 7 9600/8/n/1

zda, rmc, gga,vtg (4800,8,n,1) 2hz

Simrad AP70
AutoPilot

T
F

Com1

Com2

Klein TPU
Trig 1 out

T 10.48.16.253 H 10.48.16.250 Admin M1Br@inM3lted

TSS 100HZ
(115200,8,N,1)

P 129.100.1.231 to
H129.100.0 230

Ant 2

com1

K 192.168.0.81

Ant 1

Switch #2

Note: ROV set up for Motion but not
Active by intention

Positio
n

1
DGPS

Cable
Counte
r

1002 TPU

2

Knudson

ch 5

2
0
0

200
400

4
0
0

s
v

TSS1 (115200,8,N,1) 50hz

1
2

10

9600,8,N,1

re
c

Reson
Rov

zda (9600,8,N,1) 5hz
Res 129.100.1.233 to Pos

8

0
1
2
3

ch 3

Res 192.168.0.108 to Hyp

9600,8,N,1
Res 192.168.0.109 to Hyp

4 3

Trimble
simrad 1000
(19200,8,N,1) 10hz

200
400

s
v

Rov or SV2
Select one

zda (9600,8,N,1) 5hz

RTCM (9600,8,N,1)

dive
locker

4

1

2

MVP
CPU

PPS
BNC
splitter

2
1

4

3
SVT
Computer

19200,8,N,1

Rov SV2
Split
Fish
Co
mH
V

TSS1
115200,8,N,1
50hz

Fish
com
cable
LV

Winc
h
Cable

Multi
115200,8,N,1
MVP
Plexer
controller
host

P
1
P
2

in

Ethernet
switch

Nul
l
Splitte
r

1 2 3 4 5

9600 n, 8 1 cable count

2

5

dbt,gga,vtg,primary vessel
(9600,8,N,1)

3

3
4

1

o
ut

PosMV
Pos 129.100.1.231

r
e
c

Reson
SV2

o
ut

zda,vtg,gga (9600,8,n,1)

hdt, zda, vtg (19200,8,N,1) 2hz

broad
cast
SSVS

comp

broadcast
attitude

broad
cast
Positi
on
0
1
2
3
4
5
6
7

S222 Wiring
11/13/15 PGL

MVPTow Cable
MVPWinch input
10.48.16.253
admin
M1Br@inM3lted

6

5

4

3

2

1

Wizard blackbox

EM1002
10.48.16.150

7

usb

8

Hyp 192.168.0.110 to
Res
10.48.16.250 to network
9600,8,N,1

6

10.48.16.251

2

ODOM

1
Klein TPU

SV&
T

2

Trigger
in

ot
1

ot
2

ODOM

autopilot gpxte
,gprmc,
gpapb,gprmb
,(4800,8,n,1)

Network

9600,8,n,1

1

NOTE: PPS input to POS is
optional to a BNC switch, usually
used one input at a time.

2

1

Hypack CPU

4

4

3

3

3

1
Klein Computer

4

2

192,168.81 to
192.168.0.82

e-net

Hyp 129.100.1.230 to Pos

Null
ES6
0

205.156.16.221
10.48.16.251 to
network
NOTE: Some Ports are FLIP Flopping. Change port at connection and setup when necessary.
Klein Com 3 (Preffered) to 4 and vice versa
MVP Com 3 ( Preffered) to 1 and vice versa

Serial to USB or Ethernet combo =dash double dot

RESON Network
POS NETWORK

Auto Pilot Com 1 4800 ,N,8,1,n
use ver 10.0.0.9
“Update_4_decimal” name

Pos/MV 129.100.1.231

Hypack 129.100.1.230

SV2 129.100.1.232

ROV 129.100.1.233

Order
Hardware Applanix
Hysweep Inter

Hysweep Reson
Apppanix
SSS cable towfish.dll

Hypack 192.168.0.110

SV2 192.168.0.109

ROV 192.168.0.108

SSS CPU
May switch between COM 3
and Com 4 9600, N ,8,1 n

NMEA output
Com 3 9600 n,8,1,N, Hard
DBT, GGA VTG
No Flow

Trimble
DGPS

Broadcast
Position

Trimble
10.48.16.253

0

1

ADCP

8

7

6

5

4

3

2

1

0

AC

ADCP storage
10.48.16.251 to #30

com1
Hdt,zda,vtg
19200,8,N,1 2 hz

Broadcast
Attitude

XMIT In
High
Frequency
7

6

5

4

3

2

1

0

Int

EXT

In
XMIT
Low
Frequency

Knudsen
TPU

In
FIX

In
SYN
C
Out

Out

Int

LF
Analog
HF

in

EXT

Sonar head

AC

Com 2
Simrad3000
19200,N,8,1

1

POS Ethnet switch
1

2

3

4

Comm 1

Comm 3 Comm 5

Comm 2

Comm 4 Comm 6

Port
Ant

POS M/V PPS

Comm 2

Comm 3

Com 4

7

6

5

4

3

2

1

Com 5
GGK/ZDA 9600,n,81

IMU

AC

0

Com 3
RTCM
9600,8,N,1

Broadcas
t
Sound
Velocity

Comm 1

EM710
TRU

Stbd
Ant

I
N
1

EM 710
157.237.2.71

NBF-3 Data
buffer
2 3
4 5

Net-C

Net-A

AC

EM 710
CPU

Comm 1

Pos 129.100.1.231

5

Pos 129.100.1.232

RMC/
XMC2

PMC/XMC1
DC

CBMF EM
2040

1

GbE7 GbE1

GbE1 GbE2 GbE4 GbE6 GbE1

GbE1 GbE3 GbE5
AC

Port 2

CBMF EM
2040

48VDC out

ES 60

GbE switch
3714

Port
3

Port 4

Sync

1

1

Sync

AC

Trigger
Pos 129.100.1.233

Net-C

EM 710
10.48.16.248

Knudse
n

PPS

ETH 2

ETH 1

ETH 2

ETH 1

EM 2040
157.237.20.40

Net-A

EM 2040
CPU

Sonar head

AC
Comm 1

Fish Comm
Low voltage
Serial
out

Winch
Comm
Serial
out

Tow
Cable

Winch
input

1
2U

Klein
CPU
Comm 4

Klein
Lan

Remo
te

Emergency
stop
GND

Remote

Winch

115200,8,N,1
AC

MVP
Winch
Tow
fish

MVP winch Input

Klein

19200,8,N,1

Klein
Totco counter
9600,8,N,1

2

1
AC

MVPTow Cable

MVPTow Cable
Fish Comm
High
voltage

Core 1 Switch

Comm 3

PPS

Sonar head

AC

Ship
Lan

EM 2040
TPU

GND
Port
1

MRU
Remote
switch

MVP tow cable

10.48.16.252 to #27

Comm
4

Lan

Comm
3

MVP TPU

Comm 1

Klein
9600,8,N,1
Klein
Zda,vtg,gga
9600,8,n,1

TOWFISH

I/O

TOWFISH
Pulse

Parallel

Trigger
Trig
In

Trig 1
out

Klein
192.168.81
To
192.168.82
Trig 2
out

AC

Klein
10.48.16.250

Comm 1

Auto pilot
gpxte,gprmc,gprmb
(4800,8,N,1)

19200,8,N,1

Ethernet switch

1

1 2 3
TOWFISH

Video 3

4 5

Comm 2

Hypack
CPU

POS 129.100.1.230 ???

Valeport

Not
Attached

HYPACK
video1

Video 1

4
Totco

AC

Odom

1

HYPACK
Dongle

Keybrd 1

Serial 4

Serial 2
Not
Attached
Future use

Com
m2
Odom
Comm

Totco
Cable
counte
r

9600 n, 8 1 cable count

AC

1
1

ADCP pc
1

Sutron
Data
Logger

3

Serial 1

10.48.16.251 to #26

Knudsen
ES 60
TRU

Auto
pilot
Serial

AC

Klein TPU

1

ODOM

XMIT

In

High Frequency

In

XMIT

Low Frequency

Int

EXT

Int

In
FIX

Knudsen
TPU

In
SYNC
Out

Out

LF
Analog
HF

in

EXT

AC
Comm 1

Comm 2

Comm 3

Com 4

